
 
 

 
 

Theory Manual 
 

 
 
 
 

Version V1a 



 
 
 

 
An easily operated user interface for Z88

for all Windows- and Mac OS X-Computers 
for 32- and 64-bit 

 
This Freeware Version is the literary property of the 

Chair for Engineering Design and CAD, University of 
Bayreuth, Germany, 

composed and edited by 
Professor Dr.-Ing. Frank Rieg 

 
with the aid of:  

 
Dr.-Ing. Bettina Alber-Laukant, Dipl. Wirtsch.-Ing. Reinhard Hackenschmidt, 

Dipl.-Math. Martin Neidnicht, Dipl.-Ing. Florian Nützel,  
Dr.-Ing. Bernd Roith, Dipl.-Ing. Alexander Troll, Dipl.-Ing. Christoph Weh-

mann, Dipl.-Ing. Jochen Zapf, Dipl.-Ing. Markus Zimmermann,  
Dr.-Ing. Martin Zimmermann 

 
All rights reserved by the editor 

 
Version 1a    December 2010 

 

            is a registered trademark (No. 30 2009 064 238) of Professor Dr.-Ing. Frank Rieg



                     Theory Manual 

3 

WELCOMES TO Z88 Aurora! 
 
Z88 is a software package for solving structural mechanical, static problems with the aid of 
the Finite Element Method (FEM), which is available under GNU-GPL as free software with 
source code. The software was originally developed by Professor Frank Rieg in 1986. 
 

In addition to the present compact Z88, which is currently available in the 13th version, an ex-
tended program Z88 Aurora is developed by a team of ten under the supervision of Professor 
Rieg since 2009. Z88 Aurora is based on Z88 and is available for Windows 32-BIT and 64-
BIT for free download (as executable file). A MAC OS-X version will follow soon. In addi-
tion to the efficient solvers contained in Z88, Z88 Aurora offers a graphic user interface, a 
completely new preprocessor and an extension of the approved postprocessor Z88O. In the 
development of Z88 Aurora great importance was attached to intuitive operation.  
 

The present version Z88 Aurora offers, in addition to static strength analyses, a material data-
base containing more than 50 established construction materials. Further modules such as 
non-linear strength calculations, natural frequency analysis, contact and thermal analyses are 
under development. 
 

Z88 does not want to compete with professional FEA programs for workstation or main-
frames which can do really everything, but are hardly payable and complicated to operate. 
While you are still puzzling about installation and start of some programs of this genre also in 
the PC class, you will have already calculated the first examples with Z88 Aurora. And the 
online-help is always only one keystroke or mouse click away. The Z88 system may operate 
with English or German language depending on your setting (ENGLISH or GERMAN) in the 
options menu. 
In addition to this Theory Manual, there are a User Manual, an Example Manual, an Installa-
tion Manual and video sequences available. 
 

If you already have FEA experiences, you can start at once. If you are a beginner in this area, 
I would recommend secondary literature. Here are a few choices: 

 

 Zienkiewicz, O.C.; Taylor, R.L.: The Finite Element Method, Volumes 1-3, 5th edition, But-
terworth- Heinemann and  John Wiley & Sons, 2000 

 Bathe, K.J.: Finite Element Procedures. Prentice Hall, 1995 
 Rieg, F.; Hackenschmidt, R.: Finite Elemente Analyse für Ingenieure. Carl Hanser Verlag, 

München Wien 2009, 3rd edition (in German language) 
 
The Z88 website: www.z88.de. Give us your feedback! 
 
Professor Dr. Frank Rieg      Bayreuth, December 2010 
Lehrstuhl Konstruktionslehre und CAD 
(Chair for Engineering Design and CAD) 
Faculty of Engineering Science 
University of Bayreuth, Germany 
frank.rieg@uni-bayreuth.de 
www.uni-bayreuth.de/departments/konstruktionslehre 
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LICENSE 
 
Software Products: Z88 Aurora - Software as delivered, ("Software") 

Licensor: Chair for Engineering Design and CAD ("LCAD")  

 

This is a legal agreement between you, the end user, and  

Chair for Engineering Design and CAD, Universitaetsstr. 30, 95447 Bayreuth, Germany. 

By installing, by downloading or by agreeing to the integrated conditions of this End-User License Agreement, you are 

agreeing to be bound by the terms of this agreement. If you do not agree to the terms of this agreement, promptly return the 

Software and the accompanying items (including written materials and binders or other containers) to the place you obtained 

them for a full refund.  

 

1. Grant of license 

This LCAD license agreement (license) permits you to use a copy of the Software acquired with this license on any com-

puter in multiple number of installations. The Software is in use on a computer when it is loaded into the temporary memory 

or installed into the permanent memory (e.g. hard disk, CD ROM, or other storage device) of that computer.  

2. Copyright 

The Software is owned by LCAD and is protected by copyright laws, international treaty provisions, and other national laws. 

Therefore, you must treat the Software like any other copyrighted material (e.g. a book). There is no right to use trademarks, 

pictures, documentation, e.g. without naming LCAD. 

3. Other restrictions 

You may not rent or lease the Software, but you may transfer your rights under this LCAD license agreement on a permanent 

basis provided you transfer all copies of the Software and all written materials, and the recipient agrees to the terms of this 

agreement. You may not reverse engineer, decompile or disassemble the Software. Any transfer must include the most recent 

update and all prior versions. The Software is for calculation Finite-Element-Structures; there is no warranty for accuracy of 

the given results.  

4. Warranties 

LCAD gives no warrants; the Software will perform substantially in accordance with the accompanying documentation.  

Any implied warranties on the Software are not given.  

5. No liability for consequential damages 

In no event shall LCAD be liable for any other damages whatsoever (including, without limitation, damages for loss of busi-

ness profits, business interruption, loss of business information, or other pecuniary loss, personal damage) arising out of the 

use of or inability to use this Software product, even if LCAD has been advised of the possibility of such damages.  

7. Governing Law 

This Agreement shall be governed exclusively by and be construed in accordance with the laws of Germany, without giving 

effect to conflict of laws.  
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1.  THE FINITE ELEMENTS PROGRAM Z88 Aurora  
 

 

 
 
 
 

1.1 General overview of the FE program Z88 Aurora  

THE Z88 PHILOSOPHY IS ALSO VALID FOR Z88 AURORA! 
 

- Fast and compact: Developed for PC, no ported mainframe system 

- full 64-BIT support for Windows and Mac 

- native Windows and Mac OS X programs, no emulations 

- Windows and Mac OS X versions use the same computing kernels 

- full data exchange from and to CAD systems (*.DXF, and new: *.STP, *.STL) 

- FE structure import (*.COS, *.NAS and new: *.BDF, *.ANS, *.INP) and new: FE 

export (*.INP) 

- context sensitive online-help and video tutorials 

- simplest installation with Microsoft® Installer (MSI) 

- Z88 Aurora is fully compatible with Z88 V13. Existing Z88 V13 files can simply 

be imported! 
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Note: 
Always compare FE calculations with analytical rough calculations, results of experi-

ments, plausibility considerations and other tests without exception!  
 

Keep in mind that sign definitions of Z88 (and also other FEA programs) differ from the usual 
definitions of the analytical technical mechanics from time to time. 
Z88 Aurora is a powerful, complex computer program, which is still in the development 
phase. Please note that currently not all the functions are implemented, therefore certain func-
tions cannot be selected and the modification of parameters in the user interface to some ex-
tent show no effect.  
How Z88 deals with other programs and utilities etc. is not predictable! It is the aim of this 
research version to give you an understanding of the fundamental operating concept. The de-
velopers of Z88 Aurora are interested in constantly improving this software. Proposals, sug-
gestions, and remarks can be sent to aurorasupport@z88.de. In addition, FAQs are available 
on the homepage www.z88.de and users can exchange experiences in a forum. 
The present version Z88 Aurora V.1 was tested on WINDOWS 7 32 and 64 bit, WINDOWS 
Vista 32 and 64 bit and WINDOWS XP 32 and 64 bit. 
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1.2 Summary of the Z88 element library: 

TWODIMENSIONAL PROBLEMS: PLANE STRESS, PLATES, BEAMS, TRUSSES 
 

Plane Stress Triangle Element No. 3  
- Shape functions quadratic, but linear 
- Quality of displacements very good 
- Quality of stresses in the centre of gravity good 
- Computing effort: average 
- Size of element stiffness matrix: 12  12 
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4
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Plane Stress isoparametric Element No. 7  
- Quadratic isoparametric Serendipity element 
- Quality of displacements very good 
- Quality of stresses in the Gauss points very well 
- Quality of stresses in the corner nodes good 
- Computing effort: High 
- Size of element stiffness matrix: 16  16 
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Y
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8

1 2
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Truss No. 9  
- Linear function 
- Quality of displacements exact (Hooke 's law) 
- Quality of stresses exact (Hooke ' s law) 
- Computing effort: Minimal 
- Size of element stiffness matrix: 4  4 

2

1
X

Y
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Plane Stress Isoparametric Element No. 11  
- Cubic isoparametric Serendipity element 
- Quality of displacements excellent 
- Quality of stresses in the Gauss points excellent 
- Quality of stresses in the corner nodes good 
- Computing effort: Very high 
- Size of element stiffness matrix: 24  24 
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Beam No. 13  
- Linear function for tensile stress, cubic function for bending stress 
- Quality of displacements exact (Hooke 's law) 
- Quality of stresses exact (Hooke ' s law) 
- Computing effort: Low 
- Size of element stiffness matrix: 8  8 
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Plane Stress Isoparametric Element No. 14  
- Quadratic Isoparametric Serendipity element 
- Quality of displacements very good 
- Quality of stresses in the Gauss points very good 
- Quality of stresses in the corner nodes good 
- Computing effort: medium 
- Size of element stiffness matrix: 12  12 
Y

X
1

3

5

6

4 2 
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Isoparametric Plate Element No. 18  
- Quadratic Isoparametric Serendipity element following Reissner- Mindlin's theory  
- Quality of displacements very good 
- Quality of stresses in the Gauss points good 
- Quality of stresses in the corner nodes acceptable 
- Computing effort: medium 
- Size of element stiffness matrix: 18  18 
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3
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6

4 2
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Isoparametric Plate Element No. 19  
- Cubic Isoparametric Lagrange element following Reissner-Mindlin's theory  
- Quality of displacements very good 
- Quality of stresses in the Gauss points very good 
- Quality of stresses in the corner nodes good 
- Computing effort: High 
- Size of element stiffness matrix: 48  48 
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Isoparametric Plate Element No. 20  
- Quadratic Isoparametric Serendipity element following Reissner-Mindlin's theory  
- Quality of displacements very good 
- Quality of stresses in the Gauss points good 
- Quality of stresses in the corner nodes quite good 
- Computing effort: medium 
- Size of element stiffness matrix: 24  24 
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AXISYMMETRIC PROBLEMS: 
 

Torus No. 6  
- Linear function 
- Quality of displacements average 
- Quality of stresses in the corner nodes inaccurate 
- Computing effort: Low 
- Size of element stiffness matrix: 6  6 
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Torus No.8  
- Quadratic Isoparametric Serendipity element 
- Quality of displacements very good 
- Quality of stresses in the Gauss points very good 
- Quality of stresses in the corner nodes good 
- Computing effort: High 
- Size of element stiffness matrix: 16  16 
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Torus No.12  
- Cubic Isoparametric Serendipity element 
- Quality of displacements excellent 
- Quality of stresses in the Gauss points excellent 
- Quality of stresses in the corner nodes good 
- Computing effort: Very high 
- Size of element stiffness matrix: 24  24 
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Torus No.15  
- Quadratic Isoparametric Serendipity element 
- Quality of displacements very good 
- Quality of stresses in the Gauss points very good 
- Quality of stresses in the corner nodes good 
- Computing effort: High 
- Size of element stiffness matrix: 12  12 

5

3

R (=X)

Z (=Y)

2

6

4
1

 

Cam No. 5  
- Linear function for torsion and tensile stress, cubic function for bending stress 
- Quality of displacements exact (Hooke 's law) 
- Quality of stresses exact (Hooke ' s law) 
- Computing effort: Low 
- Size of element stiffness matrix: 12  12 
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21
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SHELL PROBLEMS: 
 

Shell No.21  
- curvilinear, isoparametric Serendipity volume shell element 
- isoparametric transformation  
- arbitrary curvature of element possible 
- good calculation of both displacements and stresses 
- Stresses in the corner nodes (good for an overview) or in the Gauss points (substantially 
more exact)  
- Computing effort: high 
- Size of element stiffness matrix: 4848 
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Shell No.22  
- curvilinear, isoparametric Serendipity volume shell element 
- isoparametric transformation  
- arbitrary curvature of element possible 
- good calculation of both displacements and stresses 
- Stresses in the corner nodes (good for an overview) or in the Gauss points (substantially 
more exact) 
- Computing effort: average 
- Size of element stiffness matrix: 3636 

 

 
 

Shell No.23  
- curvilinear, isoparametric Serendipity shell element 
- Shape functions quadratic 
- isoparametric transformation 
- all nodes in one plane 
- good calculation of both displacements and stresses 
- Stresses in the corner nodes (good for an overview) or in the Gauss points (substantially 
more exact) 
- Computing effort: high 
- Size of element stiffness matrix: 48x48 
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Shell No.24  
- curvilinear, isoparametric Serendipity shell element 
- Shape functions quadratic 
- isoparametric transformation 
- all nodes in one plane 
- good calculation of both displacements and stresses  
- Stresses in the corner nodes (good for an overview) or in the Gauss points (substantially 
more exact) 
- Computing effort: average 
- Size of element stiffness matrix: 3636 
 

 
 

 
 
SPATIAL PROBLEMS: 
 

Truss No. 4  
- Linear function 
- Quality of displacements exact (Hooke 's law) 
- Quality of stresses exact (Hooke ' s law) 
- Computing effort: Minimal 
- Size of element stiffness matrix: 6  6 
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X
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Beam No. 2  
- Linear function for tensile stress, cubic function for bending stress 
- Quality of displacements exact (Hooke 's law) 
- Quality of stresses exact (Hooke ' s law) 
- Computing effort: Low 
- Size of element stiffness matrix: 12  12 
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Hexahedron No. 1  
- Linear shape functions 
- Quality of displacements average 
- Stresses in the Gauss points useable 
- Stresses in corner nodes inaccurate 
- Computing effort: very high 
- Size of element stiffness matrix: 24  24 
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Hexahedron No. 10  
- Quadratic Isoparametric Serendipity element 
- Quality of displacements very good 
- Stresses in the Gauss points very good 
- Stresses in corner nodes good 
- Computing effort: extremely high 
- Size of element stiffness matrix: 60  60 
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Tetrahedron No. 17  
- Linear shape functions 
- Quality of displacements bad 
- Stresses in the Gauss points inaccurate 
- Stresses in corner nodes very inaccurate 
- Computing effort: medium 
- Size of element stiffness matrix: 12  12 
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Tetrahedron No. 16  
- Quadratic Isoparametric Serendipity element 
- Quality of displacements very good 
- Stresses in the Gauss points very good 
- Stresses in corner nodes good 
- Computing effort: very high 
- Size of element stiffness matrix: 30  30 
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2. THE Z88 COMPUTING UNITS: 
2.1 Overview: 

Z88 always exclusively works at the tasks required at the moment. Under the new user inter-
face the established Z88 programs are accessed. Z88 is no gigantic, monolithic program, but 
consists of several separate running modules according to the UNIX philosophy "Small Is 
Beautiful". They are loaded into the main memory according to your requirements, execute 
their tasks and release the main memory again. In this way Z88's achieves its enormous speed 
and faultlessness beating many other FE programs! The Z88 modules communicate by files, 
cf. Chapter 3. 
 

2.2 Short Description of the Modules: 

I. THE PRE- AND POSTPROCESSOR   
 
In addition to the established Z88 modules, Z88 Aurora possesses a graphic user interface. All 
input which in Z88 V13 was made via the input files Z88I1-5.TXT is now directly made in 
Z88 Aurora. But of course, existing input files from Z88 V13 can be imported into Z88 Aurora 
any time. For the plotting of results the approved Z88O was extended and adjusted. Further-
more, for the further use of the results the files Z88O1-8.TXT can be displayed and printed. 
 

II. THE SOLVER  
 
The solver is the heart of any FEA system. It reads the general structure data Z88I1.TXT and 
the boundary conditions Z88I2.TXT and, if necessary, the file for surface and pressure loads 
Z88I5.TXT. Basically, the Z88 input files can be created by CAD converter Z88X, by 3D- 
converter Z88G, by mesh generator Z88N, by editor or word processor system or by a mixed 
procedure, e.g. by CAD and editor. The solver generates prepared structure data Z88O0.TXT 
and processed boundary conditions Z88O1.TXT, calculates the element stiffness matrices, 
compiles the total stiffness matrix, scales the system of equations, solves the (huge) system of 
equations and stores the displacements in Z88O2.TXT. Therefore, the main task of every FEA 
system, the calculation of displacements, is solved. Thereupon the stresses are calculated and 
entered in Z88O3.TXT; afterwards the nodal forces are calculated and entered in Z88O4.TXT. 
Furthermore, the solver generates two files Z88O5.TXT and Z88O8.TXT, which are used for 
the communication with Z88 Aurora. 
 
Z88 features three different solvers: 

 

 A so-called Cholesky solver without fill-in. It is easy to handle and very fast for small 
and medium structures. However, like any direct solver Z88F reacts badly on ill-
numbered nodes but you may improve the situation with the Cuthill-McKee program 
Z88H. Z88F is your choice for small and medium structures, up to 20,000 ... 30,000 
degrees of freedom. 

 A so-called direct sparse matrix solver with fill-in. It uses the so-called PARDISO 
solver. This solver is very fast but uses very much dynamic memory.  It is your choice 
for medium structures, up to 150,000 degrees of freedom on ordinary 32 bit PCs. How-
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ever, we’ve computed structures with ~ 1 million of DOF very fast using a computer 
featuring 32 (!) Gbyte of memory, 4 CPUs, 64 bit Windows version of Z88. 

 A so-called sparse matrix iteration solver. It solves the system of equations by the 
method of conjugate gradients featuring SOR- preconditioning or preconditioning by 
an incomplete Cholesky decomposition depending on your choice. This solver deals 
with structures with more than 100,000 DOF at nearly the same speed as the solvers of 
the large and expensive commercial FEA programs as our tests showed. In addition, a 
minimum of storage is needed.  This solver is your choice for large structures with 
more than 150,000 … 200,000 DOF. FE-structures with ~ 5 million DOF are no prob-
lem for it if you use a 64 bit operation system (Windows or LINUX or Mac OS X) 
along with the 64 bit version of Z88 and about 6 GByte of memory. This very stable 
and approved solver works always, thus, you may use it as your standard solver. 

 
In Z88 Aurora the solver types are selected via the solver menu: 
 
 
 
 
 
 
 
 
 

Figure 1: Solver menu 
 

III. THE INTERFACE MODULES TO CAD AND FEA SYSTEMS      

  
 
Z88 Aurora offers the possibility to import a multitude of established file formats from com-
mercial simulation programs, pure geometry data or super structures, as well as to continue 
using existing FE data or CAD data from Version 13 of the Open Source program Z88. Fur-
thermore, data can be exported in different formats. Each of these converters offers an individ-
ual range of functions and its own setting options, if necessary. In chapter 4.1 the single func-
tions of the auxiliary programs as well as the procedure when using them is explained in detail. 
You have the following possibilities: 
 

 Z88 import: Data from Z88 V13 can be further used in Z88 Aurora. 
 

 STEP import: You can import 3D geometry data in the STEP data format according to 
 DIN ISO 10303 AP 203 and AP 214. This format is supported by most 3D CAD  sys-
tems. 

 

 DXF import and export: You have the possibility to import 2D and 3D FE structures 
 which were generated in a 2D CAD system (preferably AutoCAD), to edit them or to 
 directly calculate them. In the same way FE structures can be written as *.dxf again. 
 

 STL import: Z88 processes stereo lithography data which contain a triangulated 3D 
structure. This format is also typically used as input data for CAM programs. That is 
why most CAD programs can generate this file type. 
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  NASTRAN import: The CAD system Pro\ENGINEER and other commercial programs 
can write FE data (continuum elements and boundary conditions) as *.nas file. These 
can be directly imported into Z88 Aurora. 

 

 ABAQUS import and export: Similar to the NASTRAN case, the input files (*.inp) of 
 the program ABAQUS can be edited. Additionally, FE data generated in Z88 Aurora 
 can be exported as input files.  
 

 ANSYS import: Direct transformation of ANSYS data into data for Z88 Aurora. 
  

 COSMOS import: The import of COSMOS files known from previous versions is still 
 supported. 
 

IV. THE MESH GENERATOR FOR ORDERED MESHES  
 
The mesh generator ("mapped-mesher" in the menu "Preprocessor") reads the super structure 
data Z88NI.TXT (which again can be generated by a CAD system or compiled by hand) and 
computes the general structure data Z88I1.TXT.  
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2.3 Which Z88 Element types can be produced automatically? 

Table 1: Automatically producible element types 
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3. THE INPUT AND OUTPUT OF Z88 AURORA 
 
Generally, the input and output files in Z88 Aurora, unlike in Z88, are created while operating 
the user interface. Of course it is possible to import and edit existing Z88 V13 input files into 
Z88 Aurora. Additionally, all boundary conditions from existing files can be edited and altered 
directly on the Z88 Aurora user interface. The following table offers an overview of the input 
and output files: 
 

Table 2: Input and output of Z88 Aurora   
 

 
 
Dimensions, i. e. measurement units, are not used explicitly. You can work in optional meas-
urement systems, e.g. in the Metric or Imperial measurement system. Use inches, Newton’s, 
pounds, tons, millimetres, meters, and yards - whatever you prefer. But make sure to keep the 
one chosen measurement units throughout all computations of this structure. Example: You 
want to work with mm and N so Young's modulus must be used in N/mm2. 
Why work with files? Is that not old-fashioned and does "interactive" working not do a better 
job? In Z88 Aurora you have both possibilities!  
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Any kind of preprocessing and postprocessing is possible without restrictions. You can 
generate the input files by small, self-written pre-programs (such a pre-program is the mesh 
generator Z88N) or leave the job of processing the output data to other programs: You can 
quite easily load Z88 output files into EXCEL and analyse them there. Or you use Z88 Aurora 
and manual adjust the input in the text editor later, if necessary, because only few boundary 
conditions have changed or you want to use a different material for calculation. Very often 
input files are produced much faster than by any interactive queries: Many input lines are 
similar to prior lines: Use the block operations of your editor for copying! 
 
Every FEA program can, and so does Z88 Aurora, produce a huge amount of data junk from 
time to time. You are very often interested only in very specific results, e.g. of special nodes. 
The output files are simple ASCII files. You can edit and shorten them as you like and print 
only the really interesting results. 
 
Downward compatibility: 
Z88 V13.0 files are completely compatible. Z88 files for V11.0 and V12.0 are compatible, if 
the the plate flag and the surface and pressure loads flag are supplied. The import functions of 
Z88 Aurora include all possibilities to import existing Z88 files and to continue using them in 
Z88 Aurora.  
  
This is why we do not want to refrain from explaining the input and output of the program. 
Z88 Aurora is supposed to be as transparent to experienced users as the reliable Z88!  
 
 
Rules for entering values: 
There is no need for special rules or field divisions, only the usual C rules apply: 
 All values are to be separated by at least one blank 
 Integer numbers may contain any point or exponents 
 For floating point numbers no points need to be provided 
 Numerical values which are 0 (zero), have to be entered explicitly. 

 
Integer numbers 
Right 1 345 55555 0 
Wrong 1. 345. 55555E+0 no entry 

 
Floating point numbers (Z88 uses internally double precision floating point numbers  
[Double]) 
Right 1. 345 5.5555E+10 0 
Wrong 1, 345, O (letter O) no entry 

 
 
Z88 input files may have comments in every line if all corresponding data has been filled out 
before. Separate the last data and the comment at least by one blank. Lines in Z88 input files 
can include 250 bytes (really needed are noticeably less than 80). Blank lines and pure com-
ment lines are not permitted. 
Problems which often occur when editing text files: 
 Are the files really pure text files, well in the ASCII format? 
 Have hidden control characters been added by your text processor without being noticed? 
 Is the last line of an input file terminated by at least one RETURN ? 
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 Is your structure statically determined or in any way statically over defined (allowed!)?  
Statically undetermined structures can appear easily for Beams No.2, Cams No.5 and 
Beams No.13. 

 Is the coincidence list defined properly? Especially Hexahedrons No.10 are very sensitive 
to wrong numbering. 

 
Z88 input files for UNIX and Windows have the same structure. You may load without re-
striction Z88-UNIX files into Windows and vice versa. 
 

3.1 Creating input files 

Z88 Aurora is a pre- and postprocessor for Z88. As a matter of principle, the user can gener-
ate the desired calculation model completely in Z88 Aurora. Users who already know Z88, 
however, are supposed to get the possibility to edit the input files with an editor or word proc-
essor as usual. These altered files have to be imported again for subsequent use in Z88 
Aurora. In case of word processor systems you have to pay attention to create pure ASCII 
texts, which means without concealed control characters. Every word processor program in-
cludes such an option. The single Z88 V13 input files read: 
 

 Z88I1.TXT (general structure data, coordinates, coincidence, material information) 
 Z88I2.TXT (boundary conditions and loads) 
 Z88I3.TXT (control values for the stress processor) 
 Z88I4.TXT (control values for the sparse matrix solver Part 2 Z88I2, Pardiso interface) 
 Z88I5.TXT (surface and pressure loads, if needed) 
or Z88NI.TXT (input file of the mesh generator Z88N) 
 

Since further functionalities are projected in Z88 Aurora, such as natural frequency calcula-
tion, non-linear material performance etc. the existing Z88 file structures have been adjusted 
to the additional requirements. There are now several definition files, additionally, not all in-
formation required for the calculation are used from the Z88I files. The changes resulting 

from this are henceforth marked by a . The single Z88 Aurora input files read: 
 

 Z88I1.TXT (general structure data, coordinates, coincidence) 
 Z88I2.TXT (load cases, boundary conditions and loads) 
 Z88I5.TXT (surface and pressure loads, if needed) 
 Z88MAT.TXT (material definition) 
 Z88ELP.TXT (element parameters) 
 Z88MANAGE.TXT (control parameters for the stress processor, contains Z88I4.TXT) 
or Z88NI.TXT (input file of the mesh generator Z88N) 
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3.1.1 GENERAL STRUCTURE DATA Z88I1.TXT  
 
In Z88I1.TXT the geometry and material data of the structure are deposited. 
 
1st input group: 
General data in the first line, contains general structure data. Write all numbers into a line, 
separate at least by one blank respectively. All numbers here of the type [Long]. 
 

1st number:   Dimension of the structure (2 or 3) 
2nd number:   Number of nodes of the FEA structure 
3rd number:   Number of elements 
4th number:   Number of degrees of freedom 
5th number:   Number of material information lines 
6th number:   Coordinate flag KFLAG (0 or 1) 
7th number:   Beam flag IBFLAG (0 or 1) 
8th number:   Plate flag IPFLAG (0 or 1) 
9th number:   Surface and pressure loads flag IQFLAG (0 or 1) 

   Not contained in Z88 Aurora-generated Z88I1.TXT! 

10th number: Shell flag IHFLAG (0 or 1) 
 
Explanations: 
KFLAG: 
At input of 0 the coordinates are expected Cartesian while at input of 1 polar or cylindrical 
coordinates are expected. The latter are then converted into Cartesian coordinates and there-
upon stored in this form in Z88O0.TXT.  
Caution: The axially symmetric elements No.6, 8, 12 and 15 positively expect cylindrical co-
ordinates, set KFLAG to 0 here! 
 

IBFLAG: 
If Beams No.2 or Beams No.13 appear in the structure, then set beam flag IBFLAG to 1, oth-
erwise it must be 0. 
 Example: A three-dimensional structure of Hexahedrons No.10 and Beams No.2 is 
 supposed to have 10 elements. The coordinates are entered in Cartesian coordinates, 
3  material info lines, 270 degrees of freedom and 45 nodes.  
 > Thus: 3   45   10   270   3  0   1  0   0 
 

IPFLAG: 
If Plates No.18, No.19 or No.20 appear in the structure, then set plate flag IPFLAG to 1, oth-
erwise it must be 0. 
 Example: A two-dimensional structure of Plates No.20 is supposed to have 100  ele-
ments. The coordinates are entered in cylindrical coordinates, 2 material info  lines, 540 
degrees of freedom and 180 nodes. The pressure on plates is found in the material laws  (i.e. 
IQFLAG=0). 
 > Thus: 2   180   100   540   2   1   0   1   0 
 
Caution: This Z88 release allows only beams or plates in a structure, not both in the 
same structure, because the DOF of the beams and the plates are not compatible! 
 
IQFLAG: 
This flag controls if the surface and pressure loads file Z88I5.TXT is read (1) or not (0). The 
boundary conditions file Z88I2.TXT features constraints, defections and nodal forces. Surface 
and pressure loads may be defined in Z88I5.TXT, if needed. 
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 In Z88 Aurora-generated files, the IQFLAG is contained in the file Z88MANAGE.TXT. 
 
The following plane elements can deal with surface loads: plane stress elements No.7, 11 and 
14, torus elements No.8, 12 and 15. 
 
The following plane elements can deal with surface and pressure loads: hexahedrons No.1 
and 10 and tetrahedrons No.16 and 17, shells 21, 22, 23, and 24. 
 
The plate elements No.18, 19 and 20 may read the pressure loads via Z88I5.TXT, (then set 
IPFLAG = 1 and IQFLAG = 1) but it is easier to define the pressure loads directly with the 
material entries of the file Z88I1.TXT (then set IPFLAG = 1 and IQFLAG = 0). 
 
 Example 1: 

A three-dimensional structure of tetrahedrons No.16 features 100 elements, 180 
nodes,  540 DOF, 1 material information line, no change of coordinate system, no 
beams, no plates; use the surface and pressure loads file Z88I5.TXT. 

 > Thus: 3  180  100  540  1  0  0  0  1  0 
 
 Example 2: 
 A plate structure of elements No.18 features 1000 elements, 2000 nodes, 3000 DOF, 3 
 material information lines, no change of coordinate system, no beams, use the surface 
 and pressure loads file Z88I5.TXT. 
 > Thus: 2  2000  1000  3000  3  0  0  1  1  0 
 
IHFLAG: 
The shell flag is "1" when using shell elements. 
 
2nd input group: 
Starting with line 2, contains coordinates of nodes, one line per node, node numbers strictly 
ascending. 
 
1st number: node number [Long] 
2nd number: Number of the degrees of freedom for this node [Long] 
3rd number: X-coordinate or, if KFLAG is 1, R- coordinate [Double] 
4th number: Y-coordinate or, if KFLAG is 1, PHI-coordinate [Double] 
5th number: Z-coordinate or, if KFLAG is 1, Z-coordinate [Double] 
 
The Z coordinate can be dropped at 2-dimensionalen structures. Enter angles PHI in radian. 
 
Example 1: The node no.156 has 2 degrees of freedom and the coordinates X = 45.3 and Y = 
89.7 . 
> Thus: 156  2  45.3  89.7 
 
Example 2: The node no.68 is supposed to have 6 degrees of freedom (a Beam No.2 is at-
tached) and cylindrical coordinates R = 100. , PHI = 0.7854 (corresponds to 45 °), Z = 
56.87. 
> Thus: 68  6  100.  0.7854  56.87 
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3rd input group: 
Starting after last node, contains coincidence, i.e. the allocation of the element type and the   
corresponding nodes of every element. Edit two lines for every finite element. The element 
numbers, like the node numbers, must be entered strictly ascending. 
 
1st line: 
1st number: Element number [Long]. 
2nd number: Element type (1 to 24) [Long]. 
 
2nd line: Depending on element type 
1st number: 1st node number for coincidence 
2nd number: 2nd node number for coincidence 
... 
20th number: 20th node number for coincidence 
 
Write all numbers into a line, separate at least by one blank respectively. All numbers here of 
the type [Long]. 
 
Example: An Isoparametric Serendipity Plane Stress Element No.7 has element number 23. 
The coincidence has the global nodes 14, 8, 17, 20, 38, 51, 55, 34 (locally these are the nodes 
1-2-3-4-5-6-7-8) > Thus resulting in two lines: 
23  7 
14  8  17  20  38  51  55  34 
 
4th input group: 
Starting after last element contains Material information, one line for each material informa-
tion. Write all numbers into a line, separate at least by one blank respectively. 
 
1st number: This material information line starts with element no. inclusively [Long] 
2nd number: This material information line ends with element no. inclusively [Long] 
3rd number: Young’s Modulus [Double] 
4th number: Poisson's Ratio [Double] 
5th number: Integration order (0, 1, 2, 3, 4, 5, 7 or 13) [Long] 
6th number: Cross section value QPARA [Double] 
 
... And if beams (but not plates!) are defined in addition: 
 
7th number: Second moment of inertia yy (bending around yy axis) [Double] 
8th number: Max. distance from neutral axis yy [Double] 
9th number: Second moment of inertia zz (bending around zz axis) [Double] 
10th number: Max. distance from neutral axis zz [Double] 
11th number: Second moment of area (torsion) [Double] 
12th number: Second modulus (torsion) [Double] 
 
... And if plates (but not beams!) are defined and IQFLAG=0,  in addition: 
7th number: area load  
 
Explanation cross section value QPARA: 
QPARA is element type-dependent, e.g. for hexahedrons QPARA is 0, for trusses QPARA is 
the cross-sectional area and for plane stress elements QPARA is the thickness. See list of fi-
nite elements, chapter 5. 
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Example: The structure has 34 finite elements No.7. The thicknesses is supposed to vary: 
Elements 1 to 11 thickness 10 mm, elements 12 to 28 15 mm and elements 29 to 34 now 18 
mm. Material steel. Integration order is supposed to be 2. 
> Thus three material information lines: 
1    1   11   206000.   0.3   2  10. 
2  12   28   206000.   0.3   2  15. 
3  29   34   206000.   0.3   2  18. 
 

 Z88 Aurora was extended by a material data base. This is why the material data are 
now deposited in Z88MAT.TXT, which again refers to a material file in *.csv-format. 
When importing an existing Z88 file via the "Import" function, Z88MAT.TXT is created 
automatically. Subsequent changes to Z88I1.TXT, however, are not considered any 
more after the import. You will find the description of Z88MAT.TXT further on in this 
chapter. 
 

 Z88 Aurora possesses its own definition file for beams and plate information. This 
Z88ELP.TXT can also be created automatically from an existing Z88I1.TXT. Changes 
which are made in Z88I1.TXT after the import, are not considered. 
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3.1.2 MESH GENERATOR INPUT FILE Z88NI.TXT 
The layout of Z88NI.TXT is very similar to the layout of Z88I1.TXT, the input file for the FE 
processor: Only the &- labelled data is required in addition. 
 
Mind the following formats: 
[Long] = 4 bytes or 8 bytes integer number 
[Double] = 8 bytes floating point number, alternatively with or without point 
[Character] = A letter 
  
1st input group: 
 

1st number: Dimension of the structure (2 or 3) 
2nd number: Number of nodes of the super structure 
3rd number: Number of super-elements 
4th number: Number of degrees of freedom 
5th number: Number of material information lines 
6th number: Coordinate flag KFLAG (0 or 1) 
7th number: Beam flag IBFLAG (must be 0 here!) 
8th number: Plate flag IPFLAG (0 or 1) 
9th number: Surface and pressure loads flag IQFLAG (0 or 1) 
10th number: Shell flag IHFLAG (0 or 1) 
& 10th number: Trap radius flag NIFLAG (0 or 1) 
& 11th number: Coordinate flag KFLAG (0 or 1) 
 
Write all numbers into a line, separate at least by one blank respectively. All numbers here of 
the type [Long]. 
 
Explanations: 
KFLAGSS: 
At input of 0 the coordinates are expected Cartesian while at input of 1 polar or cylindrical 
coordinates are expected. The latter are then converted into Cartesian coordinates and there-
upon stored in this form in Z88I1.TXT. Caution: The axially symmetric elements No.8 and 12 
positively expect cylindrical coordinates, set KFLAGSS to 0 here! 
 
IPFLAG: 
If Plates No.20 appear in the structure, then set plate flag IPFLAG to 1, otherwise it must be 
0. 
 
IQFLAG: 
You may set here IQFLAG=1 as a reminder if you plan to define a surface and pressure loads 
file Z88I5.TXT. However, IQFLAG has no effect for the mesh generator. 
 
NIFLAG: 
In order to identify already defined nodes the mesh generator needs a trap radius. The defaults 
are 0.01 for for EPSX, EPSY and EPSZ if NIFLAG is 0. These values can be modified at ex-
tremely small or large structures. To initiate this change, set NIFLAG to 1. The new trap radi-
uses of EPSX, EPSY and EPSZ are then defined in Z88NI.TXT as the 6th input group. 
 
 Example: Super-structure 2-dimensional with 37 nodes, 7 super elements, 74 degrees 
 of freedom, one material information line. Cartesian coordinates, no beams (anyway 
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 forbidden in the mesh generator file), no plates, no surface loads, trap radius default 
 value. 
 > Thus:  2  37  7  74  1  0  0  0  0  0 
 
KFLAG: 
Internally, Z88N works with natural or Cartesian coordinates. Sometimes, though, you might 
want to enter the output of Z88N as polar or analogously cylindrical coordinates into the out-
put file Z88I1.TXT. With this flag (=1) the output takes place in polar or analogously cylin-
drical coordinates. This is independent from the flag KFLAGSS for the input file Z88NI.TXT. 
 
2nd input group: 
Starting in line 2, contains coordinates of nodes, one line per node, node numbers strictly as-
cending. 
 
1st number: Node number [Long] 
2nd number: Number of the degrees of freedom for this node [Long] 
3rd number: X-coordinate or, if KFLAG is 1, R- coordinate [Double] 
4th number: Y-coordinate or, if KFLAG is 1, PHI-coordinate [Double] 
5th number: Z-coordinate or, if KFLAG is 1, Z-coordinate [Double] 
 
The Z coordinate can be skipped at 2-dimensional structures. 
 
Example: The node no.8 has 3 degrees of freedom and the coordinates X = 112.45, Y = 0. , Z 
= 56.75. > Thus: 8 3  112.45  0.  56.75  
 
3rd input group: 
Starting after last node, contains coincidence, i.e. the allocation of the element type and the   
corresponding nodes of every element. Edit two lines for every super element. The element 
numbers, like the node numbers, must be entered strictly ascending. 
 
1st line: 
1st number: Element number [Long]. 
2nd number: Super-element type (1,7,8,10,11,12,20,21) [Long]. 
 
2nd line: Depending on element type 
1st number: 1st node number for coincidence 
2nd number: 2nd node number for coincidence 
..... 
20th number: 20th node number for coincidence 
 
Write all numbers into a line, separate at least by one blank respectively. All numbers here of 
the type [Long]. 
 
Example: An Isoparametric Serendipity Plane Stress Element No.7 has element number 23. 
The coincidence has the global nodes 14, 8, 17, 20, 38, 51, 55, 34 (locally these are the nodes 
1-2-3-4-5-6-7-8, see chapter 4.7).  
> Thus resulting in two lines: 
 
23   7 
14   8   17   20   38   51   55   34 
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4th input group: 
Starting after last super element contains material information, one line for each material in-
formation. Write all numbers into a line, separate at least by one blank respectively. 
 
1st number: This material information line starts with super-element no. inclusively [Long] 
2nd number: This material information line ends with super-element no. inclusively [Long] 
3rd number: Young’s Modulus [Double] 
4th number: Poisson's Ratio [Double] 
5th number: Integration order (1, 2, 3 or 4) [Long] 
6th number: Cross section value QPARA [Double] 
 
... And if plates are defined and IQFLAG=0, in addition: 
 
7th number: Surface load 
 
No beam data here, in contrast to Z88I1.TXT, because beams are forbidden in the mesh gen-
erator. 
 
Explanation cross section value QPARA: 
QPARA is element type-dependent, e.g. for hexahedrons 0, for trusses the cross-sectional 
area, and for plane stress elements the thickness. Here are the mesh generator-suitable ele-
ments: 
Element No.1:   Isoparametric Hexahedrons 8 nodes 
Element No.7:   Isoparametric Serendipity Plane Stress Element 8 nodes 
Element No.8:   Isoparametric Serendipity Torus 8 nodes 
Element No.10: Isoparametric Serendipity Hexahedron 20 nodes 
Element No.11: Isoparametric Serendipity Plane Stress Element 12 nodes 
Element No.12: Isoparametric Serendipity Torus 12 nodes 
Element No.20: Isoparametric Serendipity Plate 8 nodes 
Element No.21: Isoparametric Serendipity Shell 16 nodes 
 
Example: The structure has 34 super elements No.7. The thicknesses are supposed to vary: 
Elements 1 to 11 thickness 10 mm, elements 12 to 28 15 mm and elements 29 to 34 now 18 
mm. Material steel. Integration order shall be 2.  
> Thus three material information lines: 
1    1   11   206000.   0.3   2  10. 
2  12   28   206000.   0.3   2  15. 
3  29   34   206000.   0.3   2  18. 
 
& 5th input group: 
Starting after last material information line contains the descriptive details for the mesh gen-
eration process. 2 lines for every super element. 
1st line: 
1st number: Super element no. [Long] 
2nd number: Finite element type (types 1, 7, 8, 10, 19, 20) to be generated [Long] 
 
2nd line: 
1st number: Number of finite elements in local x direction [Long] 
2nd number: Type of subdivision of CMODE x [Character] 
3rd number: Number of finite elements in local y direction [Long] 
4th number: Type of the subdivision CMODE y [Character] 
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5th number: Number of finite elements in local z direction [Long] 
6th number: Type of the subdivision of CMODE z [Character] 
 
The two values for Z are skipped at 2-dimensional structures. 
 
Explanations: CMODE can accept the following values: 
 "E": Subdivision equidistant, "e" is also permitted 
 "L": Subdivision increasing geometrically in local coordinate direction 
 "l":  Subdivision decreasing geometrically in local coordinate direction 

 
The local x-, y and z axes are defined as follows: 
 Local x axis points in direction of local nodes 1 and 2 
 Local y axis points in direction of local nodes 1 and 4 
 Local z axis points in direction of local nodes 1 and 5 

 
See following sketch below. 
 
Example: Subdivide an Isoparametric Serendipity Plane Stress Element with 12 nodes (Ele-
ment No.11) into finite elements of type Isoparametric Serendipity Plane Stress Element with 
8 nodes (Element No.7). Subdivide in local x direction three times equidistantly and subdi-
vide 5 times increasing geometrically in local y direction. The super element is supposed to 
have the number 31. Thus resulting in two lines: 
31   11 
7   3   E   5  L  (e or E for equidistant are equivalent) 
 
& 6th input group, optionally after the end of input group 5: 
Input group 6 is required if NIFLAG was set to 1, i. e. the trap radiuses is supposed to be 
modified. 1 line: 
 
1st number: Trap radius in global X direction EPSX [Double] 
2nd number: Trap radius in global Y direction EPSY [Double] 
3rd number: Trap radius in global Z direction EPSZ [Double] 
 
Skip the Z detail for 2-dimensionalen structures. 
 
Example: The trap radiuses shall be set to 0.0000003 for X, Y and Z respectively.  
> Thus : 0.0000003     0.0000003     0.0000003 
This is effective only if NIFLAG was set to 1 in the first input group! 

 
 
& 7th input group, optionally after the end of input group 6: 
Input group 7 is required, if KFLAG is supposed to be set to 1, i.e. an output in polar or cy-
lindrical coordinates is supposed to take place, otherwise 0 for Cartesian coordinates. 
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Figure 2: Definition of local x, y and z direction using the example of different element types 
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3.1.3 BOUNDARY CONDITIONS FILE Z88I2.TXT 
In the file Z88I2.TXT the boundary conditions, displacements and forces affecting the model 
are deposited. Surface loads are found in the file Z88I5.TXT. In Z88 Aurora it will be possi-

ble in the future to calculate different load cases ( ), additionally the calculation can be con-

ducted with mass properties ( ). At the moment, only the calculation of one load case is 
possible. 
 
Mind the following formats: 
[Long]  = 4 bytes or 8 bytes integer number 
[Double] = 8 bytes floating point number, alternatively with or without point 
 
1st input group: 
Number of boundary conditions/loads. The boundary conditions are allocated to a load case, 
the mass property is defined. 
 

1st number: Number of boundary conditions/loads [Long] 

 2nd number: number of the load case 

 3rd number: MGFLAG 

 4th number: gravity vector X-coordinate 

 5th number: gravity vector Y-coordinate 

 6th number: gravity vector Z-coordinate 

 further entry into 1st input group: Name of the load case 
 

 Explanation MGFLAG: 
If the calculation includes a mass property, the mass flag must be set to "1"; otherwise it must 
be "0". 
 
2nd input group: 
The boundary conditions and loads are defined. For every boundary condition and for every 
load respectively one line. 
 
1st number: node number with boundary condition: load or constraint [Long] 
2nd number: Respective degree of freedom (1,2,3,4,5,6) [Long] 
3rd number: Header flag:  1 = force [Long] or 2 = displacement [Long] 
4th number: Value of the load or displacement [Double] 
 
Example: The node 1 shall be fixed respectively at his 3 degrees of freedom: support. Node 3 
gets a load of -1,648 N in Y direction (i.e. DOF 2), the degrees of freedom 2 and 3 is sup-
posed to be fixed for the node 5. Resulting in 6 boundary conditions. 
 
> Thus: 
6 1 0 0 0 0 load case_1 
1   1   2   0 
1   2   2   0 
1   3   2   0 
3   2   1   -1648 
5   2   2   0 
5   3   2   0 
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For edge loads and surface loads pay attention to: 
 
It is a good idea to define surface and pressure loads in the file Z88I5.TXT. However, for 
plates no.18, no.19 and no.20 you may define the surface load directly in the material infor-
mation lines (file Z88I1.TXT in Z88V13 or Z88ELP.TXT in Z88 Aurora)!  
 
Only forces and constraints should entered here into Z88I2.TXT. 
 
Of course, it is possible, too, to convert surface loads into concentrated forces "manually" and 
to write these forces into Z88I2.TXT (which is the classical way but somewhat cumbersome). 
 
For the elements with linear shape function, e.g. Hexahedrons No.1 and Torus No.6, edge 
loads and surface loads are distributed to the elements simply and straight onto the respective 
nodes. 
 
However, for elements with higher shape functions, i. e. square (Plane Stress No.3, No.7, To-
rus No.8, Hexahedron No.10) or cubic (Plane Stress No.11 and Torus No.12) edge and sur-
face loads have to be put onto the elements according to fixed rules which are not always 
physically obvious. Amazingly, some load components can have negative values. Though 
these facts are not obvious, nevertheless they lead to correct results which is not the case for 
intuitive distribution of loads to the respective nodes. 
 
An example shall clarify the facts: 
 

 

 
Figure 3: Correct load distribution on the nodes 

 
 
An FE structure consists of three plane stress elements No.7 with the load of 1,000 N distrib-
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uted on the upper edge in Y direction. Above incorrect, below correct load sharing: 
 
Incorrect: 1,000N/7=142.86 N per node. Not correct for elements with square shape function. 
 
Correct: 2 × 1/6 + 2 × (1/6+1/6) + 3 × 2/3 = 18/6 = 3, corresponds to 1,000 N 
"1/6 points" = 1,000/18×1 =   55.55 
"2/6 points" = 1,000/18×2 = 111.11 
"2/3 points" = 1,000/18×4 = 222.22 
Control: 2×55.55 + 2×111.11 +3×222.22 = 1,000 N, o.k.  
 
Here's why: 

1/41/4
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Figure 4: Elements with linear shape functions, e.g. Hexahedron No.1 
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5: Elements with quadratic shape functions,  

e.g. plane stress element No.3 and 7, Torus No.8, Hexahedron No.10 
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Figure 6: Elements with cubic shape functions,  
e.g. plane stress element No.11, Torus No.12 

 
3.1.4 STRESS PARAMETER FILE Z88I3.TXT 

 In Z88 Aurora this file does not have to be explicitly generated any more. The same in-
formation is contained in the file Z88MANAGE.TXT. When importing existing Z88 files the 
data contained in Z88I3.TXT are transferred automatically into Z88MANAGE.TXT. Subse-
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quent changes to Z88I3.TXT, however, remain ineffective! Immediately before the calcula-
tion Z88 Aurora generates a new Z88I3.TXT which contains all the new parameters. 
 
Mind the following format: 
[Long] = 4 bytes or 8 bytes integer number 
 
File only consists of only one line: 
 
1st value: For isoparametric elements No. 1, 7, 8, 10, 11, 12, 14, 15, 16, 17, 18, 19, 20: 
Value of the integration order INTORD [Long] 
 
Valid is: 
 
0     =  Calculation of stresses into 

the corner nodes,   reduced stress calculation 
not possible. 

 
For isoparametric elements No.1, 7, 8, 10, 11, 12, 19, 20, 23: 
1, 2, 3 or 4 (i.e. N×N)   =  Calculation of stresses into the Gauss points. 
      Reduced stress calculation is possible. A good 
      value is 3 (= 3×3 Gauss points). For element type 
      No.1 and No.20 a value of 2 could be fine. For 
      type No.19 a value of 4 (= 4×4 Gauss points) is 
      recommended. 
 
For isoparametric elements No.14, 15, 18, 24: 
3, 7 or 13 (i.e. N)   =  Calculation of stresses into the Gauss points. 
      Reduced stress calculation is possible. A good 
      value is 7 (= 7 Gauss points). For type No.18 a 
      value of 3, i.e. 3 Gauss points could be fine. 
 
For isoparametric elements No.16, 17: 
1, 4 or 5 (i.e. N)   =  Calculation of stresses into the Gauss points. 
      Reduced stress calculation is possible. A good 
      value for element type 16 is 5 (= 5 Gauss points). 
      For element type No.17 a value of 1 could be 
      fine. 
     
This 1st value has no meaning for element types No.2, 3, 4, 5, 6, 9, and 13.  
 
2nd value: For the plane stress elements No.3, 7, 11 and 14: KFLAG [Long] 
 
0 = standard stress calculation 
1 = additional calculation of the radial and tangential stresses 
3rd value: Choice of the reduced stress hypothesis: ISFLAG [Long] 
0 = no calculation of the reduced stresses 
1 = von Mises stresses 
2 = principal or Rankine stresses 
3 = Tresca stresses 
 
Example 1: The stress processor Z88D is supposed to calculate for a structure of Plane Stress 
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Elements No.7 the stresses for every finite element into 33 Gauss points: INTORD = 3. In 
addition to this calculation of standard-stresses a calculation of radial and tangential stresses 
is supposed to be run, KFLAG = 1.  Furthermore compute von Mises stresses: ISFLAG = 1. > 
Thus:  3    1    1 
Example 2: The stress processor Z88D is supposed to compute only the stresses of the corner 
nodes for every finite element No.7. Only standard-stress calculation, thus KFLAG = 0. Do 
not compute von Mises stresses, thus ISFLAG = 0.  
> Thus:  0    0    0 

 
3.1.5 PARAMETER FILE Z88I4.TXT  

 This file is not needed any longer in Z88 Aurora; all information is available in 
Z88MANAGE.TXT which will be described later in this chapter.  
 
3.1.6 SURFACE/PRESSURE LOADS FILE Z88I5.TXT 
Mind the following formats: 
[Long]  = 4 bytes or 8 bytes integer number 
[Double] = 8 bytes floating point number, alternatively with or without point 
 
1st input group: 
1st number: Number of surface and pressure loads  [Long] 
2nd number: No. of load case 
 
2nd input group: 
Surface and pressure loads – one line per load. Of course, an element may have more than one 
load applied. The following entries depend from the element type with surface and pressure 
load to avoid unnecessary data entries.  
As for the local directions:  Define the the local r and s directions by the nodes and their se-
quence. These local directions for the surface loads may differ from the local r and s coordi-
nate system of the finite element. The numbering has to conform to the element numbering, 
see chap. 5.  
 
Plain stress element No.7 and 14 and Torus elements No.8 and 15: 
Element number with surface load [Long] 
Pressure, positive if pointing towards the edge [Double] 
Tangential shear, positive in local r-direction [Double] 
3 nodes of the loaded edge [3 × Double] 
 
Example: The plain stress element 97, image 11.7-1, features surface load. The load should 
be applied onto the edge defined by the corner nodes 5 and 13 and by the mid node 51. One 
surface load is applied normally to the edge with 100 N/mm and the other surface load is ap-
plied tangentially and positive in local r direction with 300 N/mm (defined by the two corner 
nodes). 
 Thus:  
 
>  97  100.   300.  5   13   51 
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Plane stress element with surface loads  

Hexahedron No.1: 
Element number with surface and pressure load  [Long] 
Pressure, positive if pointing towards the surface [Double] 
Tangential shear, positive in local r direction [Double] 
Tangential shear, positive in local s direction [Double] 
4 nodes of the loaded surface [4 × Long] 
 
Example: The hexahedron 356 features surface loads. The load should be applied onto the 
surface defined by the corner nodes 51, 34, 99 and 12 .The first surface load is pressure with 
100 N/mm. The second surface load is applied tangentially and positive in local r direction 
with 200 N/mm. The third surface load is applied tangentially and positive in local s direction 
with 300 N/mm. Thus 
>  356   100.   200.   300.   51   34   99   12 
 
Hexahedron No.10: 
Element number with surface and pressure load [Long] 
Pressure, positive if pointing towards the surface [Double] 
Tangential shear, positive in local r direction [Double] 
Tangential shear, positive in local s direction [Double] 
8 nodes of the loaded surface [8 × Double] 
 
Example: The hexahedron 456 features surface loads. The load should be applied onto the 
surface defined by the corner nodes 51, 34, 99 and 12 and the mid nodes 102, 151, 166 and 
191. The first surface load is pressure with 100 N/mm. The second surface load is applied 
tangentially and positive in local r direction with 200 N/mm. The third surface load is applied 
tangentially and positive in local s direction with 300 N/mm. Thus 
> 456   100.   200.   300.   51   34   99   12  102  151  166  191 
 
Tetrahedron No.17: 
Element number with pressure load [Long] 
Pressure, positive if pointing towards the surface [Double] 
3 nodes of the loaded surface [3 × Double] 
 
Example: The tetrahedron 356 features surface loads. The load should be applied onto the 
surface defined by the corner nodes 51, 34 and 12.The surface load is pressure with 100 
N/mm pointing towards the surface, i.e. positive. Thus: 
> 356   100.   51   34  12 
 
Tetrahedron No.16: 
Element number with pressure load [Long] 
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Pressure, positive if pointing towards the surface [Double] 
6 nodes of the loaded surface [6 × Double] 
 
Example: The tetrahedron 888 features surface loads. The load should be applied onto the 
surface defined by the corner nodes 51, 34 and 12 and the mid nodes 65, 66 and 67.The sur-
face load is pressure with 100 N/mm pointing towards the surface, i.e. positive. Thus: 
> 888   100.   51   34   12   65   66   67 
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Tetraeder with pressure load on one element side 

Plate elements No.18, 19 and 20: 
Element number with pressure load [Long] 
Pressure, positive if pointing towards the surface [Double] 
It is easier to enter the pressure loads for plate elements directly into the structure file 
Z88I1.TXT than via Z88I5.TXT 

 
Shell No.21: 
This file is optional and is only used, if in addition to nodal forces surface and pressure loads 
are supposed to be applied to elements No. 21: 
> Element number 
> Pressure, positive if pointing towards the surface 
> Tangential shear in local r direction 
> Tangential shear in local s direction 
> 4 corner nodes and 4 mid nodes of the loaded surface. Mathematically positive in plain 
view. 
The local r direction is defined by the nodes 1-2, the local s direction is defined by the nodes 
1-4. The local nodes 1 to 8 for the surface load may differ from the local nodes 1 to 8 used for 
the coincidence. 

 
Shell No.21 with pressure load   
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Shell No.22: 
This file is optional and is only used, if in addition to nodal forces surface and pressure loads 
are supposed to be applied to elements No. 22: 
> Element number 
> Pressure, positive if pointing towards the surface 
> 3 corner nodes and 3 mid nodes of the loaded surface. Mathematically positive in plain 
view. 

 
 

Shell No.22 with pressure load   

Shell No.23: 
This file is optional and is only used, if in addition to nodal forces surface and pressure loads 
are supposed to be applied to elements No. 23: 
> Element number 
> Pressure, positive if pointing towards the surface 
> 4 corner nodes and 4 mid nodes of the loaded surface. Mathematically positive in plain 
view. 
 

 
Shell No.23 with pressure load  
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Shell No.24: 
This file is optional and is only used, if in addition to nodal forces surface and pressure loads 
are supposed to be applied to elements No. 24: 
> Element number 
> Pressure, positive if pointing towards the surface 
> 3 corner nodes and 3 mid nodes of the loaded surface. Mathematically positive in plain 
view. 

 
 

Shell No.24 with pressure load  

 
Simplified procedure for Shells No.23 and No.24: 
If a pressure affects a whole element group, this pressure can be specified simplified in the 
section "Material information“ of Z88I1.TXT, like in the case of plates: 
 
4th input group, starting after last element, contains: 
Material information, 1 line for each material information. 
 
This material information line starts with element no. inclusively [Long] 
This material information line ends with element no. inclusively [Long] 
Young’s Modulus [Double] 
Poisson's Ratio [Double] 
Integration order [Long] 
Cross section value QPARA [Double] 
> Surface load [Double] 
 
For this, the shell flag IHFLAG must not be 0 and at the same time the surface load flag must 
be 0. 
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 MATERIAL FILE Z88MAT.TXT 
Because of the extension by a material database the material data in Z88 Aurora are stored in 
a separate file. When importing an existing Z88I1.TXT, the material information is extracted 
and automatically transferred into Z88MAT.TXT. Editing Z88I1.TXT later is possible, the 
information, however, is not taken over by Aurora (workaround: reimporting). The file 
merely consists of an input group in one line, a *.csv file which contains the material data is 
accessed from this file. The structure is very similar to that of the last input group in 
Z88I1.TXT. 
 
1st input group: 
1st number: Number of materials 
 
2nd input group: one line for each material 
1st number: Material starts with element no. inclusively 
2nd number: Material ends with element no. inclusively 
3rd number: Integration order 
4th number: Material is allocated to solid No. 
5th number: MATFLAG (0=Hooke's material) 
further entry into 1st input group: Name of *.csv file 
 
Explanation MATFLAG: 
No options yet in Z88 Aurora 1.0, standard value 0 means Hooke's material performance. In 
future Z88 Aurora versions non-linear material performance is planned. For this the new 
MATFLAG is required. 
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3.1.7  ELEMENT PARAMETER FILE Z88ELP.TXT 
Contains the plate, shell and beam information, known from the last input group of the 
Z88I1.TXT. For this file the same applies as for Z88MAT.TXT: When importing an existing 
Z88 file the required data are transferred automatically, later editing of the Z88I1.TXT, how-
ever, does not influence the result. 
 
1st input group: 
1st number: Number of Element parameters 
 
2nd input group: one line for each used element 
1st number: Element starts with 
2nd number: Element ends with 
3rd number: QPARA 
 
for beams: 
4th number: Second moment of inertia yy (bending around yy axis) [Double] 
5th number: Max. distance from neutral axis yy [Double] 
6th number: Second moment of inertia zz (bending around zz axis) [Double] 
7th number: Max. distance from neutral axis zz [Double] 
8th number: Second moment of area (torsion) [Double] 
9th number: Second modulus (torsion) [Double] 
 

3.1.8  SOLVER DEFINITION FILE Z88MANAGE.TXT 
The solver definition file Z88MANAGE.TXT contains a lot of information which used to be 
available in different files (Z88I3.TXT and Z88I4.TXT). It is divided into three parts: the 
global part, the linear solver part and the stress part. The following figure shows a typical 
Z88MANAGE.TXT. 
 
DYNAMIC START 
--------------------------------------------------------------------------- 
Z88aurora Version 1 
--------------------------------------------------------------------------- 
 

--------------------------------------------------------------------------- 
GLOBAL 
--------------------------------------------------------------------------- 
 

GLOBAL START 
 SIMCASE     1    
 NEG            1 
 IQFLAG  1 
 LOADCASE  1 
 LOADSELECT  0 
 LOADADD  0 
GLOBAL END   
 

--------------------------------------------------------------------------- 
LINEAR SOLVER 
--------------------------------------------------------------------------- 
 

SOLVER START 
 ICFLAG  3 
 MFLAG   0 
 MAXIT   10000 
 EPS   1e-007 
 RALPHA  0.0001 
 ROMEGA  1.1 



                     Theory Manual 

45 

 ICORE   4 
 OUTPATH  ".\out_of_core\" 
 DUMPMAX  1000 
SOLVER END 
 

--------------------------------------------------------------------------- 
STRESS 
--------------------------------------------------------------------------- 
   

STRESS START  
 NINTO   5    
 KSFLAG   0 
  ISFLAG   1  
STRESS END 
 

DYNAMIC END 
 
 
Explanations to the single specifications: 
 
GLOBAL: 
 

SIMCASE dummy value without any significance in Z88 Aurora Version 1 
 

NEG is the number of material laws 
IQFLAG is the surface load flag 
 

LOADCASE dummy value without any significance in Z88 Aurora Version 1 
 

LOADSELECT dummy value without any significance in Z88 Aurora Version 1 
 

LOADADD dummy value without any significance in Z88 Aurora Version 1 
 
LINEAR SOLVER: 
 

ICFLAG determines the solver type (0=Cholesky, 1=SICCG, 2=SORCG, 3=Pardiso) 
 

MFLAG dummy value without any significance in Z88 Aurora Version 1 
 

MAXIT is the first termination criterion. When reaching this number of iterations, the itera-
tion solvers SICCG and analogously SORCG are terminated in any case. The values of the 
solution vector reached up to this point are printed, however. 
 

EPS This value is compared to a norm of the residual vector. When this value is reached for 
the iteration solvers SICCG and SORCG, the solution reached should have a good precision. 
This is the second termination criterion. Enter a relatively small value, e.g. 0.00001 or 
0.0000001. Note that there is no absolute truth in this field! No matter which norm of the re-
sidual vector is compared against this limit - you can never be sure that all elements of the 
solution vector are precise. The choice of EPS influences the iteration count and, thus, the 
computing speed enormously. Remember this when comparing Z88 Aurora to the big, com-
mercial solvers (you do not know which termination criterions are internally used anyway): 
The limit you can adjust there may have absolutely nothing to do with EPS of Z88.  However, 
extensive tests proved that the deflections of different nodes compared quite well to those 
from the commercial solvers if EPS was between 0.00001 and 0.0000001 with similar com-
puting time. Please note: When computing large FEA structures with different solvers, you 
will never which solver delivers the best result anyway! 
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RALPHA is the convergence acceleration parameter . With this parameter for the SIC pre-
conditioner you choose the shift factor  for the iteration solver SICCG (from 0 to 1, good 
values may vary from 0.0001 to 0.1). 0.0001 is a good initial value. 
 

ROMEGA is the convergence acceleration parameter �. With this parameter for the SOR 
pre-conditioner you choose the relaxation factor  for the iteration solver SORCG (from 0 to 
2, good values may vary from 0.8 to 1.2). Which value to choose for ? Good question! Try 
 with 1, which will never lead to totally bad results, and then try other values for further runs 
with this structure. 
 

ICORE is a control parameter of the Pardiso solver. It determines the number of CPUs on 
multi-core computers. Allowed maximum is 9. 
 

OCCFLAG is the Out of Core variable of the Pardiso solver. 
 

OUTPATH is a control parameter of the Pardiso solver. It determines the swapping direc-
tory. 
 

DUMPMAX is the given maximum memory used by the Pardiso solver. 
 
Example 1: 
You want to use the Iterations Sparsematrix Solver and stop after 5000 iterations, the limit is  
0.0000001 and the convergence acceleration parameter  for SOR is 0,9, since you want to 
use the SORCG-Solver ("SORCG:sparse, iterativ"). 

> Thus: 
 MAXIT 5000 
 EPS  0.0000001 
 RALPHA Standard value without significance 
 ROMEGA 0.9 
 
Example 2: 
You want to use the Iteration Sparse Matrix Solver and you want to stop positively after 
10000 iterations, the limit shall be 10-9 and the convergence acceleration factor    for SIC 
shall be 0.001 because you want to use the SICCG-Solver ("SICCG:sparse, iterative").  

 
> Thus: 
 MAXIT 10000 
 EPS  1e-9 
 RALPHA 0.001 
 ROMEGA Standard value without significance 
 
Example 3:  
You want to use the direct Sparse Matrix Solver with fill-in ("Pardiso: sparse, direct") and 
you have two double core CPUs installed in your computer. 

> Thus: 
 MAXIT Standard value without significance 
 EPS  Standard value without significance 
 RALPHA Standard value without significance 
 ROMEGA Standard value without significance 
 ICORE 4 
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Example 4:  
You want to use the Cholesky solver. 

> Thus: 
The control values MAXIT, EPS, RALPHA, ROMEGA and ICORE can be arbitrary and are 
without significance. 
 
STRESS: 
See remarks on Z88I3.TXT. 
 
In the menu "Solver" under "Solver options" the parameters of the single solvers can be ed-
ited. For further information on the use of the solver menu see User Manual. For further in-
formation on the Cuthill-McKee program Z88H see chapter 4.2.4.  

 

 
 

Figure 7: Solver options menu for the control of the solver parameters of the four integrated 
solver types 

 
 

3.1.9 OUTPUT FILES Z88O0.TXT TO Z88O8.TXT 
 
The following list is an overview of the Z88 Aurora output files: 

 Z88O0.TXT – (prepared input data) 
 Z88O1.TXT – (prepared boundary conditions ) 
 Z88O2.TXT – (calculated displacements) 
 Z88O3.TXT – (calculated stresses) 
 Z88O4.TXT – (calculated nodal forces) 

 

The files Z88O5.TXT and Z88O8.TXT are no regular Z88 output files. They are internally 
used for the preprocessor and stored as ASCII files, so that experienced users can use them 
for their own routines, if necessary. 
 
3.1.10 DEFINITION FILE Z88.DYN  
General settings, such as memory needs or the appearance of Z88 Aurora are defined in the 
two definition files Z88.DYN and Z88ENVIRO.DYN. The user can influence their control 
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via the option menu (under "Help" > "Options"). For further information about the settings in 
the option menu see the Z88 Aurora User Manual. 
 
The files are located in the working directory of Z88 Aurora, which is, depending on the plat-
form, in z88aurorav1/bin/*(Selection operating system). The working directory must not be 
confused with the project directory, which is selected or defined independently by the user 
when starting the program. 
 

Purpose and structure of the definition file Z88.DYN 
 
At the start of the program Z88 Aurora requests a defined amount of memory, which can be 
controlled via the file Z88.DYN. Apart from that, Z88.DYN determines the language for Z88 
Aurora and any accessed Z88 modules. For the allocation of memory, the file possesses dif-
ferent parameters which define the maximum possible size of structures to be computed. 
MAXK, for example, determines the maximum number of nodes for the finite element calcu-
lation. At the end of this chapter you will find a list of all control parameters. If it becomes 
apparent during the use of Z88 Aurora that the memory does not suffice, you will get a re-
spective error message, see Figure 8.  
 

 

Figure 8: Memory overflow because of too many nodes 
 
After that, the dialog box "Options" opens, where the respective parameter can be increased 
under the tab "Memory", see Figure 9. The memory parameters always have an offset of 
about five for safety and stability reasons. Thus, for the calculation of a model with 1000 
nodes, the memory parameter MAXK must be set to 1005. 
 
After closing the dialog box, Z88 Aurora is quitted. In the background, the definition file was 
changed according to the adjustments. When running Z88 Aurora next time, these changes are 
taken into account. There will be no data loss! The memory parameters can also be edited 
without previous memory overflow alert. For this purpose, select the function "Options“in the 
menu „Help". The tab Memory contains all memory parameters. After closing the dialog box 
the file Z88.DYN is updated and you return to Z88 Aurora without reboot.  
The file Z88.DYN can also be edited manually by experienced users. The important thing is 
that certain keywords remain in any case. Blank lines or comments are optional, only the up-
percased keywords are recognized. After the keyword follows an integer value, separated by 
at least one blank. The order of the keywords is optional. 
 
There are no limits for the size of the structures for Z88. The maximum size is limited only by 
virtual memory of your computer and your imagination! However, for very large structures 
you may use Z88 with 64 Bit integers and pointers (i.e. the 64 Bit versions for Windows and 
Mac OS X) to avoid overflows of internal loop counters. 



                     Theory Manual 

49 

Figure 9: Memory settings in the options menu 
 
In the 32 bit versions Z88 Aurora uses 

 Floating-point numbers      with doubles    = 8 Bytes and 
 Integers and pointers          with longs         = 4 Bytes. 

In the 64 bit versions Z88 uses 
 Floating-point numbers      with  doubles   = 8 Bytes and 
 Integers and pointers           with longs        = 8 Bytes. 

 
 shows an example for a file Z88.DYN with the mentioned keywords. Figure 10

 
 
DYNAMIC START 
-------------------------------------------------------------- 
Z88 new version 14.0                   Z88 new Version 14.0 
-------------------------------------------------------------- 
 
-------------------------------------------------------------- 
LANGUAGE       SPRACHE 
-------------------------------------------------------------- 
GERMAN 
-------------------------------------------------------------- 
Common entries for            gemeinsame Daten fuer 
  
all modules      alle Module  
  
-------------------------------------------------------------- 
 
  COMMON START 
 MAXKOI          3000000 
 MAXK            700000 
 MAXE            300000 
 MAXNEG          100 
 MAXGP           2000000 
 MAXOTE          5000000 
 MAXSTRUGEOELE   50 
 MAXLASTF        300 
 MAXSTLK         50000 
 MAXMAT          1000 
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 MAXXEPTHE       100 
 MAXXEPMAT       10000 
 MAXMAPAR        100 
 MAXMMREG        10000 
 MAXSTAT         50 
 MAXFREQ         20 
 MAXNFG          100000 
 MAXRBD          100000 
 MAXPR           100 
 MAXPRT          1 
  COMMON END 
DYNAMIC END 

Figure 10: Example of the definition file Z88.DYN 
 

The file must start with the keyword DYNAMIC START and end with the keyword DY-
NAMIC END. By entering GERMAN, German is selected as language, for English select 
ENGLISH. Between the lines COMMON START and COMMON END there are the memory 
parameters. 
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MAXKOI determines the number of coincidence nodes. This is the sum of the nodes of all 
elements. If, for example, we deal with a structure consisting of two hexahedrons with eight 
nodes each, connected at four nodes, there are 12 nodes (MAXK = 12 + 5 = 17) but 16 coin-
cidence nodes (MAXKOI = 8 + 8 + 5 = 17). 
 

MAXK Maximum number of nodes in the structure. 
 

MAXE Maximum number of elements in the structure. 
 

MAXNEG Maximum number of material info lines for the structure. 
 

MAXGP determines the maximum number of integration points for the visual display. 
 

 MAXOTE is the maximum number of surfaces. A surface is the outwardly visible side of 
an element. Depending on the structure, there might be more surfaces than elements. 
 

 MAXSTRUGEOELE determines the maximum number of nodes and elements which can 
be generated by means of the tool "Create FE structure". 
 

 MAXLASTF dummy value without any significance in Z88 Aurora Version 1 
 

 MAXSTLK is the maximum number of nodes for imported STL meshes. 
 

 MAXMAT is the maximum number of materials which can be saved in the material data-
base.  
 

 MAXXEPTHE dummy value without any significance in Z88 Aurora Version 1 
 

 MAXXEPMAT dummy value without any significance in Z88 Aurora Version 1 
 

 MAXMAPAR dummy value without any significance in Z88 Aurora Version 1 
 

MAXMMREG defines the largest possible number of rules for meshing super structures by 
means of the module Z88N. 
 

 MAXSTAT is the maximum number of intervals in the statistic function for equivalent 
stresses, tab "Statistics" of the post processor. 
 

 MAXFREQ dummy value without any significance in Z88 Aurora Version 1 
 

MAXNFG defines the maximum number of degrees of freedom. In case of continuum ele-
ments, for example, each node possesses three degrees of freedom. Thus, you get the number 
of degrees of freedom by multiplying the number of nodes by the factor three. 
 

MAXRBD is the maximum possible number of boundary conditions which can be applied. 
 

MAXPR defines the maximum number of pressure loads which can be applied. 
 

 MAXPRT dummy value without any significance in Z88 Aurora Version 1 
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3.1.11   DEFINITION FILE Z88ENVIRO.DYN 
Z88 Aurora includes a project file management. While working with Z88 Aurora, a project di-
rectory must be selected. All input and output files as well as log files are stored here. The file 
Z88ENVIRO.DYN contains the path of this project directory. Apart from that, several other 
paths are stored here as well. They permit, for example, the automated access to text viewers 
like Adobe Reader. Furthermore, some control flags for the configuration of the user interface 
are stored here, e.g. a flag for the definition of the number of processors set by default.  
 
Table 3: List of flags of file Z88ENVIRO.DYN  

Flag Purpose Possible Values 
Controls if mid nodes in case of 
Hexahedron No. 10 with 20 nodes 
and Tetrahedron No. 16 with 10 
nodes can be selected (1) or not (0) 

0: Mid nodes not selectable 
NODEPICK 1: Mid nodes selectable 

 

Determines if at start of program all 
elements (0) or only surface ele-
ments (1) are displayed 

0: All elements 
RANDSTART 

1: Only surface elements 

Defines the language and is always 
compliant with Z88.DYN 

1: German 
LANG 

2: English 
Default value for the number of 
computing kernels used in the cal-
culation. This is the number found 
in the solver under  "extended set-
tings"  

e.g. 1: One computing kernel 
CPU 

e.g. 4: Four computing kernels 

Maximum memory for swapping of 
solver "Pardiso" 

OCC_MEM e.g. 2000 

Path for swapping of solver "Pard-
iso" 

OCC_PATH e.g. D:\OOC 

0: hidden 
TOOLBAR_IMP Shows additional toolbar "Import" 

1: shown 
TOOL-
BAR_VIEW 

0: hidden 
Shows additional toolbar "View" 

1: shown 
Shows additional toolbar "Preproc-
essing" 

0: hidden 
TOOLBAR_PRE 

1: shown 
Speed of scroll wheel for view dis-
play 

SCROLLER 1 to 299 

ROTATOR Speed of rotation  for view display 0,1 to 2,0 
Displacement factor for view dis-
play 

TRANSLATOR 0,1 to 2,0 

 
Figure 11In  you find an example of the definition file Z88ENVIRO.DYN.  

Z88ENVIRO.DYN is also located in the subdirectory z88aurorav1/bin/* (Selection operating 
system). 
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#Projektverzeichnis auch von der letzten Sitzung 
 
WORKPATH           C:\z88aurorav1\docu\bsp\2 
 
#Addons die hinzugeschaltet werden koennen 
 
ADDONS   A01_GEOCON   C:\z88aurorav1\addons\geocon 
ADDONS   A02_TETGEN   C:\z88aurorav1\addons\tetgen 
ADDONS   A03_NETGEN   C:\z88aurorav1\addons\netgen 
 
#FLAGS zum Ansteuern der verschiedenen Optionen 
 
FLAG   NODEPICK   0 
FLAG   RANDSTART   0 
FLAG   LANG    2 
FLAG   CPU    1 
FLAG   OOC_MEM    2000 
FLAG   OOC_PATH    C:\ 
FLAG   TOOLBAR_IMP   0 
FLAG   TOOLBAR_VIEW   1 
FLAG   TOOLBAR_PRE   0 
FLAG   SCROLLER   150 
FLAG   ROTATOR   1 
FLAG   TRANSLATOR   1 
 
#PFADE zu externen Programmen 
 
PATH   P01_ACROBAT   C:\ 
PATH   P02_PLAYER   C:\ 
PATH   P03_BROWSER   C:\ 

Figure 11: Example Z88ENVIRO.DYN 
 

Lines which are preceded by a hashmark (#) are ignored by Z88 Aurora. They are meant to be 
assistance to the reader of the file. Behind WORKPATH there is the project directory which 
you are currently working on. Behind ADDONS you find the paths of additional modules. 
The flags listed in Table 3 are marked by the preceding keyword FLAG. They can be changed 
under "Help" > "Options" in the tab "View", see Figure 12. 
 

Behind "PATH" you find the paths of external programs which can be automatically ac-
cessed, for example to visualise the support. If no path is preset, C:\ is used as standard. These 
paths as well as all other settings of Z88ENVIRO.DYN can be modified under "Options" in 
the menu "Help", see Figure 12. Experienced users can edit them directly in the file. 
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Figure 12: Flags for the standard view (left) and the path settings (right) 
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4. THE Z88 MODULES 
 
Note: Always compare FE calculations with analytical rough calculations, results of ex-
periments, plausibility considerations and other tests without exception!  
 

4.1 Interfaces and file converters for CAD and FE programs 

Z88 Aurora offers the possibility to import a multitude of established file formats from com-
mercial simulation programs, pure geometry data or super structures, as well as to continue 
using existing FE data from Version 13 of the Open Source program Z88. Furthermore, data 
can be exported in different formats. Each of these converters offers an individual range of 
functions and its own setting options, if necessary. 
But since especially the actual proprietary data formats of simulation programs do not meet 
any national or international standard, the respective producers can conduct changes in the 
files when issuing a new version, which can influence the converters. When using neutral 
formats for geometry or product data (STL or STEP), some appropriate adjustments might 
have to be made in the CAD programs, in order to generate a functioning FE model in the de-
sired accuracy.  
 
CAUTION: In the following paragraphs the range of functions of the converters are listed as 
well as the programs with which they were tested. In spite of intensive tests we cannot guar-
antee the compatibility of files from other programs or newer versions. Please note the respec-
tive support in the explanations. 
 
There are two possibilities to access the import and export functions of files: 

1. Via the text menu ( ) Figure 13

2. Via the toolbar ( ) Figure 14

 

 
 

Figure 13: Import and export in the text menu 
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Figure 14: Import and export via the toolbar 

 
Depending on the range of functions of the converter, a multitude of FE model data can be 
imported or exported. You have the possibility to generate a complete FE structure or a super 
structure which can be meshed further by means of the integrated mapped mesher Z88N. The 
finite elements of the source program are properly transformed into the corresponding type in 
Z88 Aurora, and material data can be adopted. 
 
According to the contents of the original data it is possible, depending on the interface, to ap-
ply boundary conditions, i.e. boundary conditions and loads. But you can also apply them in 
Aurora, of course. You can find the respective overview of the model data, which you can 
adopt, in tables 1, 4, and 5. Please refer to table 1 in chapter 2 for information about the pos-
sible element types.  
 
As expected, the pure geometry interfaces only contain the function to import a three-
dimensional image without FE information. 
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Table 4: Model data which can be transferred from FE structure data 
 Z88V13 DXF  ABAQUS ANSYS  COSMOS NASTRAN  

  
FE structure     

FE super structure      
Material laws   

(1 mate-
rial) 

   

Point loads 
     

Boundary Conditions 
     

Area loads 
only      

import 
Solver options 

     

 
Table 5: Overview of the producible Z88 input data from external data 

 Z88 V13 DXF ABAQUS ANSYS COSMOS NASTRAN 
  

Z88I1.TXT      
Z88I2.TXT      
Z88I3.TXT      
Z88I4.TXT      
Z88I5.TXT      
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4.1.1 IMPORTING FILES FROM PREVIOUS Z88 VERSIONS UP TO V13 
 
What is the basic idea and which are the features? 
Downward compatibility is one of the basic prerequisites for the effective application of a 
simulation system. Who ever wants to revise their models every six months? Therefore all 
input files from previous versions can be used in Z88 Aurora. If necessary, only a few small 
adjustments must be made.  
 
Which Z88 versions can cooperate with Z88 Aurora? 
As a matter of principle, every input file from from every previous version can be imported. 
The function is mainly intended for the import of files from version 13. Therefore, older files 
must be updated to this version. For this purpose it is often sufficient to add single flags or 
value, according to a V13 manual. 
 
Which elements are supported by the converter? 
Of course you can use any element known from previous Z88 releases. 
 
Which functions does the converter offer? 
Import functions of the converter: 
Conversion > from Z88I1.TXT(V13) to Z88I1.TXT 
Conversion > from Z88I2.TXT(V13) to Z88I2.TXT 
Import > from Z88I3.TXT(V13) into the option settings of Z88 Aurora 
Conversion > from Z88I5.TXT(V13) to Z88I5.TXT 

 
Figure 15: Import of files from previous Z88 versions into Aurora 
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How to proceed? 
1. First you must import the structure data of your old model:  

In Z88 Aurora, select File > Import > Z88 files and in the subsequent selection menu 
select the option General structure data (Figure 16). Thus, all nodes, elements as well 
as existing material laws are directly transferred. If you do not want to apply any pre-
vious boundary conditions or stress parameters, you are already done!  

2. Importing boundary conditions, stress parameters and pressure in succession: 
Select File > Import > Z88(Z88I2.TXT, Z88I3.TXT, Z88I5.TXT). Please keep in mind 
that that you can only select only one file at a time! Therefore please repeat this step 
until all desired data are available. 

 
4.1.2 THE STEP IMPORT INTO Z88 AURORA Z88GEOKON(STEP) 
 
What is the basic idea and which are the features? 
 
The present STEP converter is based on the parsing and output routines of the Open Source 
3D-Suite OpenCASCADE. Therefore, the relevant sources (stepread.cpp and geocon.cpp) as 
well as a copy of the GPL license accompany Z88 Aurora.  
 
Most 3D CAD systems possess the possibility to generated models in files according to the 
international standard DIN ISO 10303 (STEP: STandard for the Exchange of Product model 
data). In most of these cases the application logs AP203 and AP214 are applied. These store 
the 3D geometry, described in highly accurate form, in text files. At the moment, only few 
CAD producers accommodate the fact that STEP could transfer a lot more (notes, parameters, 
materials and a lot more), according to the definition. The geometry, however, can mostly be 
used well also in FE programs, if a few points are taken into account: 
 

 Any STEP converter of a CAD program is only as good as the applied graphic 
kernel. Thus, if the CAD display contains mistakes, these mistakes are ex-
ported along with the data and might impede the processing. These mistakes 
are partially caused by the kernel itself, partially by the export of cluttered 
models. 

 In the CAD system, apply a modelling tolerance as high as possible (geometri-
cal tolerance e.g. < 0,01), if you have the possibility to repeatedly specify a tol-
erance during export, select a higher one than the modelling tolerance (e.g. = 
0,01).  

 Make sure that you use AP203 or AP214 during export. 
 Should problems during the import arise, consider simplifying your model be-

fore exporting it. Often, small roundings or chamfers are the cause for very 
small edges and surfaces, which impede the processing. If they are not manda-
tory for the FE simulation, they can be eliminated and therefore not exported. 

 
 
Which CAD systems can cooperate with Z88X? 
Any CAD systems which can export, i.e. write STEP files. However, we cannot guarantee 
any success. 
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Which elements are supported by the converter? 
Z88 Aurora first generates an STL file from the imported STEP files for visualization. This 
can be transferred into structures from elements No. 16 or No. 17 (linear or quadratic Tetra-
hedrons) by means of the existing meshers. 
 
Which functions does the converter offer? 
Z88Geokon > Conversion > from *.step or *.stp to visualised super structure Z88I1.txt 
 
How to proceed? 

1. Construct the 3D geometry to be calculated in your CAD system. In the process, 
please keep in mind the above mentioned particularities, if possible. Export the ge-
ometry as STEP AP203 or AP214 file. Please take care to export a volume model, not 
2D or wireframe model! It is recommended to check the original model and the inter-
change file with an integrated geometry check for defective and very small surfaces. 

2. In Z88 Aurora select File > Import > STEP data. In the subsequent selection box you 
can only select STEP files. Therefore select the desired file (Figure 17). 

3. From your file, Z88Geokon generates an STL, which is required for visualisation in 
Z88 Aurora. This data type can now be meshed and processed. 

 
The same functionalities are available when you access the STEP import via the toolbar. 
 

 
Figure 18: Importing STEP files 
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4.1.3 THE STL CONVERTER Z88GEOCON(STL)  
What is the basic idea and which are the features? 
Like STEP, STL (stereo lithography) is an established and standardised interchange format 
which can be generated from many CAD and CAM systems and is often used for Rapid Pro-
totyping and mould flow simulations. In addition, there are also systems in the area of Re-
verse Engineering, which can generate STL data from a 3D capture. This means that compo-
nents can also be simulated without using a CAD model.  
 
In contrast to STEP – which can describe the surface of the component very accurately by 
means of Bézier curves or splines – STL is always a discretisation of the component, i.e. all 
surfaces are divided into linearly edged triangles. Therefore, a loss of accuracy occurs espe-
cially at roundings or holes.  However, this occurs in the FEA anyway, however, after the 
meshing at the latest. But you should take into account that a poorly generated STL leads to 
an even more extensive loss of quality in the meshing process. Therefore you should check 
the following settings when generating STL data, if your source system offers this possibility: 

1. Angle control: If you can define the minimum angle in a surface triangle in your CAD 
system, it is recommended to permit angles with at least 30°. Very acute angles, de-
pending on the mesher, in most cases lead to acute angles in the elements of the FE 
mesh, which inevitably either generates elements which cannot be calculated (too 
small or negative Jacobian Determinant) or create bad results. 

2. Chord length: A very small chord length also leads to triangles as equilateral as possi-
ble, and to especially small triangles for the surface plot. You should select the short-
est straight edge of your model and conduct the meshing with, for example, half this 
value. 

3. Edge ratio: The quotient of the longest and the shortest edge of a triangle is also a 
measure for its regularity. Here, you should select a value close to 1.  

 
Which CAD systems can cooperate with Z88GEOCON? 
Any CAD systems which can export, i.e. write STL files in ASCII format. However, we can-
not guarantee any success. 
 
Which elements are supported by the converter? 
Z88 Aurora first generates a visualisation from the imported STL files. This can be trans-
ferred into structures from elements No. 16 or No. 17 (linear or quadratic Tetrahedrons) by 
means of the existing meshers. 
 
How to proceed? 

1. Construct the 3D geometry to be calculated in your CAD system. In the process, 
please keep in mind the above mentioned particularities, if possible. Export the ge-
ometry as STL file. It is recommended to check the original model and the interchange 
file with an integrated geometry check for defective and very small surfaces. Have a 
closer look at the STL and search for triangles with very acute angles. If they are lo-
cated in a part of the component which is important for the calculation, it is recom-
mended to export the interchange file one more time with modified settings. 

2. In Z88 Aurora select File > Import > STL data. In the subsequent selection box you 
can only select STL files. Therefore select the desired file (figure).  

3. The geometry is visualised in Z88 Aurora and can be processed. 
The same functionalities are available when you access the STEP import via the toolbar. 
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Figure 19: Importing STL files 
 
4.1.4 THE DXF CONVERTER IN AURORA: Z88X 
 
What is the basic idea and which are the features? 
2D CAD systems like AutoCAD offer a simple possibility to transfer complex 2D or 2½D 
structures into Z88 Aurora without an expensive 3D system. For this purpose, the layer-based 
structure of the DXF files is perfectly suited. It is an interesting fact that the CAD converter 
Z88X works in both directions. 
 
Which CAD systems can cooperate with Z88X? 
Any CAD systems which can import (read) and export (write) DXF files. However, we can-
not guarantee any success. Z88 V13 has been tested together with different AutoCAD and 
AutoCAD LT versions and AutoDesk's DXF guidelines have been regarded as the inventor of 
the DXF interface, i.e. according to AC1009 and AC1012. Choose AutoCAD R12 DXF 
format, if in doubt! 
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Figure 20: Accessing the DXF converter Z88X and import options in Z88 Aurora 
 
Which elements are supported by the converter? 
All element types from 1 to 24 except Tetrahedrons 16 and 17 
 
Which functions does the converter offer? 
Import functions of the converter: 
Z88X > Conversion > from Z88X.DXF to Z88I1.TXT 
Z88X > Conversion > from Z88X.DXF to Z88I*.TXT 
Z88X > Conversion > from Z88X.DXF to Z88NI.TXT 
 
Export functions of the converter: 
Z88X, > Conversion > from Z88I1.TXT to Z88X.DXF 
Z88X, > Conversion > from Z88I*.TXT to Z88X.DXF 
Z88X, > Conversion > from Z88NI.TXT to Z88X.DXF 
 
Since the converter is completely compatible in both directions, you can execute these possi-
bilities in succession as often as you wish. You will not find any data loss! That makes a most 
interesting variant: 
Mixed Operation, e.g. 
 
- Component- and super-structural layout done in CAD program 
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- Conversion CAD ---> Z88 
- Meshing in Z88 
- Conversion Z88 ---> CAD 
- Completing FE structure in CAD e.g.  
with not-mesh generator capable elements 
- Conversion CAD ---> Z88 
- Change e.g. material information in Z88 
- Conversion Z88 --- > CAD 
- Installation of the boundary conditions in CAD 
- Conversion CAD ---> Z88 
- FE analysis in Z88 
- Etc. 
 
How to proceed? 
 
4.1.5 FROM CAD SYSTEM TO Z88 
In the CAD system: 
Remark: This point case 1.1 will be explained in greater detail in chapter 4.1.7. This is a 
summary. 
 
1) Design your component. Order and layers as you like. 
2) Define the FEA structure or the super structure by lines and points. Any order and layers, 
therefore unproblematic and fast. 
3) Number the nodes with the TEXT function on the layer Z88KNR. Any order, therefore un-
problematic and fast. 
4) Write the element information with the TEXT function on the layer Z88EIO. Any order, 
therefore unproblematic and fast. 
5) Outline each element with the LINE function on the layer Z88NET. The only section with 
firm work rules and orders (because of the topological information).  
6) Write general information, material information and control information for the stress proc-
essor Z88D on the Layer Z88GEN. 
7) Define the boundary conditions on the layer Z88RBD. 
8) Define the surface and pressure loads (if needed) on the layer Z88FLA. 
9) Export or store your 3-D model or 2-D drawing under the name Z88X.DXF. 
 
 
In Z88 Aurora: Launching the CAD converter Z88X 
 
Select in the menu File > Import > DXF files. 
In the selection menu you can choose which of the following files are supposed to be created: 

 a file of general structure data Z88I1.TXT or 
 a complete Z88 data record with Z88I1.TXT, Z88I2.TXT, Z88I3.TXT, and Z88I5.TXT, 

if applicable 
 a Z88I1.TXT from a super structure which you can mesh manually in Aurora 
 a Z88I1.TXT from a super structure which is meshed with the information deposited in 

the DXF file (for this purpose, the ordered mesher Z88N is launched directly after-
wards) 

The same functionalities are available when you access the Z88 import via the toolbar. 
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4.1.6 FROM Z88 TO CAD SYSTEM 
In Z88: Input files Z88xx.TXT 
You have produced the input files 

 Mesh generator file Z88NI.TXT or 
 File of the general structure data Z88I1.TXT or 
 complete Z88 data set with Z88I1.TXT, Z88I2.TXT, Z88I3.TXT  and Z88I3.TXT (if 

needed) 
either by an editor, a word processing program, EXCEL or your own routine or by modifying 
data files that came from the CAD converter Z88X. 
 
In Z88 Aurora: Launching the CAD converter Z88X in the export mode 
Select in the menu File > Export > DXF files. 
All data of the current project, i.e. structure and boundary conditions, are written in the file 
Z88X.DXF.  If the input files contained polar- or cylindrical coordinates, they are converted 
into Cartesian coordinates. 
 
In the CAD system: 
Import the DXF file Z88X.DXF. Save the loaded drawing under a valid CAD name (e.g. at 
AutoCAD name.DWG) and work with the drawing. You can switch off and switch on the dif-
ferent Z88-layers as you like.  
 
4.1.7 Z88X IN DETAIL 
Proceed in the following steps and reserve the following layers 
 
Z88GEN: Layer for general information (1st input group in the mesh generator input file 
Z88NI.TXT and general structure data file Z88I1.TXT). Includes further the material infor-
mation (4th input group in the mesh generator input file Z88NI.TXT and general structure 
data file Z88I1.TXT). Add, if necessary, the data of the stress parameter Z88I3.TXT. 
Z88KNR: Layer including the node numbers. 
Z88EIO: Layer including the element information like element type and in the case of mesh 
generator input file Z88NI.TXT control information for the mesh generator. 
Z88NET: Layer containing the mesh which was drawn or outlined in defined order. 
Z88RBD: Layer containing the contents of the boundary conditions file Z88I2.TXT. 
Z88FLA: Layer containing the surface and pressure loads as defined for Z88I5.TXT 
 
A further layer, Z88PKT, is produced by Z88X if you convert from Z88 to CAD. It shows all 
nodes with a point marker in order to better recognize the nodes. For the reverse step, from 
CAD to Z88, it is completely insignificant. 
 
1st step:  Design your component in the CAD system as usual. You do not need to maintain a 
definite order and you can use any layers. It is highly recommended to put symbols on one 
layer, edges on another layer, dimensions on a third layer, invisible lines and centre lines on a 
fourth layer and so on. This enables you to remove all unnecessary information in the next 
step. 
 
2nd step: Plan your mesh subdivision that means suitable finite element types and their dis-
tribution. Subdivide the FE structure or the super structure into elements by lines, insert all 
points which are not yet existing (for example intersection points or end-points of lines are 
usable). Any order and layer. However, it is recommended not to use the Z88-layers like 
Z88NET, Z88GEN, Z88PKT, Z88KNR, Z88EIO and Z88RBD. Better define any new layer 
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for this or use already available layers from step 1. 
 
3rd step: Define the Z88-Layer Z88KNR and make it the active layer. Catch or trap every FE 
node, which were already defined in the 1st step by your construction or have been completed 
in the 2nd step, and number them. Write to every node P blank node-number e.g. P 33, with 
the TEXT function of the CAD program. Be very careful to snap exactly the node and attach 
the number exactly to the node's location. Take your time! With the snap modes of AutoCAD 
(intersection point, end-point, point etc.) this works well. Choose any order of the work se-
quence as you like, you can well number the node 1 (P 1), then the node 99 (P 99) and then 
node 21 (P21). However, the numbering of the nodes must make sense and must be meaning-
ful for an FE analysis. You define which node in node 99 and which other node reads 21.  
 
4th step: Define the Layer Z88EIO and make it the active layer. Write the element informa-
tion with the TEXT function anywhere (of course, it looks nicer with the element info’s 
placed in middle of the respective finite element or super element). The order of the work se-
quence is up to you. You can describe element 1 first, step to the attaching element 17 and 
then proceed with element 8. However, your element choice and description must make sense 
for an FE analysis. The following information has to be written: 
 
For all finite element types from 1 to 20 (not 16 and 17): 
 
FE Element number Element type 
Write into one line, separate each item by at least one blank. 
 
Example: An Isoparametric Serendipity Plane Stress Element No.7 is supposed to get the 
element no. 23. Write e.g. into the middle of the element with the TEXT function FE  23  7  
 
For super-elements 2-dimensional No. 7, 8, 11, 12 and 20 
 
SE 
Element number 
Super-element type 
Type of the finite elements to be produced by meshing 
Subdivision in local x direction 
Type of subdivision in local x direction 
Subdivision in local y direction 
Type of subdivision in local y direction 
Write into one line, separate each item by at least one blank. 
 
Example: Subdivide an isoparametric Serendipity Plane Stress Element with 12 nodes (Ele-
ment type 11) used as super-element into finite elements of type 7, i.e. isoparametric Seren-
dipity Plane Stress Elements with 8 nodes (Element type 7). Subdivide in local x direction 
three times equidistantly and subdivide in local y direction 5 times ascending geometrically. 
The super element is supposed to have the number 31. Write e.g. into the middle of the ele-
ment with the TEXT function: SE  31  11  7  3  E  5  L  (e or E for equidistant is equivalent) 
 
For super-elements 3-dimensional Hexahedrons No.10 
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SE 
Element number 
Super-element type 
Type of the finite elements to be produced by meshing 
Subdivision in local x direction 
Type of subdivision in local x direction 
Subdivision in local y direction 
Type of subdivision in local y direction 
Subdivision in local z direction 
Type of subdivision in local z direction 
Write into one line, separate each item by at least one blank. 
 
Example: Subdivide an Isoparametric Serendipity Hexahedron with 20 nodes (Element type 
10) as super element into finite elements of the type Isoparametric Hexahedrons with 8 nodes 
(Element type 1). Subdivide equidistantly three times in local x direction, 5 times ascending 
geometrically in local y direction and subdivide equidistantly 4 times in local z direction. The 
super element is supposed to have the number 19. Write e.g. into the middle of the element 
with the TEXT function: 
SE  19  10  1  3  E  5  L  4  E  (e or E for equidistant is equivalent) 
 
 
5th step: Define the Layer Z88NET and make it the active layer. You need concentration for 
this step, because a firm and rigid work sequence must now be kept because of the topological 
information. One of the most important information, the coincidence, is defined in this step 
that means which elements are defined or outlined by which nodes. Choose a proper colour 
which differs well from the colours used till now and remove all superfluous information by 
switching off unused layers. 
Select the LINE command and select the proper snap options e.g. points, intersection points 
and, if necessary, end-points. 
 
Start at the first element. For Z88 the first element is the element with which you start now, 
that means the one which you have chosen for your first element (SE 1 or FE 1). Select the 
node you want to be the first node of this element (this can be e.g. globally the node 150) and 
draw a line to the node which shall be the second node of this element (this can be e.g. glob-
ally the node 67). From there, draw a line to the third node of this element (this can be e.g. 
globally the node 45). Connect all required nodes with lines and draw at last a line to the 
starting point, the first node, and then quit the LINE function. 
 
 
Then you do the same with the second element. Remember: You determine with this order 
which of the elements will be the real second element now. In the previous 4th step you 
have only defined what kind of element the second element is. You determine here how the 
element is defined topologically. 
 
The third element follows and so on. If you should make a mistake at the outlining of an ele-
ment then delete all previous lines of this element (e.g. with an UNDO function) and start 
again at the first point of the element in question. But if you notice now just outlining element 
17 that you have made a mistake at element 9, then you must delete all lines of the elements 9 
to 17 and restart with element 9. 
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For your comfort, you must keep the following outline orders which partly differ from 
the orders shown at the element descriptions when entering the coincidence by hand. 
Z88X then sorts internally correctly. 
 
Example: The coincidence for the element type 7 is as follows in the element description: 
First the corner nodes, then the middle nodes, reads 1-2-3-4-5-6-7-8. The coincidence list 
must look like this in the Z88 input files. However, for Z88X' use for comfortably outlining 
the elements the order is 1-5-2-6-3-7-4-8-1 (left picture), respectively A-B-C-D-E-F-G-H-A 
(right picture):  
 

68

4 7 3
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Figure 21: Example for correct outline orders 

 
Following the CAD outline orders for all elements except No. 16 and No.17 (because 
these tetrahedrons can only be machine-generated, nearly impossible by hand): 
 
Element No. 7, No. 20 and No. 23:  1 - 5 - 2 - 6 - 3 - 7 - 4 - 8 - 1 
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Element No. 8:  1 - 5 - 2 - 6 - 3 - 7 - 4 - 8 - 1 
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Element No.11:  1 - 5 - 6 - 2 - 7 - 8 - 3 - 9 - 10 - 4 - 11 - 12 - 1 
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Element No.12:  1 - 5 - 6 - 2 - 7 - 8 - 3 - 9 - 10 - 4 - 11 - 12 - 1 
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Element No. 2, 4, 5, 9, 13: Line from node 1 to node 2 
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Element No. 3, 14, 15, 18 and 24:  1 - 4 - 2 - 5 - 3 - 6 - 1 
Y

X
1

3

5

6

4 2 
 
Element No.6:  1 - 2 - 3 - 1 
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Element No.19:
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Element No.1:  
Upper plane:  1 - 2 - 3 - 4 - 1,  Z

Y

1
X

2

8

7

6

5

4
3

quit LINE function 
Lower plane: 5 - 6 - 7 - 8 - 5,  
quit LINE function 
1 - 5 , quit LINE function 
2 - 6, quit LINE function 
3 - 7, quit LINE function 
4 - 8 , quit LINE function 
 
 
 
Element No.10:

1
2

43

5

6

8
X

7

1718

19
20

Z

Y

16

9

10

11

12

13

14

15

 
Upper plane:  1 - 9 - 2 - 10 - 3 - 11 - 4 - 12 - 1,  
quit LINE function 
Lower plane: 5 - 13 - 6 - 14 - 7 - 15 - 8 - 16 - 5,  
quit LINE function 
1 - 17 - 5 , quit LINE function 
2 - 18 - 6, quit LINE function 
3 - 19 - 7, quit LINE function 
4 - 20 - 8 , quit LINE function 
 
 
 
Element No. 21: 
Upper plane:  1 - 5 - 2 - 6 - 3 - 7 - 4 - 8 - 1,  
quit LINE function 
Lower plane: 9 - 13 - 10 - 14 - 11 - 15 - 12 - 16 - 9,  
quit LINE function 
1 - 9, quit LINE function 
2 - 10, quit LINE function 
3 - 11, quit LINE function 
4 - 12, quit LINE function 
 
 
 
Element No. 22: 
Upper plane:  1 - 4 - 2 - 5 - 3 - 6 - 1,  
quit LINE function 
Lower plane: 7 - 10 - 8 - 11 - 9 - 12 - 7,  
quit LINE function 
1 - 7, quit LINE function 
2 - 8, quit LINE function 
3 - 9, quit LINE function 
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6th step: Define the layer Z88GEN and switch it active. Write with the TEXT function into a 
free space (well into any place of your drawing): 
 
6.1 general information, i.e. the first input group of the general structure data Z88I1.TXT or 
the mesh generator file Z88NI.TXT,  
In case of Z88I1.TXT (i.e. FE mesh): 
 
Z88I1.TXT 
Dimension of the structure 
Number of nodes 
Number of finite elements 
Number of degrees of freedom DOF 
Number of material information lines 
Coordinate flag (0 or 1) 
Beam flag (0 or 1) 
Plate flag (0 or 1) 
Surface and pressure loads flag (0 or 1) 
Shell flag (0 or 1, 2, 3, 4) 
 
Write into one line, separate each item by at least one blank. Definitely write in the layer 
Z88GEN.  
 
Example: 3-dimensional FE structure with 150 nodes, 89 finite elements, 450 degrees of 
freedom, 5 material information lines. Input with Cartesian coordinates, structure contains 
neither beams No.2 nor beams No.13. Thus Z88I1.TXT  3  150  89  450  5  0  0  0  1 
 
In case of Z88NI.TXT (i.e. super structure): 
 
Z88NI.TXT 
Dimension of the structure 
Number of nodes 
Number of super element 
Number of degrees of freedom DOF 
Number of material information lines 
Coordinate flag (0 or 1) 
Beam flag (must here be 0!) 
Plate flag (0 or 1) 
Surface and pressure loads flag (0 or 1) 
Trap radius header flag (most 0) 
Coordinate flag output (0 or 1) 
Write into one line, separate each item by at least one blank. 
 
Example: 2-dimensional super-structure with 37 nodes, 7 super elements, 74 degrees of free-
dom, one material information line. Cartesian coordinates, no beams (forbidden anyway in the 
mesh generator file), no plates, no area loads, use default for trap radius. Thus  
Z88NI.TXT  2  37  7  74  1  0  0  0  0  0  
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6.2 Material information lines:  
For every material information one separate line: 
 
MAT 
Number of the material information 
This material information starts with element no. abc inclusively 
This material information ends with element no. xyz inclusively 
Young's Modulus 
Poisson's Ratio 
Integration order (from 1 to 4) 
Cross section value (e.g. for plane stress elements thickness, for trusses cross section area) 
 
... And if beams (but not plates!) are defined in addition: 
 
Second moment of inertia yy (bending around yy axis) 
Max. distance from neutral axis yy 
Second moment of inertia zz (bending around zz axis) 
Max. distance from neutral axis zz 
Second moment of area (torsion) 
Second modulus (torsion) 
 
... And if plates or shells (but not beams!) are defined in addition: 
 
area load 
 
Write into one line, separate each item by at least one blank. Make sure to write in the layer 
Z88GEN. 
Example: The structure has 34 super elements type 7 with varying thickness: Elements 1 to 
11 have thickness 10 mm, elements 12 to 28 have 15 mm and elements 29 to 34 have 18 mm. 
Material steel. Integration order shall be 2. 
 
MAT  1   1   11   206000.   0.3   2  10. 
MAT  2 12   28   206000.   0.3   2  15. 
MAT  3  29  34   206000.   0.3   2  18. 
 
6.3 Stress parameters:  
The input line of the stress parameter file Z88I3.TXT  
Z88I3.TXT 
Integration order (0 to 4) 
KFLAG (0 or 1) 
Von Mises stresses (0 or 1) 
 
Write into one line, separate each item by at least one blank. Make sure to write in the layer 
Z88GEN. 
 
Example: The structure uses finite elements type 7. The stress calculation is supposed to be 
carried out in 3*3 Gauss points per element, stresses are supposed to be calculated in addition 
radially and tangentially. Compute von Mises stresses, too. Thus Z88I3.TXT   3   1   1 
7th step: Define the Layer Z88RBD and activate it. Write with the TEXT function into a free 
space (well into any place of your drawing): 
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7.1 number of the boundary conditions, i.e. the first input group of the boundary condition 
file Z88I2.TXT  
 
Z88I2.TXT Number of the boundary conditions 
 
Write into one line, separate each item by at least one blank. Make sure to write in the layer 
Z88RBD. 
 
Example: The structure has 10 boundary conditions, e.g. two loads and eight constraints i.e. 
support reactions. Thus Z88I2.TXT   10 
 
 
7.2 Boundary conditions, the second input group of the boundary condition file Z88I2.TXT  
 
RBD 
Number of the boundary condition 
node number 
Degree of freedom 
Header flag force/displacement (1 or 2) 
Value 
 
Write into one line, separate each item by at least one blank. Make sure to write in the layer 
Z88RBD. 
 
Example: The structure shall be a truss-framework. Node 1 shall be fixed in Y and Z, node 2 
fixed in X and Z. Nodes 7 and 8 have a load of 30,000 N each in Z direction, pointing down. 
Node 19 is fixed in X and Z and node 20 is fixed in Y and Z. Thus 
 
RBD     1      1     2    2    0  
RBD     2      1     3    2    0  
RBD     3      2     1    2    0  
RBD     4      2     3    2    0  
RBD     5      7     3    1    -30000  
RBD     6      8     3    1    -30000  
RBD     7    19     1    2    0  
RBD     8    19     3    2    0  
RBD     9    20     2    2    0  
RBD   10    20     3    2    0  
 
8th step: if surface and pressure loads are defined: create the layer Z88FLA and activate it.  
Write with the TEXT function into a free space (well into any place of your drawing): 
 
8.1 Number of surface and pressure loads 
i.e. the first input group of the surface and pressure loads file Z88I5.TXT 
Z88I5.TXT number of surface and pressure loads 
Write into one line, separate each item by at least one blank. Make sure to write in the layer 
Z88FLA. 
Example: The structure features 12 surface loads. Thus: Z88I5.TXT  12 
 
 
8.2 Surface and pressure loads 
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i.e. the second input group of the surface and pressure loads file Z88I5.TXT 
FLA number of the surface and pressure load 
 
The following entries depend on the element type with surface and pressure load: 
 Plain stress element No.7 and 14 and Torus elements No.8 and 15: 
Element number with surface load 
Pressure, positive if pointing towards the edge  
Tangential shear, positive in local r-direction 
3 nodes of the loaded edge 
 

Example: The plain stress element 97 is the third element with surface load. The load should 
be applied onto the edge defined by the corner nodes 5 and 13 and by the mid node 51. One 
surface load is applied normally to the edge with 100 N/mm and the other surface load is ap-
plied tangentially and positive in local r direction with 300 N/mm (defined by the two corner 
nodes). Thus:   FLA  3  97  100.   300.  5   13   51 
 

 Hexahedron No.1: 
Element number with surface and pressure load 
Pressure, positive if pointing towards the surface  
Tangential shear, positive in local r direction 
Tangential shear, positive in local s direction 
4 nodes of the loaded surface  
 
Example: The hexahedron 356 is the 34th element with surface loads. The load should be 
applied onto the surface defined by the corner nodes 51, 34, 99 and 12. The first surface load 
is pressure with 100 N/mm. The second surface load is applied tangentially and positive in 
local r direction with 200 N/mm. The third surface load is applied tangentially and positive in 
local s direction with 300 N/mm. Thus: 
FLA  34  356   100.   200.   300.   51   34   99   12 
 
 Hexahedron No.10, Shells No. 21 and No. 22: 
Element number with surface and pressure load 
Pressure, positive if pointing towards the surface  
Tangential shear, positive in local r direction 
Tangential shear, positive in local s direction 
8 nodes of the loaded surface  
 
 Plate elements No.18, 19 and 20, Shells No. 23 and 24: 
Element number with pressure load 
Pressure, positive if pointing towards the surface  
(It is easier to enter the pressure loads for plate elements directly into Z88I1.TXT than via 
Z88I5.TXT) 
Separate each item by at least one blank. Make sure to write in the layer Z88FLA. 
 
9th step: Export (store) your model or drawing under the name Z88X.DXF in the DXF file 
format. For precision of decimal positions take the default value which the CAD program 
suggests.  Take care that you export directly into the Z88-directory or you must copy the file 
Z88X.DXF by hand into the Z88-directory, because the CAD converter Z88X expects the in-
put and output files in the same directory, where Z88X is located. 
You may launch the CAD converter Z88X then. 
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Note: If you want to convert Z88 text files as Z88X.DXF to CAD, you can choose the text 
size which applies to all texts like node numbers, element numbers etc. This is very important 
from time to time because there is no possibility in e.g. AutoCAD to change the text size 
globally afterwards. From time to time you must make some tries until you have found the 
suitable text size for the respective Z88 file. Simply call Z88X once more with another text 
size. 
 
Windows: In Z88X: File > Text size 
UNIX: z88x  -i1tx | -iatx | -nitx | -i1fx | -iafx | -nifx    -ts number 
Caution, valuable note: Use the Z88X keywords "P number, FE values, SE values, MAT, 
RBD, Z88NI.TXT, Z88I1.TXT, Z88I2.TXT and Z88I3.TXT" only where they are really 
needed. Take care that they do not appear in other drawing captions!  
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4.1.8 THE 3D CONVERTER Z88G 
 
Sometimes 3D CAD programs include so-called automeshers which divide a CAD model into 
finite elements. This generated mesh can be stored in some output format to fit the needs of 
the various FEA programs. 
 
Typical output formats are the COSMOS and the NASTRAN format for the COSMOS or the 
NASTRAN FEA program. 

 
Figure 22: Accessing the 3D converters Z88G and import options in Z88 Aurora 

 
Z88G is developed and tested for Pro/ENGINEER by Parametric Technology, USA. 
Pro/ENGINEER must include the option (the additional module) Pro/MECHANICA. Be sure 
to define the material data (e.g. for steel, only Young's Modulus and Poisson's Ratio is really 
needed) in Pro/ENGINEER. 
Then you may activate FEM in the Pro/ENGINEER program after designing your 3D model, 
define a coordinate system (which must be in harmony with Z88!) and add forces and bound-
ary conditions to single points. Create these single points with Feature > Datum > Point. For 
plates the direct entry of the pressure load is allowed. When using Wildfire 2, do not forget to 
define an analysis. Otherwise, no boundary conditions are filed! 
Modify the mesh control values, if necessary. Create the mesh with Make Model and choose 
the element type e.g. Tet Mesh. Store the mesh with Output Model, choose NASTRAN or 
COSMOS/M and linear or parabolic (the option toggle "fix elements" is not bad for this pur-
pose). Enter z88g.nas for NASTRAN files or z88g.cos for COSMOS files for the output file 
name. 
Then launch the converter Z88G. 
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Choose the file type and specify the element type to be generated. Of course, both must corre-
late with what you have previously designed in Pro/ENGINEER. The background, especially 
of the selection of the element type, is that the output of Pro/ENGINEER is the type shell, 
even if we deal with plane stress elements, tori or plates. The converter produces the Z88 in-
put files Z88I1.TXT, Z88I2.TXT and Z88I3.TXT and Z88I5.TXT (if needed) automatically. 
You may then enter the Z88 input files and edit values e.g. material data and integration or-
ders, if necessary. 
Test the Z88 input files generated by Z88G with the filechecker Z88V. Plot Z88I1.TXT with 
the plot program Z88O or Z88P. If you find a 3D model totally flat: You’ve defined a coordi-
nate system CS0 in Pro/ENGINEER which does not fit Z88's needs. Simply define a new cor-
rect coordinate system in Pro/ENGINEER and define it as datum when outputting the model. 
Keep in mind that those exchange file formats and their Pro/ENGINEER output are subject to 
change every some months. 
 
You may create the following Z88 element types with Z88G: 

 Tetrahedron No.16  (Tetrahedron, parabolic in Pro/ENGINEER) 
 Tetrahedron No.17  (Tetrahedron, linear in Pro/ENGINEER) 
 Plane stress No.14  (Shell, triangle, parabolic in Pro/ENGINEER) 
 Plane stress No.7  (Shell, quadrangle, parabolic in Pro/ENGINEER) 
 Plate No.18   (Shell, triangle, parabolic in Pro/ENGINEER) 
 Plate No.20   (Shell, quadrangle, parabolic in Pro/ENGINEER) 
 Torus No.15   (Shell, triangle, parabolic in Pro/ENGINEER) 
 Torus No.8   (Shell, quadrangle, parabolic in Pro/ENGINEER) 
 Shell No. 23   (Shell, quadrangle, parabolic in Pro/ENGINEER) 
 Shell No. 24   (Shell, triangle, parabolic in Pro/ENGINEER) 

 
Please keep in mind that Z88G is capable to deal directly with pressure loads from 
Pro/ENGINEER only with NASTRAN files. In this case, the file for surface and pressure 
loads Z88I5.TXT is generated. This is not possible for COSMOS files: Here you are to enter 
pressure loads via nodal forces. 
 
How to proceed?  
First step: Choose NASTRAN or COSMOS file format: If you choose NASTRAN the file 
Z88G.NAS is loaded, in case of COSMOS the file Z88G.COS is loaded. You must know 
which file type did you file in your former Pro/E session. 
 
Choose file type before start.  
Next step: Pro/ENGINEER makes no distinction between volume elements, plane stress ele-
ments, shells, torus elements and plate elements, therefore it is up to you to feed Z88G the 
right information. The reason for this is that Pro/ENGINEER only recognises the FE type 
shell or volume. Here, too, you must enter the appropriate data, i.e. what you have already 
designed in Pro/ENGINEER. 
 
Before running the conversion choose the right type of elements. 
The generation of volumes is easy, but the generation of plane stress elements, plates and to-
rus elements (axisymmetric elements) is tricky: First, build a volume with (small) thickness in 
Pro/E. Set reference points, especially for axis-symmetric elements. Launch 
Pro/MECHANICA and idealize the volume into shells: Model > Idealizations > Shells > 
Midsurfaces.  This eliminates the depth. When working with axis-symmetric elements keep in 
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mind that you are working in cylinder coordinates: Your coordinate system coincidates with 
the axis of rotation and the “volume” lies on the corresponding radiuses (see figure): 
 
Please keep in mind: These FEA output data formats, especially the NASTRAN format, are 
modified almost on a daily basis. 
 
Anyway: Z88G looks quite harmless, but properly operated Z88G is a mighty tool which al-
lows you to file very large FEA structures to Z88.   
 

 
 
This is how tori are generated in Pro/ENGINEER (Wildfire). In case of plates and shells, pro-
ceed correspondingly. 
 
 
4.1.9 THE ANSYS CONVERTER Z88ANS 
What is the basic idea and which are the features? 
Apart from NASTRAN and COSMOS, Pro/ENGINEER also supports the output of simula-
tion data as ANSYS file (*.ans). These data can subsequently be transmitted to ANSYS as 
well as to Z88 Aurora. Please keep in mind, however, that this data format can also be arbi-
trarily altered by the producer, which might lead to compatibility problems. 
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Figure 23: Accessing the ANSYS converter Z88ANS  
 
A solid with any number of materials (linear elastic) can be converted. 
The solid must consist of one element type. Optional Cartesian boundary conditions, concen-
trated forces and forces on areas as well as pressures can be applied. 
CAUTION: z88ans directly generates the mat*.csv data for Z88 Aurora from the material in-
formation in the source file. Into Z88I1.TXT, only reduced material information is entered, 
with Young's modulus and Poisson's ratio each set to 0. 
 
Which ANSYS files systems can be imported by Z88 Aurora? 
ANSYS data can possess very different structures and contents, depending on their origin. 
That is why accurate statements about compatibility cannot be made. Especially integrated 
scripts can cause problems. This converter was developed and tested for Pro/ENGINEER 
Wildfire 4. Data generated by means of ANSYS Workbench cannot be imported. 
 
Which elements are supported by the converter? 
You can use tetrahedrons, as linear or as quadratic type: 
 
Conversion > from TET 4 to element type 17 and vice versa 
Conversion > from TET 10 (E 92) to element type 16 and vice versa 
 
Which functions does the converter offer? 
Import functions of the converter z88ans: 
Generation > of Z88I1.TXT from an ANSYS file 
Generation > of Z88I2.TXT from an ANSYS file 
Generation > of Z88I5.TXT from an ANSYS file 
Generation > of MAT*.TXT from an ANSYS file 
 
 
How to proceed? 

1. Construct your model according to the instructions for the NASTRAN converter z88g. 
2. Take care to select the ANSYS format when outputting the simulation data. 
3. Import the simulation model into Z88Aurora as described in figure XX. For this pur-

pose select File > Import > ANSYS file. 
 
 
4.1.10 THE ABAQUS CONVERTERS Z88AINP AND Z88AEXP 
What is the basic idea and which are the features? 
If you want to offset the results of a simulation in a second system, one of the basic prerequi-
sites is that you re-use as many input data as possible in order to create the same precondi-
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tions. Just like the ANSYS converter, Z88AINP and Z88AEXP are supposed to provide an 
accurate exchange of mesh, material and boundary conditions between the single systems. By 
now, ABAQUS has become a wide-spread simulation tool in the industrial field, offering a 
large range of performance as well as simple operation. Due to the extensive range of func-
tions, the following restrictions were made with regard to the functions of the converter: 
 
One solid (1 instance) with one material (linear elastic) can be converted. The solid must 
consist of one element type. Optional Cartesian boundary conditions, forces (Concentrated 
Force) and pressure can be applied. 
 
Which ABAQUS versions can cooperate with Z88 Aurora? 
The converter at hand was tested with ABAQUS 6.8.4; therefore the full range of functions is 
available in this case. 
Since the ABAQUS format is actually proprietary, modifications can occur at any time, influ-
encing the functionality of the converter. Older versions of ABAQUS, e.g. 6.6 or 6.7 also do 
not write any version information into the files. Therefore a version-dependent conversion is 
difficult as well. 
 
Which elements are supported by the converter? 
You can use any Tetrahedrons and Hexahedrons from ABAQUS, but since normally no 
acoustic or thermal simulation data are exchanged between ABAQUS and Z88 Aurora, the 
following element transformations will occur: 
 
Conversion > from C3D4 to element type 17 and vice versa 
Conversion > from C3D10 to element type 16 and vice versa 
Conversion > from C3D8 to element type 1 
Conversion > from C3D20 to element type 10 
 
Which functions does the converter offer? 
Import functions of the converter z88ainp: 
Generation > of Z88I1.TXT from an ABAQUS input file 
Generation > of Z88I2.TXT from an ABAQUS input file 
Generation > of Z88I5.TXT from an ABAQUS input file 
 
Export functions of the converter z88aexp: 
Generation > of z88.inp from Z88I1.TXT and Z88I2.TXT 
 
How to proceed? 
You can use files from ABAQUS CAE as well as your own input decks. Please look for the 
corresponding keywords in the ABAQUS documentation and pay attention to upper and 
lower case characters. ABAQUS scripts cannot be processed. 
 
 
For the import of an ABAQUS file proceed as follows: 
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Importing and meshing the component in ABAQUS:  
The ABAQUS converter only processes components which you can arbitrarily import into 
ABAQUS-CAE and fit into an Assembly. It is up to you, whether you select Mesh on Part or 
Mesh on Instance. Generate a material with elastic, isotropic properties 

(   

Figure 24) and define a Section with this material. Allocate your component to this Section. 
Allocate either Hex or Tet as meshing properties 

(   

4. Figure 24) and generate a mesh which meets your requirements. 
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Figure 24: Generating a new linear elastic material and allocation of the appropriate element type in 
ABAQUS 6.8.4 

 

Note: Extended settings of the mesh control and element selection are not adopted, since there 
are no corresponding equivalents in Z88 Aurora. Thus, in case you have chosen hybrid formu-
lation or an element for acoustic analysis, this will be transformed into a pure Z88 type when 
being imported into Z88. 
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Applying boundary conditions and loads:  
Loads are best defined via the option Displacement/Rotation and by defining the correspond-

ing degrees of freedom (  

 

5. Figure 24). But the converter is also capable of processing the conditions Pinned and 
Encastre. As possible loads please use the types Concentrated Force and Pressure.  
 

Notes: Z88ainp processes all loads existing in the ABAQUS file. Should you have defined 
several simulation steps (Steps) in your CAE, please keep in mind that, if you want to export 
only one calculation step, it would be best to generate a new model by copying, where all 
simulation steps except the desired one are deleted. 
 
If you do not use ABAQUS in connection with TOSCA, you must comment out the option 
nopartscae in your environment file, because the input file will be heavily altered. With this 
option only node and element data can be transferred. 
 

6. Write the input deck as *.inp file. 
7.  In Z88 Aurora select File > Import > ABAQUS data. In the subsequent selection box 

you can only select Inp files. Therefore select the desired file (figure).  
8. The converted structure is displayed and boundary conditions and loads of Z88 Aurora 

can be displayed. Use the prove mesh of Aurora in order to check the quality of the 
mesh. 

 
For the export as ABAQUS file proceed as follows: 

1. Generate your model in Z88 Aurora. You can use all boundary conditions and all con-
centrated forces. 
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2. In Z88 Aurora select File > Export > ABAQUS data. 

4.2 The linear solver Z88R 

The linear solver Z88R includes internally three different solvers: 
 

 The so-called Cholesky solver without fill-in, with so-called Jennings storage. It is easy 
to handle and very fast for small and medium structures. However, like any direct 
solver Z88F reacts badly on ill-numbered nodes but you may improve the situation 
with the Cuthill-McKee program Z88H (for further information and access of Z88H see 
chapter 4.2.4). Z88F is your choice for small and medium structures, up to 20,000 ... 
30,000 degrees of freedom. Typical application: truss and beam models, plane contin-
uum elements. 

 A so-called direct sparse matrix solver with fill-in. It uses the so-called PARDISO 
solver. This solver is very fast, since it is multi-CPU compliant, but it uses very much 
dynamic memory, therefore the program is likely to quit with an error message, if the 
main memory is exhausted. This solver is your choice for medium structures, up to 
150,000 degrees of freedom on ordinary 32 bit PCs. However, we’ve computed struc-
tures with ~ 1 million of DOF very fast using a computer featuring 32 (!) Gbyte of 
memory, 4 CPUs, 64 bit Windows version of Z88. 

 The so-called sparse matrix iteration solver. It solves the system of equations by the 
method of conjugate gradients featuring SOR- preconditioning or preconditioning by 
an incomplete Cholesky decomposition depending on your choice. This solver needs a 
minimum of storage.  It is your choice for large structures with more than 150,000 … 
200,000 DOF. FE-structures with ~ 5 million DOF are no problem for it if you use a 64 
bit operation system (Windows or Mac OS X) along with the 64 bit version of Z88 and 
about 6 GByte of memory. This very stable and approved solver works always, thus, 
you may use it as your standard solver.    

 

Note: The following explanations for the "manual" launch of the solver are only meant for a 
deeper understanding, if necessary. Z88 Aurora takes care of everything for you! 
 
The solver Z88R runs in console mode and requires two control flags: 
 

z88r -mode -solver 
mode means: 
-t : Test mode. Z88R determines the required memory and enters these settings into the  

 memory definition file Z88R.DYN.  
-c : Computing mode. Z88R.DYN is imported. 
 
Run the solver in test mode first, and then a second time in computing mode, using the same 
setting of the second parameter solver:  
 
solver means: 
-choly : Launch of the simple Cholesky solver without fill-in with Jennings storage 
-parao : Launch of the direct sparse matrix solver with fill-in and solver PARDISO 
-siccg : Launch of the iteration solver conjugated gradients with SIC preconditioning 
-sorcg: Launch of the iteration solver conjugated gradients with SOR preconditioning 
 
Input files for both modes: 
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 Z88I1.TXT   general structure data 
 Z88I2.TXT   boundary conditions 
 Z88I3.TXT   control values for stress calculation 
 Z88I5.TXT   surface and pressure loads, if necessary 
 Z88MAT.TXT and a material file in .CSV format, if the new Z88 Aurora format is 

supposed to be used. Otherwise the material data imported from the file Z88I1.TXT as 
it was the case with Z88 V13 

NOTE: These files are described more precisely in chapter 3 
 
Output files in computing mode: 

 Z88O0.TXT   prepared structure data for documentation 
 Z88O1.TXT   prepared boundary conditions for documentation 
 Z88O2.TXT   Displacements 
 Z88O3.TXT   Stresses 
 Z88O4.TXT   Nodal forces 

 
Under "Postprocessor  Outputfiles“ you can access the single output files of the calcula-
tion, in order to get the exact numerical values there (for further information see Z88 Aurora 
Theory Manual): 

 Z88O0.TXT – prepared input data 
 Z88O1.TXT – prepared boundary conditions  
 Z88O2.TXT – calculated displacements 
 Z88O3.TXT – calculated stresses 
 Z88O4.TXT – calculated nodal forces 

 
Definition files for the solver: 

 Z88MANAGE.TXT     
in this case especially, please take care to set the parameters NEG (number of material 
laws) and IQFLAG (surface load flag), which is done on the first line of the file 
Z88I1.TXT in case of Z88 V13.  

NOTE: This file is described more precisely in chapter 3 
 
 
Explanations to the sparse matrix iteration solvers SICCG and SORCG 
 

An iteration solver uses only the so-called non-zero elements – which results in an absolute 
minimum of storage requirements. It builds the following pointers for the lower part of the 
total stiffness matrix GS: 

 Pointer vector IP points to the diagonal elements GS(i, i) 
 Pointer vector IEZ points to the column index GS(x, j) 

 
Example (ref. Schwarz, H.R: Methode der finiten Elemente): Let the lower part of GS be: 
 

GS(1,1)      

GS(2,1) GS(2,2)     

 GS(3,2) GS(3,3)    

GS(4,1)   GS(4,4)   

GS(5,1)  GS(5,3)  GS(5,5)  

 GS(6,2)  GS(6,4)  GS(6,6) 
 



                     Theory Manual 

87 

GS results in the following vector of non-zero elements: 
 

 
GS(1,1) GS(2,1) GS(2,2) GS(3,2) GS(3,3) GS(4,1) GS(4,4)  

 GS(5,1) GS(5,3) GS(5,5) GS(6,2) GS(6,4) GS(6,6)  
 

IEZ will result in:  
 

1 1 2 2 3 1 4 1 3 5 2 4 6 
 

and IP: 
 

1 3 5 7 10 13 

 
The pointer IEZ holds MAXIEZ elements, the vector GS holds MAXGS elements. These lim-
its are determines in the test mode of the solver. 
In the second run, the actual computation run, the solver computes the element stiffness ma-
trices, compiles the total stiffness matrix, incorporates the boundary conditions, scales the 
system of equations and solves the (huge) system of equations by the conjugate gradient algo-
rithm. Preconditioning is done for better convergence. You can choose whether to use a     
SOR step or a so-called incomplete Cholesky decomposition for precondition. Default is the 
incomplete Cholesky decomposition (shifted incomplete Cholesky decomposition SIC), be-
cause the main parameter, the so-called shift factor , is easy to handle. The SOR precondi-
tioning needs less memory, but the control parameter, the relaxation parameter , cannot be 
determined a-priori. 
 
In addition, you must enter several parameters into the file Z88MANAGE.TXT. This is done 
via "extended options" in the menu "Solver": 
 

 termination criterion: maximum count of iterations (e.g. 10000)  
 termination criterion: residual vector < limit Epsilon (e.g. 1e-7) 
 parameter for the SIC convergence acceleration. Shift factor Alpha (from 0 to 1, good 

values may vary from 0.0001 to 0.1; start with 0.0001). For further information con-
sult the literature. 

 Parameter for the SOR convergence acceleration: Relaxation factor Omega (from 0 to 
2, good values may vary from 0.8 to 1.2). 

 Number of CPUs. 

 
NOTE: The files Z88I1.TXT, Z88I2.TXT, Z88I3.TXT, Z88I5.TXT, Z88MAT and 
Z88MANAGE.TXT mentioned here are described more precisely in chapter 3. 
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Figure 25: Extended options of the solver menu 
 
 

Explanations to the direct sparse matrix solver with fill-in 
 

This solver does direct matrix decomposition, but in contrary to the simple Cholesky solver, 
this solver operates with fill-in. Fill-in means allocating dynamic memory for the new matrix 
elements created by the decomposition process. Thus, the memory needs cannot be calculated 
before running the solver. If the memory is exhausted during the calculation, the solver will   
inevitably quit with an error message. This solver works at very high speed for medium struc-
tures (100.000 ~ 1.000.000 DOF) because it is multi-processor compliant, but needs more 
memory than the iteration solver by several orders of magnitude. Therefore, this solver is only 
really useful on machines with very much memory and 64 bit pointers and integers. We rec-
ommend the 64 bit version of Z88 Aurora, a 64 bit Windows operating system and a mini-
mum of 4 GByte (8 or 16 Gbyte are even better) of memory for this solver. When using a 32 
bit operating system and 4 GByte of memory you are limited to structures with ~ 150.000 
DOF. The actual solver core used is PARDISO by O. Schenk, University of Basel, Switzer-
land.  Define the number of CPUs in Z88MANAGE.TXT. The values preceding have no sig-
nificance; they must be there, however. Please take care that in the Windows settings System 
Properties > Advanced > Environment Variable you do not have this kind of variable:  
NUM_THREADS, OMP_SET_NUM_THREADS.  
This might clash with the settings in Z88MANAGE.TXT. 
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4.2.1 WHICH SOLVER TO TAKE? 
Roughly spoken: Use the simple and reliable Cholesky solver Z88F for small structures. The 
sparse matrix iteration solver Z88R –siccg or –sorcg always works even for very large struc-
tures under 32 bit operating systems. For medium sized structures the direct sparse matrix 
solver with fill-in Z88R –parao is very suitable because of its tremendous speed. 
 
 
Table 6: Overview of the integrated solvers and their efficiency 
Solver Type Number of DOF  Memory 

needs 
Speed  Multi-

CPU 
Notes 

Z88R –
t/c -

choly 

Cholesky Solver 
without Fill‐In  up to ~ 30.000 medium  medium  no 

running Z88H  
first is 

recommended 

Z88R –
t/c -

parao 

direct Solver with 
Fill‐In 

up to ~ 150.000 
with 32-Bit PCs very high  very high  yes 

useful with 
several CPUs and 

very much 
memory 

Z88R –
t/c 

-siccg or 
-sorcg 

Conjugated 
gradients solver 

with pre‐
conditioning 

No limits (tested 
with more than 12 

Mio. FG on a 
normal PC) 

an 
absolute 
minimum 

medium  no 

a very stable and 
reliable solver 
for very large 
structures 

 

4.2.2 SOME NOTES ON STRESS CALCULATION 
The results are presented in the file Z88O3.TXT. The stress calculation is controlled via the 
file Z88MANAGE.TXT, see chapter 3. It defines, among other things: 

 Calculation of the stresses at the Gauss points or at the corner nodes 
 Additional calculation of radial and tangential stresses for elements No. 3, 7, 8, 11, 12, 

14 and 15. 
 Calculation of von Mises stresses for continuum elements No. 1, 3, 6, 7, 10, 11, 12, 

14, 15 ~ 24. 
 

4.2.3 SOME NOTES ON NODAL FORCE CALCULATION 
The results are presented in Z88O4.TXT. The nodal forces are calculated separately for each 
element. If several elements meet a node, one gets the complete nodal force for this node by 
adding the nodal forces of all accessing elements.  These results are presented further down in 
the nodal force file Z88O4.TXT. 
 
4.2.4 THE CUTHILL- MCKEE PROGRAMM Z88H 
The choice of nodal numbers is extremely important for the compilation of the stiffness ma-
trix. Bad nodal numbering may result in huge memory needs which are not really necessary.  
 
However, Z88H may reduce the memory needs for the direct Cholesky Solver Z88F greatly; 
the sparse matrix solvers Z88I1/Z88I2 and Z88I1/Z88PAR may also gain some advantages 
from a Z88H run, but the iteration solver is a-priori very stable regarding node numbering be-
cause of storing the non-zero elements only.  
 
Basically, it is always good to achieve a small difference of nodal numbers for each finite 
element. This results in nodal numbers of similar size for an element. However, this is not al-
ways possible: consider a circular structure starting with nodal numbering at 0° with increas-
ing numbers clockwise. When reaching 360°, elements with large differences of nodal num-
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bers will occur. 
3D CAD programs sometimes contain so-called automeshers, which divide the 3d model into 
finite elements. This generated mesh can be stored in some output format to fit the needs of 
the various FEA programs. But many of these automeshers generate meshes with very large 
nodal differences. This is true for Pro/ENGINEER's Pro/MECHANICA: If you choose Tet 
Mesh parabolic, Pro/MECHANICA in a first operation generates linear tetrahedrons, i.e. with 
4 rather than 10 nodes per element, with straight element edges. Then midnodes are put on the 
element edges resulting in parabolic elements with 10 nodes. These midnodes inevitably have 
relatively large nodal numbers because the corner nodes were numbered in the first step. 
Thus, every finite element features relatively small corner node numbers and relatively large 
mid node numbers. When choosing Shell, triangle, parabolic, the same situation occurs. This 
means that meshes built with Pro/MECHANICA will always have a large difference of nodal 
numbering. 
 
For large meshes one needs to re-number the nodes to get finite elements with small differ-
ences of nodal numbers. Several proper procedures do exist in literature for this task.  How-
ever, the so-called Cuthill-McKee procedure is a good compromise, which is based on graph 
theoretical considerations. One modification of it is the RCMK algorithm (reverse Cuthill- 
McKee algorithm). For more information, consult Schwarz, H.R.: Die Methode der finiten 
Elemente. The C program Z88H is based on a FORTRAN77 program of Professor Schwarz 
and is specially adapted to Z88. The core algorithm of H.R. Schwarz decides internally 
whether to use the normal Cuthill-McKee procedure or the reverse Cuthill-McKee algorithm. 
 
The Cuthill-McKee program Z88H, integrated in Z88 Aurora was originally designed for fi-
nite element meshes generated by 3D converter Z88G. However, Z88H can deal with all Z88 
meshes. Z88H reads the Z88 input files Z88I1.TXT (general structure information) and 
Z88I2.TXT (boundary conditions) and – if needed – Z88I5.TXT (surface and pressure loads), 
files backups Z88I1.OLD, Z88I2.OLD and Z88I5.OLD (if needed) and computes the modi-
fied input files Z88I1.TXT and Z88I2.TXT and Z88I5.TXT. 
 
Own research studies showed that sometimes a second run of Z88H may improve again the 
numbering of a first run of Z88H. A third run seems to make things slightly worse again. In 
extreme cases, the Cuthill-McKee algorithm, i.e. Z88H, may sometimes compute counterpro-
ductive results, i.e. worse nodal numbering than the original mesh. You should have some 
experiments because the Cuthill-McKee algorithm may not always improve a given mesh. 
 
You find the Cuthill-McKee program in the menu "Solver" under "Extended Options“. 
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Figure 26: Solver menu, or extended options with Cuthill-McKee program 

 

4.3 The mapped mesher / mesh generator Z88N 

4.3.1 GENERAL REMARKS 
The mesh generator Z88N from Z88 is integrated into Z88 Aurora with all functionalities. It 
can produce 2-dimensional and 3-dimensional Finite Element structures from super struc-
tures. The mesh generator input file is imported and the general structure data displayed. It is 

accessed in the preprocessor menu via the icon Superelemente . 

 
Figure 27: Menu "preprocessor" with launch icon "Super Elements" of the mesh generator 

Z88N 
A mesh generation is only sensible and permitted for continuum elements. An overview of the 
possible finite element structures can be found in . Table 7
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Table 7: Possible super structures in Z88 Aurora  
Superstructure Finite Element Structure 
Plane Stress Element No. 7 Plane Stress Element No. 7 
Torus No. 8 Torus No. 8 
Plane Stress Element No. 11 Plane Stress Element No. 7 
Torus No. 12  Torus No. 8 
Hexahedron No. 10 Hexahedron No. 10 
Hexahedron No. 10 Hexahedron No. 1 
Hexahedron No. 1 Hexahedron No. 1 
Plate No.20 Plate No.20 
Plate No.20 Plate No.19 
Shell No. 21 Shell No. 21 

   
Mixed structures e.g. containing Plane Stress Elements No.7 and Trusses No.9, cannot be 
processed. 
 
In such a case let the mesh generator process a super structure containing no trusses. After-
wards you can either insert the additional trusses manually in Z88 Aurora or you can export 
the file created by the mesh generator by means of the DXF converter, import this DXF file 
into the CAD system and insert the trusses there; you can also define the boundary conditions 
at the same time or edit them in Z88 Aurora. Subsequently, re-import the DXF file into Z88 
Aurora.  
 
Mode of operation of the mesh generator: 
For generating FE meshes proceed as follows: The continuum is described by so-called super 
elements (short SE), which practically corresponds to a quite rough FE structure. 
The super structure is then subdivided. This is done super element wise, starting with SE 1, 
SE 2 up to the last SE. SE 1 produces the finite elements (short FE) 1 to j, SE 2 the FE j+1 to 
k, SE 3 the FE k+1 to m and so on. Within the SE, the direction of the local coordinates de-
termines the nodal numbers and the element numbers of the FE structure. Definition: 
 
 Local x axis points in direction of local nodes 1 and 2 
 Local y axis points in direction of local nodes 1 and 4 
 Local z axis points in direction of local nodes 1 and 5 

 
Super structures in space are subdivided first in z, then in y and finally in x direction i. e. the 
FE element numbers start along the z direction. To plane and axially symmetric structures ap-
plies analogously: The numbering starts along the y axis or for axially symmetric elements 
along the z axis (cylinder coordinates!). 
Along the local axes, a subdivision can be conducted as follows: 

 equidistant 
 increasing geometrically from node 1 to 4 or 5 : mesh becomes rougher 
 decreasing geometrically from node 1 to 4 or 5 : mesh becomes finer 

It is obvious, that for lines or areas, which are shared by two super elements, the super ele-
ments must be subdivided exactly the same! The mesh generator does not check this and then 
generates useless or totally meaningless FE meshes. Example: 
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Figure 28: Subdivision of the super elements 
 
Since the local axes x, y and z are defined by the location of the local nodes 1, 4 and 5, it is 
possible to generate almost arbitrary numberings for nodes and elements of the FE structure 
by corresponding construction of the coincidence list in the mesh generator input file 
Z88NI.TXT. 
Example for the generation of a FE structure with 8 FE Plane Stress Elements No.7 from a 
super structure with 2 Plane Stress Elements No.7 (looks the same with Toruses No.8), Figure 

28. 
 
Specials: 
The mesh generator checks which nodes are already known at the production of new FE 
nodes. For this check it needs a trap radius (a computer cannot meet a floating point number 
exactly). This trap radius is provided for all 3 axes per default 0.01. Modify the trap radiuses 
when processing very small or very large numerical values.  

 
 

Figure 29: Transformation of super elements into finite elements 
 
Attention mesh generator Z88N: The generator can easily generate input files which blast 
all limits of the FE processor. Generate therefore at first rougher FE structures, check the re-
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sults then refine if necessary. A good starting point: Produce approx. 5..10 times more finite 
elements than super elements. 
Note mesh generator Z88N: If the coordinate flag KFLAGSS is set in the mesh generator 
input files Z88NI.TXT, i.e. input values are polar or cylindrical coordinates, then the mesh 
generator output files Z88I1.TXT normally have Cartesian coordinates and KFLAG is set to 
0.   If you set the coordinate flag output KFLAG to 1, however, then the coordinates are polar 
or cylindrical in the output file Z88I1.TXT and KFLAG is set to 1 in Z88I1.TXT. 
 

4.4 THE POSTPROCESSOR 

Structures illuminated with three light sourced, wireframe- or hidden line-structures can be 
plotted undeflected, deflected or both of them overlaying. In the same way, a colour range for 
stresses and Y- and Z-deflections can be displayed. In case of node and element numbers ar-
eas can be specified, which is very helpful in case of large structures. A plotter or printer out-
put is not explicitly intended. Why should it be? Simply make a screenshot with Shift-Print in 
the clipboard and edit or print it with the Windows program Paint or a paint program such as, 
for example CorelPaint etc. Under the "Export" function it is possible in Z88 Aurora to export 
the current view as a *.bmp-image.  
 

 
Figure 30: Exporting the current view as image in Z88 Aurora 

 
Z88 Aurora uses OpenGL. Therefore your computer must be able to deal with OpenGL. In 
case of the more recent Windows versions, this is activated by default, and usually a cheap 
graphic adapter will be sufficient. To be on the safe side, however, check the system settings 
– sometimes OpenGL hardware acceleration can be activated.  
 
Your choice of colours, screen size, light features material properties, the polygon offset etc. 
can be defined in the file Z88.FCD. But be careful with changes in Z88.FCD: You must pos-
sess some basic knowledge of how OpenGL works, if you want to change light effects etc. 
Otherwise there will be long faces, because nothing seems to work properly anymore. Some 
hints are included in Z88.FCD in the form of remarks, but I cannot give an introduction to 
OpenGL in this context. 
Please consul, for example, Rieg, F: Grafikprogrammierung für Windows. Carl Hanser Ver-
lag. München, Wien: 2005. 
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Table 8: Required data for the display of results 
Needed Files: Super Structures undeflected FE Structures deflected FE  Structures 
Z88NI.TXT yes no no 
Z88I1.TXT no yes yes 
Z88I2.TXT no yes for displaying the boundary condi-

tions 
yes for displaying the boundary 
conditions 

Z88I5.TXT no yes for displaying the surface and 
pressure loads 

yes for displaying the surface 
and pressure loads 

Z88O2.TXT no no yes 
Z88O5.TXT no yes for displaying the stresses in the 

Gauss points 
no 

Z88O8.TXT no yes for displaying the stresses in the 
corner nodes or the average element 
stresses 

yes for displaying the stresses in 
the corner nodes or the average 
element stresses 

 

Features of rendering: For fastest operation Z88 Aurora connects the nodal points in case of 
scenes with lighting and in hidden line mode – and only the corner points – with straight 
lines, although for Serendipity elements the edges of the elements are square or cubic curves; 
in wireframe mode all nodes are connected with straight lines. Especially illuminated scenes 
need a huge amount of computational power. If a part renders pretty fast in your CAD system, 
Pro/ENGINEER for example, and the same part renders quite slowly in Z88O - this is normal 
business because CAD systems are „drawing“ only some outline curves. In contrast, FEA sys-
tem have to render every finite element i.e. compute the normal vectors for any element sur-
face, compute light effects for every tetrahedron etc. Hidden line scenes put very heavy load 
on the CPU. This can be solved by applying "Surface/Solid View", which can be found in the 
view menu. Here, only the outer solid edges are calculated and completely displayed, but this 
procedure is not suitable for all functionalities. 
 
What can I plot with Z88O? Nearly everything if a solver was run which stored the deflec-
tion file Z88O2.TXT and the three stress files Z88O3.TXT (for you to check the stresses), 
Z88O5.TXT (for Z88O internally) and Z88O8.TXT (for Z88 Aurora internally). Even for 
trusses you may plot the "von Mises“ stresses (i.e. tensile stresses) with different colours; 
only beams No.2 and No.13 and cams No.5 allow only the plotting of deflections and nothing 
more. Why? Because you must compute for beams and cams also the stress concentration fac-
tor which is impossible for a FEA system which deals with a whole structure of beams. Of 
course, you may compute the stresses in a chamfer by putting an FE mesh around it. But this 
needs either plane stress elements or 3D elements but neither beam elements nor cam ele-
ments. 
 
Plot of stresses: The kind of plotting the stresses within FEA programs is truly of philosophi-
cal character. As a matter of fact, numerous experiments and computer studies at the Institute 
of Engineering Design and CAD of the University of Bayreuth, Germany, showed, that some 
very expensive and well-known professional FEA programs produced incorrect stress plots in 
some situations! The best way is the computation of stresses directly in the Gauss points. 
However, this is odd for OpenGL in some modes so I decided for the following way after a 
lot of experiments: 
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1. von Mises/principle/Tresca stresses in corner nodes. In fact, the stresses are computed 
not really in the corner nodes, which would lead to very wrong results especially for very 
tapered elements (sic!), but in Gauss points lying near the current corner nodes. Stresses 
are computed for just the same number of Gauss points like the number of corner points. 
Because often a node is linked to more than one element the stresses are computed to a 
mean value from the "corner node“ stresses of all linked elements. This results in pretty 
balanced stress shadings which are mostly somewhat lower than the maximum stresses in 
the Gauss points, however. The value of the order of integration INTORD in the header 
file Z88MANAGE.TXT has no meaning but INTORD should be greater than 0. 

2. von Mises/principle/Tresca stresses as a mean value for each element. The stresses are 
computed in the Gauss points of the current element, added and then divided by the cur-
rent number of Gauss points. This results in a mean value for the von 
Mises/principle/Tresca stress per element. The value of the order of integration INTORD 
in the header file Z88MANAGE.TXT is important and INTORD must be greater than 0. 

3. von Mises/principle/Tresca stresses directly in Gauss points. This is most accurate but 
does not deliver as pretty pictures as 1. and 2. INTORD must be greater than 0. 

 
Z88 Aurora may show the following reduced stresses – but only one at a time - depending on 
the previous computation run:  
 

- Distortion Energy Theory  DET, i.e. von Mises stresses 
- Principal stress hypothesis PSH, i.e. Rankine stresses 
- Shear stress hypothesis SH, i.e. Tresca stresses 
 

Thus, if you have computed the von Mises stresses previously, Z88 Aurora will show them.  If 
you want to show the Rankine stresses now, you have to run the solver again, in this case with 
the setting "Principal Stress Hypothesis SH (Tresca), see Figure 31.  

Figure 31: Setting options stress parameters in the menu "Solver" 

 
Plot of deflections: You may plot the undeflected or the deflected structure or both of them 
overlaying. The enlargement factor is adjustable, with 100 as the default value for X, Y and 
Z. In addition, you may plot the deflections for X, for Y or for Z with colour shading. This is 
a pretty nice feature for large spatial structures. You may plot the shaded colours for stresses 
or for the deflections or the hidden line display or the wire frame display with the deflected 
structure. The background colours and legend display can be adjusted. For further information 
refer to the Z88 Aurora User Manual. By means of a scrollbar the deflection can also be 
scaled steplessly. 
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Table 9: Combination of the different modes of postprocessing 
 3D 2D BC un-

def. 
deflec. nodes elem. 

Light + + + + + - - 
Hidden Line + - + + + o - 
Wire Frame + + + + + + + 
Stresses in corner nodes + + - + + - - 
Stresses aver. elements + + - + + - - 
Stresses in Gauss points + + - + - - + 
Deflections X + + - + + - - 
Deflections Y + + - + + - - 
Deflections Z + + - + + - - 

 

The „coordinate system“: OpenGL works with a Clipping Volume, i.e. with a kind of cube, 
defined by Xmin and Xmax in horizontal direction, by Ymin and Ymax in vertical direction and 
Zmin (points towards the user) and Zmax (points away from the user). If you use a too-large 
zoom factor or if you are panning the structure too near to you then the range of Zmin is ex-
ceeded and parts of the structure are lying outside the viewing volume. This offers a nice 
chance to look into a structure – also in order to see the internal stresses! Otherwise, change 
the value of Zmin (default entry is –100) to lower values, e.g. -1000: use the menu "View" > 
Z limit towards you.  
 
For further information regarding the application and options of postprocessing, please con-
sult the Z88 Aurora User Manual. 
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5. DESCRIPTION OF THE FINITE ELEMENTS 
 

5.1 HEXAHEDRON NO.1 WITH 8 NODES  

The hexahedron element calculates deflections and stresses in space. It is a transformed ele-
ment; therefore it can have a wedging form or another oblique-angled form. The transforma-
tion is isoparametric. The integration is carried out numerically in all three axes according to 
Gauss- Legendre. Thus, the integration order can be selected in Z88I1.TXT in the material 
information lines. The order 2 is mostly sufficient. Hexahedron No.1 is also well usable as a 
thick plate element, if the plate's thickness is not too small against the other dimensions. The 
element causes high computing load and needs a lot of memory, because the element stiffness 
matrix has the order 24×24. 
 
Hexahedrons No.1 can be generated by the mesh generator Z88N from super elements Hexa-
hedrons No.10 and Hexahedrons No.1. 
 Z

Y

1
X

2

8

7

6

5

4
3 

 
 
 
 
 
 
 
 
 
Input: 
 
CAD (see chapter 2.7.2): 
Upper plane:  1 - 2 - 3 - 4 - 1, quit LINE function 
Lower plane:  5 - 6 -7 - 8 - 5, quit LINE function 
1 - 5, quit LINE function 
2 - 6, quit LINE function 
3 - 7, quit LINE function 
4 - 8, quit LINE function 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> IQFLAG=1 if surface and pressure loads for this element are filed in Z88I5.TXT 
> 3 degrees of freedom for each node 
> Element type is 1 
> 8 nodes per element 
> Cross-section parameter QPARA is 0 or any other value, has no influence 
> Integration order INTORD for each mat info line. 2 is usually good. 
 
Z88I3.TXT 
> Integration order INTORD for stress calculation: 
Can be different from INTORD in Z88I1.TXT. 
0   = Calculation of stresses in the corner nodes 
1,2,3,4 = Calculation of stresses in the Gauss points 
> any KFLAG, has no influence 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
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1 = von Mises stresses in the Gauss points (INTORD not 0 !) 
2 = principal or Rankine stresses in the Gauss points (INTORD not 0 !) 
3 = Tresca stresses in the Gauss points (INTORD not 0 !) 
 
Z88I5.TXT 
This file is optional and only used if in addition to nodal forces surface and pressure loads applied onto element 
no.1: 
 
> Element number with surface and pressure load  
> Pressure, positive if pointing towards the surface  
> Tangential shear, positive in local r direction  
> Tangential shear, positive in local s direction   
> 4 corner nodes of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2, the local s direction is defined by the nodes 1-4. The local 
nodes 1, 2, 3 , 4 may differ from the local nodes 1, 2, 3, 4 used for the coincidence. 
 

r

s
p

1

2

3

4

tr

ts

8

5

6

 
Results: 
 
Displacements in X, Y and Z 
Stresses: SIGXX, SIGYY, SIGZZ, TAUXY, TAUYZ, TAUZX, respectively for corner nodes or Gauss points. 
Optional von Mises or principal or Tresca stresses. 
Nodal forces in X, Y and Z for each element and each node. 
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5.2 BEAM NO.2 WITH 2 NODES IN SPACE  

Beam element with any symmetric profile (no slanting bend) with the restriction that the local 
y-y axis must be parallel to the global X-Y coordinate system. The profile values are provided 
in Z88I1.TXT. Thus, you can use any symmetric profile in contrast to other FEA programs 
which sometimes incorporate a variety of different special beam and profile subroutines with-
out matching all symmetric profiles as necessary. The element matches exactly Bernoulli's 
bend theory and Hooke's law. It uses no approximate solution as for the continuum elements. 
 
 

1

y

x pa

X, U

U 5

2Y, U

X-Y

3

z
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2

Z, U

U 4
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 Ebene
parallel to  
x-y plane 

 
 
 
 
 
Input: 
 
CAD (see chapter 2.7.2): Line from node 1 to node 2 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> Set beam flag IBFLAG to 1 
> 6 degrees of freedom in a node (Attention: DOF5 (not right hand rule), see below) 
> Element type is 2 
> 2 nodes per element 
 
At the material information lines: 
> Integration order INTORD is arbitrary (1..4), has no influence 
> Cross-sectional area QPARA 
> Second moment of inertia RIYY (bending around y-y axis) 
> Max. distance EYY from neutral axis y-y 
> Second moment of inertia RIZZ (bending around z-z axis) 
> Max. distance EZZ from neutral axis z-z 
> Second moment of area (torsion) RIT 
> Second modulus (torsion) WT 
 

Z88I3.TXT 
Beams No.2 have no influence. However, Z88I3.TXT must exist (with any content). 
 
Results: 
Displacements in X, Y and Z and rotations around X, Y and Z. Attention DOF5 (not right hand rule), see below 
Stresses: SIGXX, TAUXX: Direct stress, shear stress, SIGZZ1, SIGZZ2: Bending stress around z-z for node 1 
and node 2, SIGYY1 SIGYY2: Bending stress around y-y for node 1 and node 2 
Nodal forces in X, Y and Z and nodal moments around X, Y and Z for each element and each node. 
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Algebraic sign 

X-Y plane X-Z plane 
 



Theorie Manual     

102 

5.3 PLANE STRESS TRIANGLE NO.3 WITH 6 NODES  

This is a simple, triangular plane stress element with complete square shape functions. This 
element is obsolete and kept in Z88 only for studies. Elements No. 7, 11 or 14 are much bet-
ter. Pay attention to edge loads, cf. chapter 3.4. No entries into the surface and pressure loads 
file Z88I5.TXT! 
. 
 

2

X

5

3

1

4

6

Y
 
 
 
 
 
 
 
 
Input: 
 
CAD (see chapter 2.7.2): 1-4-2-5-3-6-1 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or polar coordinates (1) 
> 2 degrees of freedom for each node 
> Element type is 3 
> 6 nodes per element 
> Cross-section parameter QPARA is the element thickness 
 
Z88I3.TXT 
> Integration order INTORD: any order, has no influence 
 
> KFLAG = 0: Calculation of SIGXX, SIGYY and TAUXY 
> KFLAG = 1: Additional calculation of SIGRR, SIGTT and TAURT 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses in the centre of gravity 
2 = principal or Rankine stresses in the centre of gravity 
3 = Tresca stresses in the centre of gravity 
 
Results: 
 
Displacements into X and Y  
Stresses: The stresses are calculated in the element's centre of gravity. The coordinates of the centre of gravity 
are thus printed. For KFLAG = 1 the radial stresses SIGRR, the tangential stresses SIGTT and the accompany-
ing shear stresses SIGRT are computed additionally (makes only sense if a rotational-symmetric structure is 
available). For easier orientation the respective radiuses and angles of the centre of gravity are printed. Optional 
von Mises stresses in the centre of gravity. 
Nodal forces in X and Y for each element and each node. 
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5.4 TRUSS NO.4 IN SPACE  

The truss element No.4 can take any location in space. It is part of the simplest elements in 
Z88 and is calculated extremely fast. The truss elements match Hooke's law exactly. 
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Input: 
 
CAD (see chapter 2.7.2): Line from node 1 to node 2 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> 3 degrees of freedom for each node 
> Element type is 4 
> 2 nodes per element 
> Cross-section parameter QPARA is the cross-sectional area of the truss 
 
Z88I3.TXT 
Trusses No.4 have no influence. However, Z88I3.TXT must exist (with any content). 
 
Results: 
Displacements in X, Y and Z 
Stresses: Normal stresses 
Nodal forces in X, Y and Z for each element and each node. 
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5.5 CAM ELEMENT NO.5 WITH 2 NODES  

The cam element is a simplification of the general beam element No.2: It has always a circu-
lar cross-cut. The element lies concentrically to the X axis, consequently local and global co-
ordinates have the same direction. Inputs and calculations are simplified strongly through this. 
Like with the beam element the results are exact according to Bernoulli's bend theory and 
Hooke's law, and not approximate solutions like with the continuum elements. 
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Input: 
 
CAD (see chapter 2.7.2): Line from node 1 to node 2 
 
Z88I1.TXT 
> Set KFLAG on 0 for Cartesian coordinates 
> 6 degrees of freedom in a node (Attention DOF5 (not right hand rule), see below) 
> Element type is 5 
> 2 nodes per element 
> Cross-section parameter QPARA is the diameter of the cam 
 
Z88I3.TXT 
Cams No.2 have no influence. However, Z88I3.TXT must exist (with any content). 
 
Results: 
 
Displacements in X, Y and Z and rotations around X, Y and Z. Attention DOF5 (not right hand rule), see below 
Stresses: SIGXX, TAUXX: Direct stress, shear stress, SIGXY1, SIGXY2: Bending stress in X-Y plane for 
node 1 and node 2, SIGXZ1 SIGXZ2: Bending stress in X-Z plane for node 1 and node 2 
Nodal forces in X, Y and Z and nodal moments around X, Y and Z for each element and each node.  
 

Algebraic sign 

 X-Y plane X-Z plane 
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5.6 TORUS NO.6 WITH 3 NODES  

This element is implemented only for historical reasons and possible data exchange to other 
FEA systems. Much better: Torus No.8 or Torus No.12 or No.15. No entries into the surface 
and pressure loads file Z88I5.TXT! 
 
This is a simple, triangular torus element with linear shape functions for rotational-symmetric 
structures. The displacement results for this very simple element are quite useable, but the 
stress calculation results are inaccurate. The stresses are calculated in the corner nodes inter-
nally and then distributed as average value in the centre of gravity. However, the use of the 
torus elements No.8 or No.12 or No.15 is highly recommended especially for accurate stress 
calculations.  
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Input: 
 
CAD (see chapter 2.7.2): 1-2-3-1 
 
Z88I1.TXT 
> In principle cylindrical coordinates are expected: KFLAG must be 0! 
 R coordinate (= X), always positive 
 Z coordinate (= Y), always positive 
> 2 degrees of freedom for each node, DOF R and Z (= X and Y)). 
> Element type is 6 
> 3 nodes per element 
> Cross-section parameter QPARA is 0 or any value, no influence 
 
Z88I3.TXT 
> INTORD , any, has no influence 
> KFLAG  , any, has no influence 
> Reduced stress flag ISFLAG: 
0 = no reduced stress calculation 
1 = von Mises stresses plotted in the centre of gravity 
2 = principal or Rankine stresses plotted in the centre of gravity 
3 = Tresca stresses plotted in the centre of gravity 
 
Results: 
 
Displacements in R and Z (= X and Y)  
Stresses: The stress are internally computed in the corner nodes, but plotted in the centre of gravity. 
It is: SIGRR = stress in R direction = radial stress (= X direction), SIGZZ = stress in Z direction (= Y direction), 
TAURZ = shear stress in RZ plane (= XY plane), SIGTE = stress in peripherical direction = tangential stress. 
Optional von Mises stresses. 
Nodal forces for each element and each node. 
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5.7  PLANE STRESS ELEMENT NO.7 WITH 8 NODES  

This is a curvilinear Serendipity plane stress element with square shape functions. The trans-
formation is isoparametric. The integration is carried out numerically in both axes according 
to Gauss-Legendre. Consequently, the integration order can be selected in Z88I1.TXT in the 
material information lines. The order 3 is mostly sufficient. This element calculates both dis-
placements and stresses very exactly. The integration order can be chosen again for the stress 
calculation. The stresses are calculated in the corner nodes (good for an overview) or calcu-
lated in the Gauss points (substantially more exactly). Pay attention to edge loads when using 
forces, cf. chapter 3.4. It is easier to enter edge loads via the surface and pressure loads file 
Z88I5.TXT. You may combine this element with elements no.3 (not recommended) or ele-
ments no.14 (good). 
Plane Stress Elements No.7 can be generated by the mesh generator Z88N from super ele-
ments Plane Stress Elements No.7 or No.11. Thus, the Plane Stress Element No.7 is well 
suited as super element. 
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Input: 
 
CAD (see chapter 2.7.2): 1-5-2-6-3-7-4-8-1 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or polar coordinates (1) 
> IQFLAG=1 if edge loads for this element are filed in Z88I5.TXT 
> 2 degrees of freedom for each node 
> Element type is 7 
> 8 nodes per element 
> Cross-section parameter QPARA is the element thickness 
> Integration order INTORD per each mat info line. 3 is usually good. 
 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
0   = Calculation of the stresses in the corner nodes 
1,2,3,4 = Calculation of the stresses in the Gauss points 
 
> KFLAG = 0: Calculation of SIGXX, SIGYY and TAUXY 
> KFLAG = 1: Additional calculation of SIGRR, SIGTT and TAURT 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Teresa stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
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This file is optional and only used if in addition to nodal forces edge loads applied onto element no.7: 
 
> Element number with surface and pressure load   
> Pressure, positive if pointing towards the edge   
> Tangential shear, positive in local r direction  
> 2 corner nodes and one mid node of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2. The local nodes 1, 2, 3 may differ from the local nodes 1, 2, 3 
used for the coincidence. 
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Results: 
 
Displacements in X and Y.  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
For KFLAG = 1 the radial stresses SIGRR, the tangential stresses SIGTT and the accompanying shear stresses 
SIGRT are computed additionally (makes only sense if a rotational-symmetric structure is available). For easier 
orientation the respective radiuses and angles of the nodes/points are printed. Optional von Mises or principal or 
Tresca stresses  
Nodal forces in X and Y for each element and each node. 
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5.8  TORUS NO.8 WITH 8 NODES  

This is a curvilinear Serendipity torus element with square shape functions. The transforma-
tion is isoparametric. The integration is carried out numerically in both axes according to 
Gauss-Legendre. Thus, the integration order can be selected in Z88I1.TXT in the material in-
formation lines. The order 3 is mostly sufficient. This element calculates both displacements 
and stresses very exactly. The integration order can be chosen again for the stress calculation. 
The stresses are calculated in the corner nodes (good for an overview) or calculated in the 
Gauss points (substantially more exactly). Pay attention to edge loads when using forces, cf. 
chapter 3.4. It is easier to enter edge loads via the surface and pressure loads file Z88I5.TXT. 
You may combine this element with elements no.15. 
 
Torus elements No.8 can be generated by the mesh generator Z88N from the super elements 
torus elements No.8 or No.12. Thus, Torus No.8 is well suited as super element. 
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Input: 
 
CAD (see chapter 2.7.2): 1-5-2-6-3-7-4-8-1 
 
Z88I1.TXT 
> In principle cylindrical coordinates are expected: KFLAG must be 0! 
 R coordinate (= X), always positive 
 Z coordinate (= Y), always positive 
> IQFLAG=1 if edge loads for this element are filed in Z88I5.TXT 
> 2 degrees of freedom for each node, DOF R and Z (= X and Y). 
> Element type is 8 
> 8 nodes per element 
> Cross-section parameter QPARA is 0 or any value, no influence 
> Integration order per each mat info line. 3 is usually good. 
 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT , but 
different values are permitted 
0   = Calculation of the stresses in the corner nodes 
1,2,3,4 = Calculation of the stresses in the Gauss points 
 
> KFLAG, any, has no influence  
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
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Z88I5.TXT 
This file is optional and only used if in addition to nodal forces edge loads applied onto element no.8: 
 
> Element number with surface and pressure load  
> Pressure, positive if pointing towards the edge  
> Tangential shear, positive in local r direction  
> 2 corner nodes and one mid node of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2. The local nodes 1, 2, 3 may differ from the local nodes 1, 2, 3 
used for the coincidence. 
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Results: 
 
Displacements in R and Z (= X and Y).  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
It is: SIGRR = stress in R direction = radial stress (= X direction), SIGZZ = stress in Z direction (= Y direction), 
TAURZ = shear stress in RZ plane (= XY plane), SIGTE = stress in peripherical direction = tangential stress. 
Optional von Mises stresses. 
Nodal forces in R (= X) and Z (= Y) for each element and each node. 
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5.9 TRUSS NO.9 IN PLANE  

The truss element No.9 can take any location in the X-Y plane. It is the simplest element in 
Z88 and is calculated extremely fast. The truss elements match Hooke's law exactly. 
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Input: 
 
CAD (see chapter 2.7.2): Line from node 1 to node 2 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or polar coordinates (1) 
> 2 degrees of freedom for each node 
> Element type is 9 
> 2 nodes per element 
> Cross-section parameter QPARA is the cross-sectional area of the truss 
Z88I3.TXT 
 
Trusses No.9 have no influence. However, Z88I3.TXT must exist (with any content). 
 
Results: 
 
Displacements in X and Y 
Stresses: Normal stresses 
Nodal forces in X and Y for each element and each node. 
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5.10  HEXAHEDRON NO.10 WITH 20 NODES  

This is a curvilinear Serendipity volume element with square shape functions. The transfor-
mation is isoparametric. The integration is carried out numerically in all axes according to 
Gauss- Legendre. Thus, the integration order can be selected in Z88I1.TXT in the material 
information lines. The order 3 is good. The quality of the displacement and stress calculations 
are far better than the results of the hexahedron element No.1. 
 
Hexahedron No.1 also applies well for thick plate elements, if the plate's thickness is not too 
small compared to the other dimensions. 
 
The element causes an enormous computing load and needs an extreme amount of memory 
because the element stiffness matrix has the order 60*60. 
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The nodal numbering of the element No.10 must be done carefully and must exactly 
match the sketch below. Pay attention to the location of the axis system! The possible 
error message „Jacobi determinant zero or negative " is a hint for incorrect node num-
bering. 
Pay attention to surface and pressure loads when using forces, cf. chapter 3.4. It is easier to 
enter these loads via the surface and pressure loads file Z88I5.TXT. 
 
Hexahedron No.10 can be generated by the mesh generator Z88N from super elements Hexa-
hedron No.10. Thus, the Hexahedron No.10 is well suited as super element. Hexahedron 
No.10 can also generate 8-node Hexahedrons No.1. 
 
Input: 
 
CAD (see chapter 2.7.2): 
Upper plane:  1 - 9 - 2 - 10 - 3 - 11 - 4 -12 - 1, quit LINE function 
Lower plane: 5 - 13 - 6 - 14 - 7 - 15 - 8 - 16 - 5, quit LINE function 
1 - 17 - 5, quit LINE function 
2 - 18 - 6, quit LINE function 
3 - 19 - 7, quit LINE function 
4 - 20 - 8, quit LINE function 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1)  
> IQFLAG=1 if surface and pressure loads for this element are filed in Z88I5.TXT 
> 3 degrees of freedom for each node 
> Element type is 10 
> 20 nodes per element 
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> Cross-section parameter QPARA is 0 or any value, has no influence 
> Integration order INTORD for each mat info line. 3 is usually good. 
 
Z88I3.TXT 
> Integration order INTORD for stress calculation: 
Can be different from INTORD in Z88I1.TXT. 
0   = Calculation of stresses in the corner nodes 
1,2,3,4 = Calculation of stresses in the Gauss points 
 
> KFLAG , any, has no influence 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and only used if in addition to nodal forces surface and pressure loads applied onto element 
no.10: 
 
> Element number with surface and pressure load  
> Pressure, positive if pointing towards the surface 
> Tangential shear, positive in local r direction  
> Tangential shear, positive in local s direction  
> 4 corner nodes and 4 mid nodes of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2; the local s direction is defined by the nodes 1-4. The local 
nodes 1, 2, 3, 4 may differ from the local nodes 1, 2, 3, 4 used for the coincidence. 
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Results: 
 
Displacements in X, Y and Z 
Stresses: SIGXX, SIGYY, SIGZZ, TAUXY, TAUYZ, TAUZX, respectively for corner nodes or Gauss points. 
Optional von Mises or principal or Tresca stresses. 
Nodal forces in X, Y and Z for each element and each node. 
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5.11 PLANE STRESS ELEMENT NO.11 WITH 12 NODES  

This is a curvilinear Serendipity plane stress element with cubic shape functions. The trans-
formation is isoparametric. The integration is carried out numerically in both axes according 
to Gauss-Legendre. Thus, the integration order can be selected in Z88I1.TXT in the material 
information lines. The order 3 is mostly the best choice. This element calculates both dis-
placements and stresses with outstanding precision. The integration order can be chosen again 
for the stress calculation. The stresses are calculated in the corner nodes (good for an over-
view) or calculated in the Gauss points (substantially more exactly). Because of its 24×24 
element stiffness matrices the element No.11 needs a lot of memory and computing power. 
Pay attention to edge loads when using forces, cf. chapter 3.4. It is easier to enter edge loads 
via the surface and pressure loads file Z88I5.TXT. 
 
Plane Stress Elements No.7 can be generated by the mesh generator Z88N from super ele-
ments Plane Stress Elements No.11. Thus, the Plane Stress Element No.11 is well suited as 
super element. But Plane Stress Elements No.11 cannot be generated by the mesh generator 
Z88N from super elements Plane Stress Elements No.11. 
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Input: 
 
CAD (see chapter 2.7.2): 1-5-6-2-7-8-3-9-10-4-11-12-1 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or polar coordinates (1)  
> IQFLAG=1 if edge loads for this element are filed in Z88I5.TXT 
> 2 degrees of freedom for each node 
> Element type is 11 
> 12 nodes per element 
> Cross-section parameter QPARA is the element thickness 
> Integration order INTORD per each mat info line. 3 is usually good. 
 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
0   = Calculation of the stresses in the corner nodes 
1,2,3,4 = Calculation of the stresses in the Gauss points 
 
> KFLAG = 0: Calculation of SIGXX, SIGYY and TAUXY 
> KFLAG = 1: Additional calculation of SIGRR, SIGTT and TAURT 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
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3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and only used if in addition to nodal forces edge loads applied onto element no.11: 
 
> Element number with surface and pressure load  
> Pressure, positive if pointing towards the edge  
> Tangential shear, positive in local r direction 
> 2 corner nodes and 2 mid nodes of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2. The local nodes 1, 2, 3, 4 may differ from the local nodes 1, 2, 
3, 4 used for the coincidence. 
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Results: 
 
Displacements in X and Y.  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
For KFLAG = 1 the radial stresses SIGRR, the tangential stresses SIGTT and the accompanying shear stresses 
SIGRT are computed additionally (makes only sense if a rotational-symmetric structure is available). For easier 
orientation the respective radiuses and angles of the nodes/points are printed. Optional von Mises or principal or 
Tresca stresses  
Nodal forces in X and Y for each element and each node. 
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5.12  TORUS NO.12 WITH 12 NODES  

This is a curvilinear Serendipity torus element with cubic shape functions. The transformation 
is isoparametric. The integration is carried out numerically in both axes according to Gauss- 
Legendre. Thus, the integration order can be selected in Z88I1.TXT in the material informa-
tion lines. The order 3 is mostly sufficient. This element calculates both displacements and 
stresses with outstanding precision. The integration order can be chosen again for the stress 
calculation. The stresses are calculated in the corner nodes (good for an overview) or calcu-
lated in the Gauss points (substantially more exactly). Because of its 24*24 element stiffness 
matrices the element No.11 needs a lot of memory and computing power. Pay attention to 
edge loads when using forces, cf. chapter 3.4. It is easier to enter edge loads via the surface 
and pressure loads file Z88I5.TXT. 
 
Torus elements No.8 can be generated by the mesh generator Z88N from super elements torus 
elements No.12. Thus, the torus element No.12 is well suited as super element. But torus ele-
ments No.12 cannot be generated by the mesh generator Z88N from super elements torus ele-
ments No.12. 
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Input: 
 
CAD (see chapter 2.7.2): 1-5-6-2-7-8-3-9-10-4-11-12-1 
 
Z88I1.TXT 
> In principle cylindrical coordinates are expected: KFLAG must be 0! 
 R coordinate (= X), always positive 
 Z coordinate (= Y), always positive 
> IQFLAG=1 if edge loads for this element are filed in Z88I5.TXT 
> 2 degrees of freedom for each node, DOF R and Z (= X and Y). 
> Element type is 12 
> 12 nodes per element 
> Cross-section parameter QPARA is 0 or any value, no influence 
> Integration order per each mat info line. 3 is usually good. 
 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
0   = Calculation of the stresses in the corner nodes 
1,2,3,4 = Calculation of the stresses in the Gauss points 
 
> KFLAG, any, has no influence  
 
> Reduced stress flag ISFLAG: 
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0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and only used if in addition to nodal forces edge loads applied onto element no.12: 
 
> Element number with surface and pressure load  
> Pressure, positive if pointing towards the edge  
> Tangential shear, positive in local r direction 
> 2 corner nodes and 2 mid nodes of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2. The local nodes 1, 2, 3, 4 may differ from the local nodes 1, 2, 
3, 4 used for the coincidence. 
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Results: 
 
Displacements in R and Z (= X and Y).  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
It is: SIGRR = stress in R direction = radial stress (= X direction), SIGZZ = stress in Z direction (= Y direction), 
TAURZ = shear stress in RZ plane (= XY plane), SIGTE = stress in peripherical direction = tangential stress. 
Optional von Mises or principal or Tresca stresses. 
Nodal forces in R (= X) and Z (= Y) for each element and each node. 
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5.13  BEAM NO.13 IN PLANE  

Beam element with any symmetric profile. The profile values are provided in Z88I1.TXT. 
Thus, you can use any symmetric profile in contrast to other FEA programs which sometimes 
incorporate a variety of different special beam and profile subroutines without matching all 
symmetric profiles as necessary. The element matches exactly Bernoulli's bend theory and 
Hooke's law. It uses no approximate solution compared to the continuum elements. 
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Input: 

Y, U 2

1 2
1X, U

algebraic sign 

 
CAD (see chapter 2.7.2): Line from node 1 to node 2 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or polar coordinates (1) 
> Set beam flag IBFLAG to 1 
> 3 degrees of freedom in a node 
> Element type is 13 
> 2 nodes per element 
 
At the material information lines: 
> Any integration order INTORD (1...4), has no influence 
> Cross-sectional area QPARA 
> Insert 0 for second moment of inertia RIYY (bending around y-y axis) 
> Insert 0 for max. distance EYY from neutral axis y-y 
> Second moment of inertia RIZZ (bending around z-z axis) 
> Max. distance EZZ from neutral axis z-z 
> Insert 0 for second moment of area (torsion) RIT 
> Insert 0 for second modulus (torsion) WT 
 
Z88I3.TXT 
Beams No.13 have no influence. However, Z88I3.TXT must exist (with any content). 
 
Results: 
 
Displacements in X and Y and rotations around Z. 
Stresses: SIGXX, TAUXX: Direct stress, shear stress, SIGZZ1, SIGZZ2: Bending stress around z-z for node 1 
and node 2 
Nodal forces in X and Y and nodal moments around Z for each element and each node. 
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5.14  PLANE STRESS ELEMENT NO.14 WITH 6 NODES  

This is a curvilinear Serendipity plane stress element with square shape functions. The trans-
formation is isoparametric. The integration is carried out numerically according to Gauss- 
Legendre. Consequently, the integration order can be selected in Z88I1.TXT in the material 
information lines. The order 7 (=7 Gauss points) is mostly sufficient. This element calculates 
both displacements and stresses very exactly. The integration order can be chosen again for 
the stress calculation. The stresses are calculated in the corner nodes (good for an overview) 
or calculated in the Gauss points (substantially more exactly). Pay attention to edge loads 
when using forces, cf. chapter 3.4. It is easier to enter edge loads via the surface and pressure 
loads file Z88I5.TXT. 
 
This element type is implemented for use with automeshers e.g. Pro/MECHANICA  for the 3D 
CAD system Pro/ENGINEER by Parametric Technology. Thus, a mesh generation with Z88N 
is not possible. Use plane stress elements No.7 for Z88N. 
Use plane stress element No.7 whenever possible. It is substantially more precise than this 
isoparametric triangle. 
 
 Y

X
1

3

5

6

4 2

 
 
 
 
 
 
 
 
 
Input: 
 
CAD (see chapter 2.7.2): 1-4-2-5-3-6-1 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or polar coordinates (1) 
> IQFLAG=1 if edge loads for this element are filed in Z88I5.TXT 
> 2 degrees of freedom for each node 
> Element type is 14 
> 6 nodes per element 
> Cross-section parameter QPARA is the element thickness 
> Integration order INTORD per each mat info line. 7 is usually good. Possible is: 3 for 

3 Gauss points, 7 for 7 Gauss points and 13 for 13 Gauss points. For easy use with 
plane stress element No.7 (e.g. with Pro/ENGINEER), function ISOD88 of Z88 uses 
internally these values: 
integration order 1 or 2 in Z88I1.TXT: 3 Gauss points 
integration order 4 in Z88I1.TXT: 7 Gauss points 
 
Example: Z88I1.TXT uses an entry of 2 for INTORD: Thus, plane stress elements 
No.7 use 2×2 = 4 Gauss points and plane stress elements No.14 use 3 Gauss points     for integra-

tion. 
 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
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0   = Calculation of the stresses in the corner nodes 
1, 7, 13 = Calculation of the stresses in the Gauss points (e.g. 7 Gauss points) See note for Z88I1.TXT.  
 
> KFLAG = 0: Calculation of SIGXX, SIGYY and TAUXY 
> KFLAG = 1: Additional calculation of SIGRR, SIGTT and TAURT 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and only used if in addition to nodal forces edge loads applied onto element no.14: 
 
> Element number with surface and pressure load  
> Pressure, positive if pointing towards the edge  
> Tangential shear, positive in local r direction 
> 2 corner nodes and one mid node of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2. The local nodes 1, 2, 3 may differ from the local nodes 1, 2, 3 
used for the coincidence. 
 

r

p
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Results: 
 
Displacements in X and Y.  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
For KFLAG = 1 the radial stresses SIGRR, the tangential stresses SIGTT and the accompanying shear stresses 
SIGRT are computed additionally (makes only sense if a rotational-symmetric structure is available). For easier 
orientation the respective radiuses and angles of the nodes/points are printed. Optional von Mises or principal or 
Tresca stresses. 
Nodal forces in X and Y for each element and each node. 
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5.15  TORUS NO.15 WITH 6 NODES  

This is a curvilinear Serendipity torus element with square shape functions. The transforma-
tion is isoparametric. The integration is carried out numerically according to Gauss- Legen-
dre. Thus, the integration order can be selected in Z88I1.TXT in the material information 
lines. The order 7 is mostly sufficient. This element calculates both displacements and 
stresses very exactly. The integration order can be chosen again for the stress calculation. The 
stresses are calculated in the corner nodes (good for an overview) or calculated in the Gauss 
points (substantially more exactly). Pay attention to edge loads when using forces, cf. chapter 
3.4. It is easier to enter edge loads via the surface and pressure loads file Z88I5.TXT. 
 
This element type is implemented for use with automeshers e.g. Pro/MECHANICA for the 3D 
CAD system Pro/ENGINEER by Parametric Technology. Thus, a mesh generation with Z88N 
is not possible. Use torus elements No.8 for Z88N. 
Use torus element No.8 whenever possible. It is substantially more precise than this 
isoparametric triangle. 
 

5

3

R (=X)

Z (=Y)

2

6
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Input: 
 
CAD (see chapter 2.7.2): 1-4-2-5-3-6-1 
 
Z88I1.TXT 
> In principle cylindrical coordinates are expected: KFLAG must be 0! 
 R coordinate (= X), always positive 
 Z coordinate (= Y), always positive 
> IQFLAG=1 if edge loads for this element are filed in Z88I5.TXT 
> 2 degrees of freedom for each node, DOF R and Z (= X and Y). 
> Element type is 15 
> 6 nodes per element 
> Cross-section parameter QPARA is 0 or any value, no influence 
> Integration order INTORD per each mat info line. 7 is usually good. Possible is: 3 for 

3 Gauss points, 7 for 7 Gauss points and 13 for 13 Gauss points. For easy use with 
torus element No.8 (e.g. with Pro/ENGINEER), function ISOD88 of Z88 uses 
internally these values: 
integration order 1 or 2 in Z88I1.TXT: 3 Gauss points 
integration order 4 in Z88I1.TXT: 7 Gauss points 
Example: Z88I1.TXT uses an entry of 2 for INTORD: Thus, torus elements 
No.8 use 2×2 = 4 Gauss points and torus elements No.14 use 3 Gauss points for 
integration. 

 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
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0   = Calculation of the stresses in the corner nodes 
1, 7, 13 = Calculation of the stresses in the Gauss points (e.g. 7 Gauss points) See note for Z88I1.TXT.  
 
> KFLAG, any, has no influence  
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
 
This file is optional and only used if in addition to nodal forces edge loads applied onto element no.15: 
 
> Element number with surface and pressure load  
> Pressure, positive if pointing towards the edge  
> Tangential shear, positive in local r direction 
> 2 corner nodes and one mid node of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2. The local nodes 1, 2, 3 may differ from the local nodes 1, 2, 3 
used for the coincidence. 
 

r
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Results: 
Displacements in R and Z (= X and Y).  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
It is: SIGRR = stress in R direction = radial stress (= X direction), SIGZZ = stress in Z direction (= Y direction), 
TAURZ = shear stress in RZ plane (= XY plane), SIGTE = stress in peripherical direction = tangential stress. 
Optional von Mises or principal or Tresca stresses. 
Nodal forces in R (= X) and Z (= Y) for each element and each node. 
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5.16  TETRAHEDRON NO.16 WITH 10 NODES  

This is a curvilinear Serendipity volume element with square shape functions. The transfor-
mation is isoparametric. The integration is carried out numerically according to Gauss- Leg-
endre. Thus, the integration order can be selected in Z88I1.TXT in the material information 
lines. The order 4 is good. The quality of the displacement and stress calculations are far bet-
ter than the results of the tetrahedron element No.17 but less precise than hexahedron No.10.  
 
This element type is implemented for use with automeshers e.g. Pro/MECHANICA  for the 3D 
CAD system Pro/ENGINEER by Parametric Technology. The converter functionality in Z88 
Aurora offers the possibility to import and process files with this element type by means of 
Z88G. For further information see chapter 4.1.8; a DXF data exchange with Z88X is not pos-
sible, because this will make no sense. 
 
Tetrahedron No.16 also applies well for thick plate elements, if the plate's thickness is not too 
small compared to the other dimensions. 
The element causes a big computing load and needs a large amount of memory because the 
element stiffness matrix has the order 30×30. Pay attention to pressure loads when using 
forces, cf. chapter 3.4. It is easier to enter pressure loads via the surface and pressure loads 
file Z88I5.TXT. 
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The nodal numbering of the element No.16 must be done carefully and must exactly match 
the sketch below. Pay attention to the location of the axis system! The possible error message 
„Jacobi determinant zero or negative " is a hint for incorrect node numbering. 
 
Tetrahedron No.16 cannot be generated by the mesh generator Z88N. A DXF data exchange 
with Z88X is not implemented because tetrahedrons due to their strange geometry are very 
difficult to arrange in space. This element's main purpose is the use with automeshers from 
third-party suppliers. Caution: Sometimes the automeshers of CAD systems produce very 
bad element and nodal numbering resulting in an useless large amount of memory needs of 
Z88F. In this case, renumber especially the nodes. 
 
Input: 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> IQFLAG=1 if pressure loads for this element are filed in Z88I5.TXT 
> 3 degrees of freedom for each node 
> Element type is 16 
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> 10 nodes per element 
> Cross-section parameter QPARA is 0 or any value, has no influence 
> Integration order INTORD for each mat info line. 4 is usually good. Allowed are 1 for 
 1 Gauss point, 4 for 4 Gauss points and 5 for 5 Gauss points. 
 
Z88I3.TXT 
> Integration order INTORD for stress calculation: 
Can be different from INTORD in Z88I1.TXT. 
0   = Calculation of stresses in the corner nodes 
1, 4, 5 = Calculation of stresses in the Gauss points (e.g. 4 = 4 Gauss points) 
 
> KFLAG, any, has no influence 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and only used if in addition to nodal forces pressure loads applied onto element no.16: 
 
> Element number with pressure load  
> Pressure, positive if pointing towards the edge  
> 3 corner nodes and 3 mid nodes of the loaded surface. Mathematically positive in plain view. 
 
The local nodes 1 to 6 may differ from the local nodes 1 to 6 used for the coincidence.  

p
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4
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Results: 
Displacements in X, Y and Z 
Stresses: SIGXX, SIGYY, SIGZZ, TAUXY, TAUYZ, TAUZX, respectively for corner nodes or Gauss points. 
Optional von Mises or principal or Tresca stresses. 
Nodal forces in X, Y and Z for each element and each node. 
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5.17  TETRAHEDRON NO.17 WITH 4 NODES  

This is a volume element with linear shape functions. The transformation is isoparametric. 
The integration is carried out numerically according to Gauss- Legendre. Thus, the integration 
order can be selected in Z88I1.TXT in the material information lines. The order 1 is good.  
 
This element type is implemented for use with automeshers e.g. Pro/MECHANICA for the 3D 
CAD system Pro/ENGINEER by Parametric Technology. The converter functionality in Z88 
Aurora offers the possibility to import and process files with this element type by means of 
Z88G. For further information see chapter 4.1.8; a DXF data exchange with Z88X is not pos-
sible, because this will make no sense. 
 
Tetrahedron No.17 also applies well for thick plate elements, if the plate's thickness is not too 
small compared to the other dimensions. 
 
Basically, this element calculates deflections and stresses very bad i.e. inaccurate. One needs 
very fine meshes to obtain useful results. Its one and only reason is the data exchange with 
3D CAD systems. Use tetrahedrons No.16, hexahedrons No.1 and (best choice) hexahedrons 
No.10. 
 
Tetrahedron No.17 cannot be generated by the mesh generator Z88N. A DXF data exchange 
with Z88X is not implemented because tetrahedrons due to their strange geometry are very 
difficult to arrange in space. This element's main purpose is the use with automeshers from 
third-party suppliers. Caution: Sometimes the automeshers of CAD systems produce very 
bad element and nodal numbering resulting in an useless large amount of memory needs of 
Z88F. In this case, renumber especially the nodes. 
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Input: 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> IQFLAG=1 if pressure loads for this element are filed in Z88I5.TXT 
> 3 degrees of freedom for each node 
> Element type is 17 
> 4 nodes per element 
> Cross-section parameter QPARA is 0 or any value, has no influence 
> Integration order INTORD for each mat info line. 1 is usually good. Allowed are 1 for 
 1 Gauss point, 4 for 4 Gauss points and 5 for 5 Gauss points. 
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Z88I3.TXT 
> Integration order INTORD for stress calculation: 
Can be different from INTORD in Z88I1.TXT. 
0   = Calculation of stresses in the corner nodes 
1, 4, 5 = Calculation of stresses in the Gauss points (e.g. 4 = 4 Gauss points) 
 
> KFLAG, any, has no influence 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and only used if in addition to nodal forces pressure loads applied onto element no.17: 
 
> Element number with pressure load  
> Pressure, positive if pointing towards the edge  
> 3 corner nodes of the loaded surface. Mathematically positive in plain view. 
 
The local nodes 1 to 3 may differ from the local nodes 1 to 3 used for the coincidence. 
 
 
Results: 
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Displacements in X, Y and Z 
Stresses: SIGXX, SIGYY, SIGZZ, TAUXY, TAUYZ, TAUZX, respectively for corner nodes or Gauss points. 
Optional von Mises or principal or Tresca stresses. 
Nodal forces in X, Y and Z for each element and each node. 
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5.18  PLATE NO.18 WITH 6 NODES  

This is a curvilinear Serendipity Reissner-Mindlin plate element with square shape functions. 
The transformation is isoparametric. The integration is carried out numerically in both axes 
according to Gauss-Legendre. Consequently, the integration order can be selected in 
Z88I1.TXT in the material information lines. The order 3 (= 3 points) is mostly sufficient (re-
duced integration). This element calculates both displacements and stresses quite good. The 
integration order can be chosen again for the stress calculation. The stresses are calculated in 
the corner nodes (good for an overview) or calculated in the Gauss points (substantially more 
exactly). Area loads are defined in the appropriate material lines; file Z88I1.TXT, instead of 
Second moment of inertia RIYY. For this element you need to set the plate flag IPFLAG to 1. 
Attention: In contrary to the usual rules of the classic mechanics Z88 defines x the rotation 
around the X-axis and y the rotation around the Y-axis. 
 
This element type is implemented for use with automeshers e.g. Pro/MECHANICA for the 3D 
CAD system Pro/ENGINEER by Parametric Technology. Thus, a mesh generation with Z88N 
is not possible, because this will make no sense. Use plates No.20 for the mesher Z88N. 
Because plates No.20 compute both the deflections and the stresses more exactly than the 
curvilinear triangle plates No.18, you should prefer always plates No.20. 
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Input: 
 
CAD: 1-4-2-5-3-6-1, ref. Chap. 2.7.2 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> set plate flag IPFLAG to 1 (or 2, if you want to reduce the shear influence) 
> set surface and pressure loads flag IQFLAG to 0 for your convenience. Then the entry of the pressure is done 
via the "Second moment of inertia RIYY", see below. If IQFLAG is set to 1, then the entry of the pressure is done 
via the surface and pressure loads file Z88I5.TXT 
> 3 degrees of freedom for each node (w, x,y ) 
> Element type is 18 
> 6 nodes per element 
> Cross-section parameter QPARA is the element thickness 
> "Second moment of inertia RIYY"  is the pressure load 
> Integration order INTORD per each mat info line. 3 is usually good. Possible is: 3 for 
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3 Gauss points, 7 for 7 Gauss points and 13 for 13 Gauss points. For easy use with 
plate element No.20 (e.g. with Pro/ENGINEER), function SPLA88 of Z88 uses 
internally these values: 
integration order 1 or 2 in Z88I1.TXT: 3 Gauss points 
integration order 4 in Z88I1.TXT: 7 Gauss points 
 
Example: Z88I1.TXT uses an entry of 2 for INTORD: Thus, plate elements 
No.20 use 2×2 = 4 Gauss points and plate elements No.18 use 3 Gauss points for 
integration. 
 

Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
 
0   = Calculation of the stresses in the corner nodes 
1, 7, 13 = Calculation of the stresses in the Gauss points (e.g. 7 Gauss points) See note 
   for Z88I1.TXT.  
 
> KFLAG has no meaning 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and normally not used here because it is much more convenient to enter the pressure data for 
the plate elements into Z88I1.TXT in the section material information. However, the possibility for entering the 
pressure loads by the surface and pressure loads file Z88I5.TXT, too, is implemented for universal use of this 
file. Then set IQFLAG to 1 and proceed as follows: 
 
> Element number with pressure load  
> Pressure, positive if pointing towards the edge  
 
Results: 
 
Displacements in Z (i.e. w) and rotations x around X-axis and y around the Y-axis.  
 
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
The following results will be presented: 
 p

late bending moments Mxx and Myy (unit: force × length / length) 
 p

late torsion moments Mxy = Myx (unit: force × length / length) 
 t

he shear forces Qyz and Qzx (unit: force / length) 
 t

he true stresses resulting from plate bending moments and plate torsion moments 
Optional von Mises or principal or Tresca stresses.  
Nodal forces in X and Y for each element and each node. 
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5.19  PLATE NO.19 WITH 16 NODES  

This is a curvilinear Lagrange-Reissner-Mindlin plate element with cubic shape functions. 
The transformation is isoparametric. The integration is carried out numerically in both axes 
according to Gauss-Legendre. Consequently, the integration order can be selected in 
Z88I1.TXT in the material information lines. The order 4 (= 4 × 4 points) is very good. This 
element calculates both displacements and stresses very precisely. The input amount is heavy; 
you should use the mesher Z88N. 
 
The integration order can be chosen again for the stress calculation. The stresses are calcu-
lated in the corner nodes (good for an overview) or calculated in the Gauss points (substan-
tially more exactly). Area loads are defined in the appropriate material lines, file Z88I1.TXT, 
instead of Second moment of inertia RIYY. For this element you need to set the plate flag IP-
FLAG to 1. Attention: In contrary to the usual rules of the classic mechanics Z88 defines x 
the rotation around the X-axis and y the rotation around the Y-axis. 
 
Mesh generation with Z88N: Use plates No.20 for super elements, resulting in finite elements 
of type 19 (plates No.20 may generated by AutoCAD or Pro/ENGINEER, ref. the chapters of 
Z88X and Z88G). A bit tricky, but works quite fine. 
For example, some lines from a mesh generator input file Z88NI.TXT: 
 
 ..... 
5     20            super element 5 of type 20 
20    25    27    22    24    26    28    21 
..... 
5         19                 generate from super element 5 (which is of type 20 is, see above) finite elements of type 19   
3 E       3 E          .. and subdivide them three times equidistant in X-direction and three times equidistant in Y- direction 
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Input: 
 
CAD: 1-2-3-4-5-6-7-8-9-10-11-12-13-14-15-16-1 , ref. chap. 2.7.2. Usually, you will not work in this way. It's 
much easier to build within a CAD program a super elements mesh with 8- node plates No.20. Export this mesh 
as a DXF file and use Z88X to produce a mesh generator input file Z88NI.TXT. Run the mesher Z88N and gen-
erate a finite elements mesh with plates No.19. Plot this mesh using Z88P, read off the appropriate node num-
bers and edit the boundary conditions file Z88I2.TXT. 
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Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> set plate flag IPFLAG to 1 (or 2, if you want to reduce the shear influence) 
> set surface and pressure loads flag IQFLAG to 0 for your convenience. Then the entry of the pressure is done 
via the "Second moment of inertia RIYY", see below. If IQFLAG is set to 1, then the entry of the pressure is done 
via the surface and pressure loads file Z88I5.TXT 
> 3 degrees of freedom for each node (w, x,y ) 
> Element type is 19 
> 16 nodes per element 
> Cross-section parameter QPARA is the element thickness 
> "Second moment of inertia RIYY" is the surface load 
> Integration order INTORD per each mat info line. 4 is usually good.  

 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
0   = Calculation of the stresses in the corner nodes 
1, 2, 3, 4 = Calculation of the stresses in the Gauss points  
> KFLAG has no meaning 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and normally not used here because it is much more convenient to enter the pressure data for 
the plate elements into Z88I1.TXT in the section material information. However, the possibility for entering the 
pressure loads by the surface and pressure loads file Z88I5.TXT, too, is implemented for universal use of this 
file. Then set IQFLAG to 1 and proceed as follows: 
> Element number with pressure load  
> Pressure, positive if pointing towards the edge  
 
Results: 
Displacements in Z (i.e. w) and rotations x around X-axis and y around the Y-axis.  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
The following results will be presented: 
plate bending moments Mxx and Myy (unit: force × length / length) 
plate torsion moments Mxy = Myx (unit: force × length / length) 
the shear forces Qyz and Qzx (unit: force / length) 
the true stresses resulting from plate bending moments and plate torsion moments 
Optional von Mises or principal or Tresca stresses.  
Nodal forces in X and Y for each element and each node. 
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5.20  PLATE NO.20 WITH 8 NODES  

This is a curvilinear Serendipity Reissner- Mindlin plate element with square shape functions. 
The transformation is isoparametric. The integration is carried out numerically in both axes 
according to Gauss- Legendre. Consequently, the integration order can be selected in 
Z88I1.TXT in the material information lines. The order 2 (= 2 x 2 points) is mostly sufficient 
(reduced integration). This element calculates both displacements and stresses quite good. 
The integration order can be chosen again for the stress calculation. The stresses are calcu-
lated in the corner nodes (good for an overview) or calculated in the Gauss points (substan-
tially more exactly). Area loads are defined in the appropriate material lines, file Z88I1.TXT, 
instead of Second moment of inertia RIYY. For this element you need to set the plate flag IP-
FLAG to 1. Attention: In contrary to the usual rules of the classic mechanics Z88 defines x 
the rotation around the X-axis and y the rotation around the Y-axis. 
This element type is implemented for use with automeshers e.g. Pro/MECHANICA  for the 3D 
CAD system Pro/ENGINEER by Parametric Technology. In addition, a mesh generation with 
Z88N is possible. Super elements of type 20 cannot only generate finite elements of type 20, 
but plates of type 19 with 16 nodes, too. 
 

 

 
 
 
 
 
 
 
 
 
Input: 
 
CAD: 1-5-2-6-3-7-4-8-1, ref. chap. 2.7.2 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> set plate flag IPFLAG to 1 (or 2, if you want to reduce the shear influence) 
> set surface and pressure loads flag IQFLAG to 0 for your convenience. Then the entry of the pressure is done 
via the "Second moment of inertia RIYY", see below. If IQFLAG is set to 1, then the entry of the pressure is done 
via the surface and pressure loads file Z88I5.TXT 
> 3 degrees of freedom for each node (w, x,y) 
> Element type is 20 
> 8 nodes per element 
> Cross-section parameter QPARA is the element thickness 
> "Second moment of inertia RIYY“ is the area load 
> Integration order INTORD per each mat info line. 2 is usually good. 

 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted 
0   = Calculation of the stresses in the corner nodes 
1, 2, 3, 4 = Calculation of the stresses in the Gauss points  
> KFLAG has no meaning 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
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2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 
This file is optional and normally not used here because it is much more convenient to enter the pressure data for 
the plate elements into Z88I1.TXT in the section material information. However, the possibility for entering the 
pressure loads by the surface and pressure loads file Z88I5.TXT, too, is implemented for universal use of this 
file. Then set IQFLAG to 1 and proceed as follows: 
 
> Element number with pressure load  
> Pressure, positive if pointing towards the edge  
 
Results: 
 
Displacements in Z (i.e. w) and rotations x around X- axis and y around the Y- axis.  
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
The following results will be presented: 
 p

late bending moments Mxx and Myy (unit: force × length / length) 
 p

late torsion moments Mxy = Myx (unit: force × length / length) 
 t

he shear forces Qyz and Qzx (unit: force / length) 
 t

he true stresses resulting from plate bending moments and plate torsion moments 
Optional von Mises or principal or Tresca stresses.  
Nodal forces in X and Y for each element and each node. 
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5.21 SHELL NO.21 WITH 16 NODES  

This is a curvilinear Serendipity volume shell element. The transformation is isoparametric. 
The integration is carried out numerically in all axes according to Gauss-Legendre. The ele-
ment can be arbitrarily curved; it is actually a hexahedron with square shape functions on the 
surface and linear shape functions in the thickness direction. The integration order can be se-
lected in Z88I1.TXT in the material information lines. The order 3 (i.e. 3×3 Gauss Points) is 
mostly sufficient. This element calculates both displacements and stresses very exactly. The 
integration order can be chosen again for the stress calculation. The stresses are calculated in 
the corner nodes (good for an overview) or calculated in the Gauss points (substantially more 
exactly). 

 
The three degrees of freedom are the global displacements in X, Y and Z. There are no rota-
tional degrees of freedom, since it is a volume element. The Element can be generated by the 
mesh generator Z88N: Type 21  Type 21. 
 
Input: 
 
CAD: upper plane: 1-5-2-6-3-7-4-8-1; lower plane:  9-13-10-14-11-15-12-16-9;  
Lines:      1-9; 2-10; 3-11; 4-12, see chapter 4.1.7 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> surface and pressure loads flag IQFLAG=1, if entry of  surface and pressure loads via Z88I5.TXT 
> 3 degrees of freedom for each node 
> Element type is 21 
> 16 nodes per element 
> Cross-section parameter QPARA is insignificant 
> Integration order for each mat info line. 3 is usually good.  

 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted: 
0  = Calculation of the stresses in the corner nodes 
1,2,3,4 = Calculation of the stresses in the Gauss points 
> KFLAG has no influence 
 
> Reduced stress flag ISFLAG: 
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0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
 
Z88I5.TXT 

This file is optional and is only used, if in addition to nodal forces surface and pressure loads are supposed to be 
applied to elements No. 21:  
> Element number  
> Pressure, positive if pointing towards the surface  
> Tangential shear, positive in local r direction  
> Tangential shear, positive in local s direction   
> 4 corner nodes and 4 mid nodes of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2, the local s direction is defined by the nodes 1-4. The local 
nodes 1 to 8 for the surface load may differ from the local nodes 1 to 8 used for the coincidence. 
 

 
 
 
Results: 
 
Displacements in X, Y and Z 
Stresses: SIGXX, SIGYY, SIGZZ, TAUXY, TAUYZ, TAUZX, respectively for corner nodes or Gauss 
points. Optional von Mises or principal or Tresca stresses.  
Nodal forces in X, Y and Z for each element and each node 
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5.22 SHELL NO.22 WITH 12 NODES  

This is a curvilinear Serendipity volume shell element. The transformation is isoparametric. 
The integration is carried out numerically in all axes according to Gauss-Legendre. The ele-
ment can be arbitrarily curved; it is actually a kind of pie segment with square shape functions 
on the surface and linear shape functions in the thickness direction. The integration order can 
be selected in Z88I1.TXT in the material information lines. The order 3 (i.e. 3×3 Gauss 
Points) is mostly sufficient. This element calculates both displacements and stresses very ex-
actly. The integration order can be chosen again for the stress calculation. The stresses are 
calculated in the corner nodes (good for an overview) or calculated in the Gauss points (sub-
stantially more exactly).  
 

 
 
The three degrees of freedom are the global displacements in X, Y and Z. There are no rota-
tional degrees of freedom, since it is a volume element.  
 
Input: 
 
CAD: upper plane: 1-4-2-5-3-6-1; lower plane:  7-10-8-11-9-12-7;  
Lines:      1-7; 2-8; 3-9; see chapter 4.1.7 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> surface and pressure loads flag IQFLAG=1, if entry of  surface and pressure loads via Z88I5.TXT 
> 3 degrees of freedom for each node 
> Element type is 22 
> 12 nodes per element 
> Cross-section parameter QPARA is insignificant 
>  Integration order for each mat info line. 3, 7, and 13 are possible. 7 is usually good. 

 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted: 
0  = Calculation of the stresses in the corner nodes 
3,7, 13 = Calculation of the stresses in the Gauss points (e.g. 7 = 7 Gauss points) 
> KFLAG has no influence 
 
> Reduced stress flag ISFLAG: 
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0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 

This file is optional and is only used, if in addition to nodal forces surface and pressure loads are supposed to be 
applied to elements No. 22: 
> Element number  
> Pressure, positive if pointing towards the surface  
> 3 corner nodes and 3 mid nodes of the loaded surface. Mathematically positive in plain view. 
 

 
 
Results: 
 
Displacements in X, Y and Z 
Stresses: SIGXX, SIGYY, SIGZZ, TAUXY, TAUYZ, TAUZX, respectively for corner nodes or Gauss 
points. Optional von Mises or principal or Tresca stresses.  
Nodal forces in X, Y and Z for each element and each node. 
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5.23  SHELL NO.23 WITH 8 NODES  

This is a curvilinear Serendipity shell element with square shape functions. The transforma-
tion is isoparametric. The integration is carried out numerically in all axes according to 
Gauss-Legendre. All nodes have to be on a common surface which can be placed arbitrarily 
in a space – which is very useful for the data exchange with 3D CAD systems. The integra-
tion order can be selected in Z88I1.TXT in the material information lines. The order 3 (i.e. 
3×3 Gauss Points) is mostly sufficient. This element calculates both displacements and 
stresses very exactly. The integration order can be chosen again for the stress calculation. The 
stresses are calculated in the corner nodes (good for an overview) or calculated in the Gauss 
points (substantially more exactly). For this element, the shell flag IHFLAG must be set to 0 
or 1 in the first line of Z88I1.TXT. In case of thin shells, set IHFLAG to 2 or 3. In case of 
very thin shells set it to 4. If IHFLAG is not 0, a surface load can be imported simplified into 
the material entries. In this case, the surface load flag IQFLAG should be 0. 
 

 
The first three degrees of freedom are the global displacements in X, Y and Z. The degrees of 
freedom 4 and 5 are the torsions on the respective node; degree of freedom 6 is a pseudo-DOF 
without practical significance. Only the global displacements in X, Y and Z are practically 
useful and of interest. 
 
Input: 
 
CAD: 1-5-2-6-3-7-4-8-1 , see chapter 4.1.7 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> Set shell flag IHFLAG to 0 or 1, analogously to 2 or 3 in case of thin shells, to 4 in case of very thin shells. If    
   IHFLAG is not 0, a surface load can be imported simplified into the material entries in Z88I1.TXT   
   via the „Second moment of inertia RIYY".  Otherwise the "Second moment of inertia RIYY" is set to 0. 
> surface and pressure loads flag IQFLAG=1, if entry of  surface and pressure loads via Z88I5.TXT 
> 6 degrees of freedom for each node 
> Element type is 23 
> 8 nodes per element 
> Cross-section parameter QPARA is the element thickness 
> Integration order for each mat info line. 3 is usually good.  

 
Z88I3.TXT 
 > Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted: 
0  = Calculation of the stresses in the corner nodes 
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1,2,3,4 = Calculation of the stresses in the Gauss points 
 
> KFLAG has no influence 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 

This file is optional and is only used, if in addition to nodal forces surface and pressure loads are supposed to be 
applied to elements No. 23: 
> Element number  
> Pressure, positive if pointing towards the surface  
> 4 corner nodes and 4 mid nodes of the loaded surface. Mathematically positive in plain view. 
 
The local r direction is defined by the nodes 1-2, the local s direction is defined by the nodes 1-4. The local 
nodes 1 to 8 for the surface load may differ from the local nodes 1 to 8 used for the coincidence. 
 

 
 
Results: 
 

Displacements in X, Y and Z and Rotations (inclinations) around X- and Y-axis (x u. y)    
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
The stresses SIGXX, SIGYY and TAUXY as well as optionally von Mises or principal or Tresca stresses are 
output. 
Nodal forces first for each element, then for each node. 
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5.24 SHELL NO.24 WITH 6 NODES  

This is a curvilinear Serendipity shell element with square shape functions. The transforma-
tion is isoparametric. The integration is carried out numerically in all axes according to 
Gauss-Legendre. All nodes have to be on a common surface which can be placed arbitrarily 
in a space – which is very useful for the data exchange with 3D CAD systems. The integra-
tion order can be selected in Z88I1.TXT in the material information lines. The order 7 (i.e. 7 
Gauss Points) is mostly sufficient. This element calculates both displacements and stresses 
very exactly. The integration order can be chosen again for the stress calculation. The stresses 
are calculated in the corner nodes (good for an overview) or calculated in the Gauss points 
(substantially more exactly). For this element, the shell flag IHFLAG must be set to 0 or 1 in 
the first line of Z88I1.TXT. In case of thin shells, set IHFLAG to 2 or 3. In case of very thin 
shells set it to 4. If IHFLAG is not 0, a surface load can be imported simplified into the mate-
rial entries. In this case, the surface load flag IQFLAG should be 0. 
 

 
 
The first three degrees of freedom are the global displacements in X, Y and Z. The degrees of 
freedom 4 and 5 are the torsions on the respective node; degree of freedom 6 is a pseudo-DOF 
without practical significance. Only the global displacements in X, Y and Z are practically 
useful and of interest. 
 
 
Input: 
 
CAD: 1-4-2-5-3-6-1, see chapter 4.1.7 
 
Z88I1.TXT 
> KFLAG for Cartesian (0) or cylindrical coordinates (1) 
> Set shell flag IHFLAG to 0 or 1, analogously to 2 or 3 in case of thin shells, to 4 in case of very thin shells. If    
   IHFLAG is not 0, a surface load can be imported simplified into the material entries in Z88I1.TXT   
   via the „Second moment of inertia RIYY".  Otherwise the "Second moment of inertia RIYY" is set to 0. 
> surface and pressure loads flag IQFLAG=1, if entry of  surface and pressure loads via Z88I5.TXT 
> 6 degrees of freedom for each node 
> Element type is 24 
> 6 nodes per element 
> Cross-section parameter QPARA is the element thickness 
>  Integration order for each mat info line. 3, 7, and 13 are possible. 7 is usually good. 

 
Z88I3.TXT 
> Integration order INTORD: Basically, it is a good idea to use the same value as chosen in Z88I1.TXT, but 
different values are permitted: 
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0  = Calculation of the stresses in the corner nodes 
3,7, 13 = Calculation of the stresses in the Gauss points (e.g. 7 = 7 Gauss points) 
 
> KFLAG has no influence 
 
> Reduced stress flag ISFLAG: 
0 = no calculation of reduced stresses 
1 = von Mises stresses computed for the Gauss points (INTORD not 0!) 
2 = principal or Rankine stresses computed for the Gauss points (INTORD not 0!) 
3 = Tresca stresses computed for the Gauss points (INTORD not 0!) 
 
Z88I5.TXT 

This file is optional and is only used, if in addition to nodal forces surface and pressure loads are supposed to be 
applied to elements No. 24: 
> Element number  
> Pressure, positive if pointing towards the surface  
> 3 corner nodes and 3 mid nodes of the loaded surface. Mathematically positive in plain view. 
 

 
 
 
 
Results: 
 
Displacements in X, Y and Z and Rotations (inclination) around X- and Y-axis (x u. y)    
Stresses: The stresses are calculated in the corner nodes or Gauss points and printed along with their locations. 
The stresses SIGXX, SIGYY and TAUXY as well as optionally von Mises or principal or Tresca stresses are 
output. 
Nodal forces first for each element, then for each node. 
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